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0. getSoft–Installation 

Bevor Sie das getSpec-2048-Spektrometer an die USB-Schnittstelle Ihres Computers 
anschließen, müssen Sie zuerst die getSoft-Software installieren. 

getSoft Version 7 ist eine 32-bit-Anwendung und kann unter folgenden Betriebssystemen 
installiert werden: 

o Windows 95/98/Me 
o Windows NT/2000/XP 

Für den Fall, dass Sie mit den Betriebssystemen Windows 95 oder Windows NT4.0 arbeiten, 
benutzen Sie ein Standard-RS-232-Kabel (mit DB-9-Gerätestecker und -buchse), um das 
getSpec-2048 an die serielle Schnittstelle des Computers anzuschließen 

Installationsprogramm 

In jedem neuen Spektrometersystem ist eine CD-ROM enthalten. Eine der Optionen, welche 
nach dem Einlegen der CD in das CD-ROM-Laufwerk angezeigt wird, ist die Installation der 
getSoft-Software. Wenn diese Option ausgewählt wird, erscheint ein Untermenü. Dort kann 
die Konfiguration des Spektrometers ausgewählt werden.  

Die getSpec-USB1 Spektrometergruppe sollte ausgewählt sein, um getSoft für eine der 
folgenden Spektrometertypen zu installieren:  

o getSpec-102 oder getSpec-102-y 
o getSpec-256 oder getSpec-256-y 
o getSpec-1024 oder getSpec-1024-y 
o getSpec-2048 oder getSpec-2048-y 
o getSpec-2048FT oder getSpec-2048FT-y 

 Dabei beschreibt y die Anzahl der Spektrometerkanäle.  

Die getSpec-USB2 Spektrometergruppe sollte ausgewählt sein, um getSoft für eine der 
folgenden Spektrometertypen zu installieren:  

o getSpec–102/256/1024/2048/3648/NIR256-USB2. 

Dieses Handbuch behandelt die getSpec-USB1 und -USB2 Spektrometer. Anmerkungen zu 
getSpec-Bluetooth befinden sich im Abschnitt 0.1. 

Installations-Dialog 

Das Setup-Programm überprüft zunächst die 
Systemkonfiguration des Computers. Falls 
keine Probleme gefunden werden, erscheint ein 
„Welcome-Fenster“ mit einigen grundlegenden 
Informationen.  

Im nächsten Fenster kann das gewünschte 
Verzeichnis für die getSoft-Software geändert 
werden. Das vorgegebene Verzeichnis ist 
C:\getSOFT7USB2. Falls Sie die Software in ein 
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anderes Verzeichnis installieren möchten, klicken Sie den „Browse“-Button, wählen Sie ein 
neues Verzeichnis aus und klicken Sie „OK“. Sollte das gewünschte Verzeichnis noch nicht 
existieren, wird es erstellt. 

Im nächsten Fenster kann der Name für die Programmmanager-Gruppe geändert werden. 
Der vorgegebene Name ist „getSpec Software”. 

Das nächste Fenster öffnet sich („Start Installation”). Durch Betätigung des „Next“-Buttons 
wird die Installation gestartet. 

Nachdem alle Dateien installiert wurden, öffnet sich das „Installation complete“-Fenster. Es ist 
empfehlenswert, den Computer jetzt neu zu starten.  

Anschluss der Hardware 

Schließen Sie den USB-Stecker mit Hilfe des beiliegenden USB-Kabels an einen USB-
Anschluss ihres Computers an. Sollte es sich beim Spektrometertyp um ein getSpec-SPU 
handeln, dann legen Sie bitte den Schalter in die SPU-Position. Sollte das getSpec-2048-
Spektrometer ein 12-V-Netzteil benötigen, so schließen Sie das getSpec-2048 an das 12-V-
Netzteil an.  

Windows wird die „New Found 
Hardware“ (USB-Laufwerk) anzeigen 
und beginnen, nach einem geeigneten 
Treiber zu suchen. Dieser Vorgang 
kann einige Minuten dauern. 

Unter Windows XP öffnet sich ein 
Fenster, welches anzeigt, dass das 
getSpec-Spektrometer-Board  
“den Windows-Logo-Test zur 
Überprüfung der Kompatibilität mit 
Windwos XP nicht bestanden hat”. 
Dies besagt, dass der Hersteller des 
USB-Treibers denselben Microsoft 
nicht zugesandt hat und Microsoft auch nicht für die Überprüfung des Treibers bezahlt hat, 
wie es für alle Treiber, die für Windows 2000 entwickelt wurden und welche unter Windows 
XP problemlos laufen, der Fall ist. Wählen Sie „Continue Anyway“. 

Unabhängig von der Windows-Version 
kann sich das Fenster (Abb. rechts) 
öffnen, in dem Sie das Verzeichnis 
auswählen können, in dem sich der 
USB-Treiber befindet. Klicken Sie die 
„Browse“-Taste, gehen Sie zu dem 
Verzeichnis 
C:\WINNT\SYSTEM32\DRIVERS und 
doppelklicken Sie auf den getUSB.sys-
Treiber bzw. für den USB2-Anschluss 
den get5216USB.sys-Treiber. 

The file „getUSB.sys“ on getUSB 
Installation Disk is needed.  
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Falls der Computer USB nicht unterstützt (Windows 95, Windows NT 4.0), benutzen Sie ein 
Standard-RS-232-Kabel (mit DB-9-Gerätestecker und -buchse), um das getSpec-2048 an die 
serielle Schnittstelle des Computers anzuschließen. 

0.1 Bluetooth Installation 

Die getSpec Spektrometer mit drahtloser Datenübertragung mittels Bluetooth werden mit 
einem Tornado-USB-Dongle geliefert. Eine Bluetooth-Treiberinstallations-CD liegt der 
Packung bei. Dieser Abschnitt beschreibt, wie die Bluetooth-Datenübertragung mit dem 
getSpec-Bluetooth-Spektrometer eingerichtet wird. 

Installieren von getSoft für USB2-Spektrometer von der getSpec CD-ROM 

Legen Sie die getSpec CD-ROM in das CD-ROM-Laufwerk Ihres PCs ein. Wählen Sie 
„Software Installation“ und installieren Sie getSoft. 

Installieren des Bluetooth-Treibers 

Legen Sie die Tornado-Installations-CD in das CD-ROM-Laufwerk Ihres PCs ein. Folgen Sie 
den Anweisungen auf dem Bildschirm. Nachdem die Installation beendet ist, werden Sie 
aufgefordert, den Computer neu zu starten. Nach dem Neustart wird das IVT BlueSoleil-
Fenster angezeigt. Stecken Sie den Tornado-USB-Dongle ein. 

Verbinden des externen 12-V-Gleichstromnetzteils oder des Akkupacks mit getSpec 

Versichern Sie sich zuerst, dass die Akkumulatoren vollständig geladen sind. Sollte das nicht 
der Fall sein, schließen sie das Akkupack an das Ladegerät an bis die LED-Anzeige des 
Ladegerätes zu blinken beginnt (Erhaltungsladen-Modus). Verbinden Sie jetzt das Akkupack 
mit dem getSpec und schalten Sie es ein (Schalter an der rechten Seite). Schalten Sie 
getSpec an das externe Netz. 

Suche nach getSpec Spektrometer  

Die grüne LED-Leuchte an der 
Vorderseite des Spektrometers muss 
an sein. Wählen Sie die Menüoption 
„Refresh Devices“ im IVT BlueSoleil 
Hauptfenster aus (siehe Abb.). 

Pair Defice 

GetSpec wird als ein Symbol im Ring 
mit einer Adresse und einem 
Fragezeichen angezeigt. Mit einem 
Mausrechtsklick auf das Symbol wird 
das Menü angezeigt (Abb. rechts). 
Wählen Sie die Option „Pair Device“ 
aus. Geben Sie „0“ im Bluetooth -
Passwortfenster ein und bestätigen 
Sie mit „OK“. 
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Einrichten der Datenübertragung 

Wählen Sie das Menü „Refresh Services“ nach einem Rechtsklick mit der Maus auf das 
Gerätesymbol. Daraufhin wird das „Bluetooth - Serielle Anschluss“-Symbol markiert. Klicken 
Sie erneut mit rechts auf das Bluetooth-Gerätesymbol. Die neue Menüoption „Connect“ wird 
geöffnet. 

Nach einem Klick auf „Connect 
Bluetooth Serial Port Device“ wird eine 
serielle Anschlussnummer für diese 
Verbindung vergeben. Sie müssen 
später in getSoft diese serielle 
Anschlussnummer eingeben (im 
Beispiel: COM8). Klicken Sie auf „Yes“ 
für eine automatische Verbindung, wenn Windows diesen seriellen Anschluss öffnet.  

Die Datenübertragung wurde jetzt hergestellt. Das wird durch eine Linie zwischen dem Gerät 
und dem PC angezeigt. 

Wenn Sie auf die Option „Tools -> 
Configurations -> Quick Connect“ klicken, wird 
die COM Port Nummer, die für die 
Datenübertragung zwischen Spektrometer 
und PC zugewiesen wurde, überprüft. 

getSoft starten 

Nachdem die Datenübertragung hergestellt 
worden ist, kann getSoft gestartet werden. Beim 
ersten Starten von getSoft mit dem Bluetooth 
Spektrometer, wird ein Fenster wie in der Abb. 
rechts geöffnet. 

Klicken Sie auf die Option „Retry to establish 
communication through RS-232 or Bluetooth 
(Erneuter Versuch, eine Verbindung mit RS-232 
oder Bluetooth herzustellen)”. Eine Liste mit 
möglichen seriellen Schnittstellen (COM Ports) 
wird angezeigt. 

In unserem Beispiel wurde COM8 für die 
Bluetooth-Datenübertragung ausgewählt.  

Wählen Sie in der Liste den für Sie richtigen 
Anschluss aus und bestätigen Sie mit „OK“. 

getSoft wird jetzt die Konfigurierdaten vom Spektrometer lesen. Das kann länger als 15 
Sekunden dauern. Danach kann mit den Messungen begonnen werden. 
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0.2 Starten der Software 

getSoft kann vom Windows-Startmenü gestartet werden. Unter „Start -> Programme" wurde 
die Gruppe „getSpec Software” hinzugefügt. Diese enthält zwei Icons. Mit dem getSpec.com-
Logo wird getSoft gestartet. Das getSoft-Hilfe-Icon aktiviert die getSoft-Hilfe. Diese Hilfe kann 
auch vom Hilfemenü aus angewählt werden, nachdem getSoft gestartet wurde. 

 

USB1-Plattform 

Wenn Sie getSoft gestartet haben, 
erscheint ein Fenster (Abb. rechts), mit der 
Anzeige, dass die USB-Verbindung 
gefunden wurde. Ein ähnliches Fenster 
erscheint bei Nutzung der seriellen RS-
232-Schnittstelle. 

Sollten mehr als ein getSpec-2048-
Spektrometer an Ihren PC angeschlossen sein, öffnet sich ein 
Fenster (Abb. rechts), in welchem Sie die Seriennummer des zu 
verwendenden Spektrometers auswählen können. Mit dem 
USB1-Plattform-Spektrometern können mehrere Spektrometer 
gleichzeitig betreiben werden, wenn sie getSoft entsprechend oft 
neu starten. 

Nachdem Sie die „OK“-Taste gedrückt haben, erscheint das 
Hauptmenü.  

USB2-Plattform 

Nachdem getSoft 7 gestartet worden ist, werden alle angeschlossenen Spektrometer 
automatisch erkannt. Die Seriennummern werden als Kennungsfeld rechts auf dem 
Bildschirm erscheinen. 

Nach dem Drücken des „Start“-Buttons werden alle angeschlossenen Spektrometer im 
Hauptfenster angezeigt. Nach dem Drücken des „OK“-Buttons wird das Hauptfenster 
angezeigt. 

Im Abschnitt 2 finden Sie eine Beschreibung der Komponenten des Hauptmenüs. Ein 
Schnellstart wird in Abschnitt 2 beschrieben, falls Sie sofort eine Messung starten wollen. 
Genaue Informationen über die Menüoptionen sind im Abschnitt 3 enthalten. 
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Abhängig von Ihrer getSoft-Version (Basis oder Vollversion) und den von Ihnen bestellten 
Zusatzmodulen sind bis zu sechs Anwendungen in getSoft verfügbar. Diese werden in den 
Abschnitten 4.1 bis 4.6 beschrieben:  

o History / Verlauf (Standard in getSoft FULL) 
o Wavelength Calibration / Wellenlängenkalibrierung (Standard in getSoft FULL) 
o Color Measurment / Farbmessung (Zusatzmodul) 
o Absolute Irradiance Measurement / Messung der Bestrahlungsstärke (Zusatzmodul) 
o Excel Output / Excel-Ausgabe (Zusatzmodul) 
o Chemometry / Chemometrie (Zusatzmodul) 

1. Schnellstart: Spektrum messen und speichern 

1. Nachdem getSoft aufgerufen wurde, kann mit dem grünen „Start“-Button die Messung 
begonnen werden. 

2. Verbinden Sie die Lichtquelle und einen Spektrometereingang (bzw. mehrere) mit einer 
Faser oder einer Sonde. Starten Sie das Experiment zur Aufnahme eines Referenz-
Spektrums. 

3. Stellen Sie im Setup-Menü den Glättungsparameter bezüglich des benutzten Faser-/ 
Blendendurchmessers ein (Abschnitt „3.2.3 Setup Menu: Smoothing and Spline“). Für die 
USB2-Plattform ist die optimale Glättung bezüglich getSpec im EEPROM voreingestellt 
und gespeichert. 

4. Schalten Sie nun die Lichtquelle ein. Es erscheint ein Spektrum auf dem Bildschirm. 
Dabei ist es möglich, dass das Spektrum übersteuert ist. Zu viel Licht bedeutet, dass über 
einer bestimmten Wellenlänge das Signal gesättigt ist. Dies wird durch eine gerade Linie 
beim Maximalwert und die Aktivierung des Buttons „Saturated” in der Statusleiste des 
Spektrometerkanals angezeigt.  

Dies kann normalerweise durch ein Verringern der Integrationszeit verhindert werden. Die 
Integrationszeit kann im Hauptfenster im weißen Feld unter dem „Start/Stop“-Button 
geändert werden. Wenn die Software getSoft Daten erfasst, zeigt der „Start/Stop“-Button 
ein rotes „Stop“ und das Feld für die Integrationszeit ist grau um anzuzeigen, dass sie im 
Augenblick nicht geändert werden kann (USB1).  

Wenn der „Stop“-Button betätigt wird, wird die Datenerfassung beendet. Die Integrations-
zeit kann nun geändert werden. Das Ergebnis der geänderten Integrationszeit kann nach 
Betätigung des grünen „Start“-Buttons betrachtet werden.  

Versuchen Sie, die Integrationszeit so einzustellen, dass der Maximalwert der 
Wellenlängenkurve ungefähr bei 14500 Einheiten (Rohsignal) liegt. Sollte bei einer 
minimalen Integration das Signal noch immer zu hoch sein, müssen eventuell 
Dämpfungsglieder, neutrale Dichtefilter oder Fasern mit geringerem Durchmesser 
benutzt werden. Sollte nicht genügend Licht das Spektrometer erreichen, sollte eine 
längere Integrationszeit eingegeben werden.  

5. Wenn ein verwertbares Spektrum angezeigt wird, schalten Sie die Lichtquelle aus. 

6. Speichern Sie nun die Dunkelspektren. Dies erfolgt mit der Menüoption „File -> Save -> 
Dark“ oder durch Betätigung des schwarzen Quadrats in der linken oberen Ecke des 
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Bildschirms. Speichern Sie immer die Dunkelspektren, nachdem Sie die Integrationszeit 
verändert haben.  

7. Schalten Sie die Lichtquelle erneut ein. Speichern Sie das aktuelle Spektrum als 
Referenz. Dies erfolgt mit der Option „File -> Save -> Reference“ oder durch Betätigung 
des weißen Quadrats in der linken oberen Ecke des Bildschirms (neben dem schwarzen 
Quadrat). Speichern Sie immer die Referenzdaten, nachdem Sie die Integrationszeit 
geändert haben.  

Nun kann das Transmissions-/Reflexions- („T“-Button) oder Absorptionsspektrum („A“-
Button) online dargestellt werden. Um eine bessere Ansicht der Amplitude zur 
Wellenlänge zu erreichen, betätigen Sie den „Cursor“-Button. Eine vertikale Linie wird nun 
im Graphen angezeigt. Wenn Sie den Cursor nahe dieser Linie platzieren, verändert sich 
seine Form vom Pfeil zu einer Drag-Form. Wenn diese Form angezeigt wird, kann die 
linke Maustaste zum Ziehen der Linie in eine andere Position benutzt werden (halten Sie 
die linke Maustaste gedrückt). Das Ziehen der Linie zeigt die entsprechenden Werte für 
Wellenlänge und Amplitude im Hauptbildschirm.  

Durch Betätigen des roten „Stop“-Buttons wird die Datenerfassung abgebrochen und das 
zuletzt erfasste Spektrum wird im Static-Modus dargestellt. Durch erneute Betätigung 
desselben Buttons, welcher nun ein grünes „Start” anzeigt, kann die Datenerfassung neu 
gestartet werden. 

8. Um das Spektrum zu speichern, wählen Sie die Option „File -> Save -> Experiment” oder 
betätigen Sie den Button „Save Experiment” in der Button-Leiste. 

9. Um das Signal/Rausch-Verhältnis zu verbessern, kann eine Anzahl von Spektren 
gemittelt werden. Dafür muss im weißen Mittelungsfeld (neben der Integrationszeit) der 
Wert erhöht werden. Der Wert kann nur im Static-Modus geändert werden. Wenn getSoft 
gerade Daten erfasst, wird das Mittelungseingabefeld grau. 
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2. Hauptfenster 

2.1 Menüleiste 

 
Die Menüs und Untermenüs werden in Abschnitt 3 beschrieben. 

2.2 Symbolleiste 

- Für die USB1-Plattform  

 
 

 

- Für die USB2-Plattform 

 

    „Start/Stop“- Button 

Der „Start/Stop“-Button kann für die Anzeige von Daten in Echtzeit oder für die Aufnahme 
eines Speicherauszuges verwendet werden. 

   „Cursor“- Button 

Nachdem der „Cursor“-Button betätigt wurde, wird eine vertikale Linie im Graphen angezeigt. 
Wenn der Mauscursor nahe dieser Linie platziert wird, verändert sich die Form des Cursors 
vom Pfeil zu einer „drag“-Form. Wenn diese Form des Cursors angezeigt wird, kann die linke 
Maustaste zum Ziehen der Linie in eine neue Position verwendet werden (halten Sie die 
Maustaste gedrückt). Das Ziehen der Linie zeigt die entsprechenden Werte für Wellenlänge 
und Amplitude auf dem Hauptbildschirm an. Als Alternative 
zum Ziehen der Linie dienen die „Small Step“/„Big Step”-
Buttons oder die Pfeiltasten auf der Tastatur. Der Wert für 
diese Schritte kann verändert werden, wenn die CTRL-
Taste während des Betätigens der Einzel- oder 
Doppelpfeilbuttons gehalten wird.  

  Buttons „Reference“ und „Dark“ 

Der Referenzbutton ist der weiße Button in der linken oberen Ecke des Bildschirms. Durch 
Betätigen dieses Buttons können die Referenzdaten gespeichert werden. Alternativ kann dies 
auch mit der Option „File -> Save -> Reference“ geschehen.  

Der Dunkelbutton ist der schwarze Button in der linken oberen Ecke des Bildschirms. Durch 
Betätigen dieses Buttons können Dunkeldaten gespeichert werden. Alternativ kann dies mit 
der Option „File -> Save -> Dark“ geschehen. 
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   Button „Save Experiment”  

Durch Betätigen des Buttons „Save Experiment” wird ein Experiment gespeichert. Alternativ 
kann dies mit der Option „File -> Save -> Experiment“ geschehen. 

   Button „Print” 

Durch Betätigen des Buttons „Print” wird der Graph, der auf dem Bildschirm angezeigt wird, 
gedruckt. Alternativ kann dies mit der Option „File -> Print“ geschehen. 

   „Channel”- Button (nur USB1-Plattform) 

Wenn der „Channel”-Button betätigt wird, öffnet sich ein Fenster, in dem die Spektrometer-
kanäle ausgewählt werden können. Alternativ kann dies mit der Option „View -> Channel” 
geschehen. 

   „Scope”- Button 

Durch Betätigen des S-Buttons werden die Daten im „Scope”-Modus angezeigt. Alternativ 
kann dies über die Option „View -> Scope Mode“ geschehen. 

   Button „Absorbance” 

Durch Betätigen des A-Buttons werden die Daten im Absorptionsmodus dargestellt. Alternativ 
kann dies über die Option „View -> Absorbance Mode“ geschehen. 

   Button „Transmission” 

Durch Betätigen des T-Buttons werden die Daten im Transmissionsmodus dargestellt. 
Alternativ kann dies über die Option „View -> Transmittance Mode“ geschehen. 

   Button „Irradiance” 

Durch Betätigen des I-Buttons werden die Daten im Irradiance-Modus dargestellt. Alternativ 
kann dies über die Option „View -> Irradiance Mode“ geschehen. 

   Button „Autoscale Y-Axis“ 

Durch Betätigen des Autoskalieren-Buttons wird der Graph online neu skaliert. Ein maximales 
Signal bei etwa 75 % auf der vertikalen Skala wird angezeigt. Alternativ kann dies mit der 
Option „View -> Autoscale Y-axis” geschehen. 
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   Button „Change Graph Scale ” 

Durch Betätigen dieses Buttons wird ein Fenster geöffnet, in dem das Intervall für die Y- und 
X-Achse geändert werden kann. Dieses Intervall kann gespeichert und jederzeit durch 
Betätigen des „Goto Preset Scale“-Button neu aufgerufen werden (siehe unten). Alternativ  
kann dies mit der Option „View -> Change Graph Scale“ geschehen. 

   Button „Goto Preset Scale” 

Durch Betätigung dieses Buttons werden die Skalen für die X- und Y-Achse auf den zuletzt 
gespeicherten Stand zurückgesetzt. Alternativ kann dies mit der „View -> Goto Preset Scale“ 
geschehen. 

   Button „Graphic Reset” 

Durch Betätigen dieses Button werden die X- und Y-Achse auf ihre vorgegebenen Werte 
zurückgesetzt. Alternativ kann dies mit der Option „View -> Graphic Reset“ geschehen. 

   Button „Auto Configure Integration time“ 

Nachdem dieser Button betätigt wurde, beginnt getSoft nach einer optimalen Integrationszeit 
zu suchen. Abhängig vom maximalen Wert des letzten Scans wird die Integrationszeit auto-
matisch erhöht/herabgesetzt bis ein Scope-Signal von ca. 14500 Einheiten gemessen wird. 
Während des Suchvorgangs können die Änderungen der Integrationszeit in der Edit-Box der 
Integrationszeit in der Edit-Leiste verfolgt werden. Ein Fenster wird die neue Integrationszeit 
anzeigen, sobald der Suchvorgang beendet ist. Der Suchvorgang kann durch ein erneutes 
Betätigen des Buttons abgebrochen werden, sollte er noch nicht abgeschlossen sein. 

   H.C.F.-Button 

Der Button „History Channel Function” erlaubt Ihnen, direkt zum H.C.F.-Bildschirm zu 
wechseln, um sofort eine Messung zu starten. Natürlich müssen die Funktionen zunächst 
jedoch definiert werden. 
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Die beiden folgenden Buttons sind nur dann verfügbar, wenn getSoft gemeinsam mit 
der Color Application Zusatzsoftware bestellt wurde:  

   Button „Color Chart” 

Dieser Button ermöglicht Ihnen, direkt in den Farbdiagramm-Bildschirm zu wechseln. Eine 
Messung wird sofort gestartet. 

   Button „Color of Object versus Time“  

Dieser Button ermöglicht Ihnen, direkt zur Zeitmessung von Farbparametern zu wechseln. 
Eine Messung wird sofort gestartet.  

2.3 Edit-Leiste 

- Für die USB1-Plattform  

 

- Für die USB2-Plattform (mehrkanalig) 

 

Wenn getSoft für USB1 Daten erfasst, sind die Edit-Felder grau und können nicht geändert 
werden. Durch Betätigung des roten „Stop“-Buttons wird die Datenerfassung beendet und die 
Edit-Felder werden weiß und können geändert werden.  

In der Edit-Leiste werden folgende Parameter dargestellt: 

Integrationszeit – Integration time [ms] 

Diese Option ändert die CCD-Auslesefrequenz und somit auch die Belichtungs- oder  
Integrationszeit des CCD-Detektors. Je länger die Integrationszeit, desto mehr Licht ist der 
Detektor während eines einzelnen Scans ausgesetzt und um so höher ist das Signal.  

Sollte die Integrationszeit zu lang eingestellt sein, gelangt zu viel Licht zum Detektor. Die 
Folge davon ist, dass über einer bestimmten Wellenlänge das Signal den Maximalwert 
erreicht (16383) oder im Extremfall als gerade Linie bei einer beliebigen Höhe darstellt wird, 
möglicherweise sogar nahe 0.  

Normalerweise sollte dieses Problem durch die Eingabe einer kürzeren Integrationszeit zu 
beheben sein. Versuchen Sie, die Integrationszeit so einzustellen, dass der Maximalwert über 
dem Wellenlängenbereich bei etwa 15000 liegt. Sollte bei einer minimalen Integration das 
Signal noch immer zu hoch sein, müssen eventuell Dämpfungsglieder, neutrale Dichte-Filter 
oder Fasern mit geringerem Durchmesser benutzt werden.  
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Sollte nicht genügend Licht das Spektrometer erreichen, sollte eine längere Integrationszeit 
eingegeben werden. Weiterhin ist es möglich, getSoft durch Betätigen des „?AC”-Buttons oder 
mit der Menüoption „Setup -> Options -> Autoconfigure Integrationtime“ nach einer geeigneten 
Integrationszeit suchen zu lassen. 

Erfolgen die Messungen in einem Modus, in dem Referenz- und Dunkeldaten erforderlich sind 
(alle Modi außer Scope-Modus), müssen neue Referenz- und Dunkelspektren gespeichert 
werden, nachdem die Integrationszeit geändert wurde. 

Durchschnittswert – Average 

Mit dieser Option kann die Anzahl der Scans eingestellt werden, von denen der Durch-
schnittswert ermittelt werden soll. Jeweils nach # Scans wird ein Spektrum angezeigt. Dieses 
ist der Mittelwert von # Scans. 

Wellenlänge – Wavelength [nm] 

Die Wellenlänge zeigt die Position des Cursors, welcher dann sichtbar wird, wenn der 
Cursor-Button aktiviert wurde. Die Amplitude des Signals, welche in der Statusleiste unten im 
Hauptfenster angezeigt wird, ist die Amplitude bei der Wellenlänge, die in diesem Feld 
angezeigt wird.  

Mehrkanal (nur USB2) 

Wenn für alle Kanäle dieselben 
Durchschnittswerte und 
Integrationszeit eingestellt werden sollen, setzen Sie 
vor „to All“ ein Häkchen. 

Wenn auf den Schalter mit den drei Punkten gedrückt 
wird, können verschiedene Integrationszeiten und 
Durchschnittswerte für jeden Kanal eingegeben 
werden. 

2.4 Grafischer Bereich 

Der grafische Bereich stellt die 
Daten in einem X-Y-Diagramm 
dar. Dabei stellt die X-Achse die 
Wellenlänge in Nanometern und 
die Y-Achse den Detektor-Wert 
dar. Nachdem ein Referenz- 
oder Dunkelspektrum geladen 
oder gespeichert  wurde, können 
an der Y-Achse andere Einheiten 
ausgewählt werden: 
Absorptionseinheiten, 
Prozentuale Transmission oder 
relative Strahlungsintensität. 
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Gespeicherte Graphen anzeigen und Linienstil-Editor 

Mit einem Klick der rechten Maustaste auf die Legende können 
mehrere, früher gespeicherte Spektren angezeigt werden.  

Neu in getSoft 7 ist, dass die angezeigten Graphen entfernt 
werden, die Eigenschaften der angezeigten 
Graphen, wie z.B. Stil und Farbe der Linie, sowie die 
Anmerkungen geändert werden können. Das ist mit 
einem Klick der rechten Maustaste auf die Linie in 
der grafischen Anzeige möglich. Ein kleines Fenster 
eröffnet die Möglichkeit zum Deaktivieren der Linie, 
zur Veränderung der Linieneigenschaften (wie im 
„Border Editor“ beschrieben) oder zur Bearbeitung 
von Anmerkungen. 

Zoom-Eigenschaften 

Zoom in: Wählen Sie einen Bereich, der auf den gesamten Graphen ausgedehnt werden soll. 
Um diesen Bereich anzuwählen, klicken Sie mit der linken Maustaste in den weißen 
grafischen Bereich und ziehen Sie ihn nach unten und nach rechts. Nachdem Sie die linke 
Maustaste im Grafik-Display losgelassen haben, werden X- und Y-Achse entsprechend der 
neuen Werte des ausgewählten Bereichs neu skaliert. 

Zoom out: Ziehen Sie mit der linken Maustaste innerhalb des weißen Rechtecks, aber anstatt 
die Maus nach unten zu ziehen, bewegen Sie sie in eine andere Richtung. Nachdem Sie die 
Maustaste losgelassen haben, werden X- und Y-Achse auf ihre voreingestellten 
Ausgangswerte zurückgesetzt. 

X-Y-Bewegung: Mit der rechten Maustaste können Sie das gesamte Spektrum nach oben 
und unten sowie nach rechts und links verschieben. 

Y-Bewegung: Wenn ihre Maus über ein Scroll-Rad verfügt, so kann das gesamte Spektrum 
damit nach oben oder unten bewegt werden. 

2.5 Statusleiste 

USB1 

 
Die Statusleiste am unteren Bildrand des Hauptfensters zeigt für jeden ausgewählten 
Spektrometerkanal Informationen über die Datei an, unter welcher die Daten gespeichert 
werden, die Amplitude bei momentaner Wellenlänge und die aktuellen Einstellungen für die 
Glättungs- und Splineparameter. Das Feld rechts von den Spline-Einstellungen zeigt an, ob 
zu viel Licht das Spektrometer bei einer bestimmten Wellenlänge erreicht wird. In diesem Fall 
würde das Feld „Saturated” sichtbar werden. Sehen Sie auch im Abschnitt „3.2.9.1 Setup 
Menu: Options – Check on Saturation“  
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USB 2 

 
Für jeden ausgewählten Spektrometerkanal zeigt eine Statusleiste unten im Hauptfenster 
folgende Eigenschaften an: 

o den Kennsatznamen des angeschlossenen Spektrometerkanals, 
o die Datei, in der die Daten gespeichert werden, 
o die Amplitude bei gegenwärtiger Wellenlänge, 
o die aktuellen Einstellungen für die Glättungs- und Splineparameter, 
o die Farbe und den Stil der Linie in der grafischen Anzeige, 
o die echte Integrationszeit, 
o die Mittelungen pro Kanal, 
o die Anzahl der aufgenommenen Scans, seit dem der „Start“-Button gedrückt worden 

ist. 

Das Feld rechts dient zur Anzeige, wenn das Spektrometer zu viel Licht bei einer bestimmten 
Wellenlängenbereich empfängt (= 16383 Einheiten bevor dynamisches Dunkel, Glättung oder 
Mittelung korrigiert werden). In diesem Fall wird die Markierung „Saturated“ erscheinen. 

2.6 Maximal- und Minimalwerte mit „CTRL“ oder „SHIFT + linke Maustaste“ finden 

Diese Option kann in allen Modi und für alle dargestellten Grafiken verwendet werden (Scope, 
Absorption, Transmission oder Irradiance). Wenn mit der linken Maustaste in den grafischen 
Bereich geklickt wird, während die „CTRL“-Taste gedrückt wird, folgt getSoft folgendem 
Ablauf um zum nächsten Maximalwert zu gelangen: 

1. Die Wellenlänge wird von der Position des Mausklicks bestimmt. 

2. Die Daten des nächsten Pixels werden abgerufen. 

3. Die Richtung, in welcher nach dem Höchstwert gesucht wird, wird aus der Position der 
benachbarten Pixel berechnet.  

Wenn beide benachbarten Pixel auf der Y-Achse einen niedrigeren Wert als der mittlere 
Pixel besitzen, so ist der mittlere Pixel bereits ein Maximum. Sollte nur einer der beiden 
benachbarten Pixel einen höheren Wert besitzen, wird der Maximalwert in Richtung des 
höherwertigen Pixels gesucht. Besitzen beide benachbarten Pixel höhere Werte, so stellt 
der mittlere Pixel ein Minimum dar. In diesem Fall wird das Maximum in Richtung des 
benachbarten Pixels mit der höheren Wertigkeit gesucht. 

4. Der Cursor beginnt sich in die Richtung zu bewegen, die unter 3. bestimmt wurde, bis er 
einen Pixel erreicht, dessen Wert den zuvor gemessenen nicht mehr übersteigt. An 
diesem Pixel stoppt der Cursor.  

Durch Gedrückthalten der „SHIFT“-Taste anstelle von „CTRL“ 
startet die Prozedur, um zum nächsten Minimum zu gelangen. 

Werden mehr als ein Spektrum dargestellt, öffnet sich ein Fenster 
(Abb. rechts), in dem Sie aus allen dargestellten Spektren 
auswählen können, für welches Sie den Höchstwert ermitteln 
wollen.  
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3. Menüoptionen 

In den Abschnitten 3.1 bis 3.3 werden die Hauptmenüoptionen und deren Untermenüs genau 
beschrieben. 

3.1 File Menu 

 

3.1.1 File Menu: Start New Experiment 

Nach dem diese Option ausgewählt wurde, öffnet sich ein Fenster, in dem ein neuer Name 
für das Experiment eingegeben werden kann. Der Name des Experiments wird als 
Dateiname mit der Erweiterung *.kon gespeichert. Diese Erweiterung muss nicht mit 
eingegeben werden.  

Nach dem der Button „Speichern“ 
betätigt wurde, wird der Dateiname 
aus dem eingegebenen Namen und 
einer Laufnummer (Start bei 0001) 
erstellt. 

Beispiel: Wenn der Name des 
Experiments „test” sein soll, so heißt 
die erste Grafik-Datei, die im Scope-
Modus gespeichert wird, 
„test0001.ROH“. Die Laufnummer 
wird automatisch um 1 erhöht, so 
dass die nächste Datei, die im 
Scope-Modus abgespeichert wird, 
den Namen „test0002.ROH“ erhält.  

Detaillierte Informationen zu Namen von Grafik-Dateien finden Sie im Abschnitt „File Menu: 
Save Experiment“. Beachten Sie, dass das Fenster es Ihnen ermöglicht, verschiedene 
Ordner und Laufwerke als Speicherort auszuwählen sowie neue Ordner für das Abspeichern 
des Experiments zu erstellen. Der vorgegebene Ordner für das Speichern der Daten für die 
USB1-Plattform, heißt „Daten<Seriennummer>”. Hierbei bezieht sich <Seriennummer> auf 
die Seriennummer des verwendeten getSpec-2048-Spektrometer. Für die USB2-Plattform 
heißt das angegebene Verzeichnis „Daten“. 
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Nachdem das Fenster durch Betätigung des Buttons „Save” geschlossen wurde, wird der 
neue Name des Experiments gefolgt von der Seriennummer unten links in der Statusleiste 
angezeigt. Durch Betätigen des Buttons „Cancel” wird der alte Name des Experiments wieder 
hergestellt. 

3.1.2 File Menu: Load Dark 

Mit dieser Option können die Dunkeldaten geladen werden, die zuvor abgespeichert wurden. 
Wenn getSoft im Static-Modus läuft, werden die Dunkeldaten, die geladen werden, zuerst auf 
dem Bildschirm angezeigt. 

3.1.3 File Menu: Load Reference 

Mit dieser Option können Referenzdaten geladen werden, die zuvor gespeichert wurden. 
Wenn getSoft im Static-Modus läuft, werden die Referenzdaten, die geladen werden, 
zunächst auf dem Bildschirm angezeigt. 

3.1.4 File Menu: Load Experiment 

Mit dieser Option kann ein Experiment, das zuvor bearbeitet wurde, geladen werden. Dadurch 
können mehrere Spektren unter einem Experiment abgespeichert werden. Der Name des 
Experiments trägt die Erweiterung *.kon.  

Nachdem diese Option 
ausgewählt wurde, 
öffnet sich ein Fenster, 
welches alle zuvor im 
momentan angewählten 
Verzeichnis 
abgespeicherten 
Experimente anzeigt. 
Wenn sich der Name 
des Experiments, das 
geladen werden soll, in 
diesem Verzeichnis 
befindet, betätigen Sie 
den Button „Save”. 
Wenn sich das zu 
ladende Experiment in 

einem anderen Verzeichnis oder auf einem anderen Laufwerk befindet, klicken Sie auf den 
Auswahlschalter neben dem aktuellen Ordnernamen, um zu dem entsprechenden 
Verzeichnis zu gelangen.  

Detaillierte Informationen über Grafik-Dateien finden Sie im Abschnitt „File Menu: Save 
Experiment“. 

3.1.5 File Menu: Save Dark 

Mit dieser Option können Dunkeldaten gespeichert werden. Der Name der Dunkeldaten-Datei 
für die USB1-Plattform lautet dark*.dat, wobei * die Nummer des Slave-Kanals repräsentiert, 
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für den die Dunkeldaten gespeichert werden sollen (* = 0 repräsentiert den Master-Kanal). 
Für die USB2-Plattform lautet der Name des Dunkeldaten-Datei „serialnr.drk“. 

Die Dunkeldaten werden in dem Experiment-Verzeichnis abgespeichert, welches mittels der 
Option „File -> Load -> Experiment ” oder „File -> Start New Experiment“ ausgewählt wurde. 

3.1.6 File Menu: Save Reference 

Mit dieser Option werden Referenzdaten gespeichert. Der Name der Referenzdatei ist  
ref*.dat, wobei * die Nummer des Slave-Kanals repräsentiert, für den die Referenzdaten 
gespeichert werden sollen (* = 0 repräsentiert den Master-Kanal). 

Die Referenzdaten werden in dem Experiment-Verzeichnis abgespeichert, welches durch die 
Option „File -> Load -> Experiment” oder „File -> Start New Experiment“ ausgewählt wurde. 

3.1.7 File Menu: Save Experiment 

Mit dieser Option werden Spektrumdaten gespeichert. Alle Grafikdateien werden in dem 
Experiment-Verzeichnis abgespeichert, welches durch die Option „File -> Load -> 
Experiment” oder „File -> Start New Experiment“ ausgewählt wurde. 

Speichern von Grafikdateien, wenn ein Spektrometerkanal aktiv ist 

Zunächst öffnet sich ein Fenster, in dem den gespeicherten Graphen eine Reihe von 
Bemerkungen zugewiesen werden können. Dann werden zwei Dateien gespeichert: Die 
erste enthält die gespeicherten Spektrumdaten. Der Name dieser ersten Datei beginnt mit 
dem Namen des Experiments, gefolgt von der Laufnummer des gespeicherten Spektrums. 
Die Erweiterung dieser Datei ist abhängig vom momentanen Mess-Modus (siehe unten): 

 Erweiterung Modus 
 ROH  Scope-Modus 
 ABS  Absorption 
 TRM  Transmission/Reflexion 
 IRR  Irradiance 

Die zweite Datei enthält die Zeile mit Bemerkungen, welche dem Graphen eventuell 
hinzugefügt wurden. Der Name dieser zweiten Datei ist bis auf die Erweiterung identisch mit 
dem der ersten Datei (Name des Experiments und Laufnummer). Die Erweiterung dieser 
zweiten Datei hängt ebenso vom Messmodus ab: 

 Erweiterung Modus 
 RCM  Scope-Modus 
 ACM  Absorption 
 TCM  Transmission/Reflexion 
 ICM  Irradiance 

Beispiel: Angenommen, der Name unseres Experiments ist „gts". Werden ein Spektrum im 
Scope-Modus, ein Spektrum im Absorptions-Modus und zwei Spektren im Transmissions-
Modus abgespeichert, liegen folgende Dateien vor: 

gts0001.roh: Spektrumdaten im Scope-Modus 
gts0001.rcm: Bemerkungen für das Spektrum gespeichert unter gts0001.roh  
gts0001.abs: Spektrumdaten im Absorptions-Modus 
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gts0001.acm: Bemerkungen für das Spektrum gespeichert unter gts0001.abs 
gts0001.trm: Spektrum Transmissions-Modus 
gts0001.tcm: Bemerkungen für das Spektrum gespeichert unter gts0001.trm  
gts0002.trm: Spektrumdaten im Transmissions-Modus 
gts0002.tcm: Bemerkungen für das Spektrum gespeichert unter gts0002.trm 

Nach dem die Anwendung verlassen und getSoft neu geöffnet wurde, werden beim Speichern 
von Grafiken im Scope-, Absorptions- und Transmissionsmodus entsprechend die Dateien 
gts0002.roh, gts0002.abs und gts0003.trm sowie die „Comment“-Dateien gts0002.rcm, 
gts0002.acm und gts0003.tcm erstellt.  

Vor dem Speichern wird der Name der Grafikdatei in der Statusleiste am unteren Bildrand 
angezeigt. Nach dem Speichern wird die Laufnummer automatisch um eine Einheit erhöht. 

Speichern von Grafikdateien, wenn mehrere Spektrometerkanäle aktiv sind 

Wenn Grafikdateien abgespeichert werden, während mehr als ein Kanal zur gleichen Zeit 
betrachtet wird (siehe Option „View -> Channel”), so erhält der Dateiname für jeden Kanal 
eine unterschiedliche Laufnummer. Das Speichern eines Experiments im Dreifach-Ansichts-
Modus würde drei Grafikdateien und drei Kommentar-Dateien erstellen, wie zum Beispiel: 

gts0002.roh: Spektrumdaten im Scope-Modus (z.B. Spektrometer 1 oder Master-Kanal) 
gts0003.roh: Spektrumdaten im Scope-Modus (z.B. Spektrometer 2 oder Slave1-Kanal) 
gts0004.roh: Spektrumdaten im Scope-Modus (z.B. Spektrometer 3 oder Slave2-Kanal) 
gts0002.rcm: Bemerkungen für das Spektrum gespeichert unter gts0002.roh 
gts0003.rcm: Bemerkungen für das Spektrum gespeichert unter gts0003.roh 
gts0004.rcm: Bemerkungen für das Spektrum gespeichert unter gts0004.roh 

Für jeden Kanal kann eine verschiedene Kommentarzeile eingegeben werden. 

Um später Grafikdateien einfacher mit der Option „File -> Display Saved Graph” 
auszuwählen, beginnen alle Kommentarzeilen mit einem kurzen Namen des Kanals, unter 
welchem der Graph abgespeichert wurde: M für Master, S1 für Slave1 usw. 

Nach dem Speichern wurde die Laufnummer in diesem Experiment (Dreifach-Ansichts-
Modus) auf 0005, 0006 und 0007 entsprechend für Master, Slave1 and Slave2 inkrementiert. 

3.1.8 File Menu: Print 

Nachdem die Menüoption „File -> Print” 
ausgewählt wurde, werden die 
Hintergrundfarben im grafischen Bereich 
weiß.  

Wenn die Menüoption „File -> Black and 
White Printer“ (siehe nächster Abschnitt) 
markiert wurde, ändert sich auch die 
Linienart der Spektren von farbig zu weiß.  

Ein Fenster öffnet sich, in dem der Name 
des Ausdrucks eingegeben werden kann. 
Im nächsten Fenster können die 
Druckereinstellungen geändert werden 
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(z.B. Portrait- oder Panoramadruck, Druckqualität). Nachdem in diesem Fenster der Button 
„OK“ betätigt wurde, wird der Graph gedruckt und die ursprünglichen Farben des Graphs 
werden auf dem Bildschirm wieder hergestellt.  

3.1.9 File Menu: Black and White Printer 

Die vorgegebene Einstellung in getSoft druckt Spektren in den Farben aus, in denen sie auf 
dem Bildschirm dargestellt sind. Sollte ein Farbdrucker nicht zur Verfügung stehen, kann die 
Menüoption „File -> Black and White Printer“ aktiviert werden. Wenn diese Option ausgewählt 
ist, werden bei mehr als einem dargestelltem Spektrum verschiedene Linienarten (z.B. 
Strich-Strich, Punkt-Punkt, Strich-Punkt) gedruckt. Um diese Option auszuwählen, klicken sie 
auf die Menüoption und ein Häkchen erscheint davor.  

3.1.10 File Menu: Display Saved Graph 

Um diese Option zu nutzen, ist 
es nötig, Grafikdateien vorher 
mit der Option „File -> Save -> 
Experiment“ abgespeichert zu 
haben. Nachdem diese Option 
ausgewählt wurde, öffnet sich 
ein Fenster, welches alle im 
momentanen Messmodus 
abgespeicherten Dateien 
anzeigt. 

Im Beispiel (Abb. rechts) ist 
dies der Scope-Modus, die 
Erweiterung der gespeicherten 
Spektren ist *.ROH. 

Um Grafikdateien auszuwählen, die in anderen Messmodi (z.B. Absorption) gespeichert 

wurden, klicken Sie  hinter dem Graph ...-Modus und wählen Sie den gewünschten Mess-
Modus aus. 

Um gespeicherte Grafikdateien von einem anderen Verzeichnis oder Laufwerk auszuwählen, 

klicken Sie  hinter dem momentan angezeigten Ordnernamen. 

Wenn eine Grafikdatei durch einen Mausklick auf den Dateinamen markiert wurde, erscheint 
die Kommentarzeile ganz oben im grafischen Bereich im Hauptfenster. Mehrere Dateien 
können mit der Kombination CTRL oder SHIFT und der Maus ausgewählt werden. Wenn die 
CTRL-Taste gedrückt gehalten wird, werden alle mit der Maus ausgewählten Dateien 
angezeigt. Wenn die SHIFT-Taste gedrückt gehalten wird, werden alle Dateien zwischen 
zwei mit der Maus ausgewählten Dateien angezeigt. 

Wählen Sie den Namen der Datei(en) aus, die dargestellt werden soll(en), und klicken Sie 
den Button „Open“. Wenn Sie das Fenster verlassen wollen, ohne eine Datei zu öffnen, 
klicken Sie den Button „Cancel“. 

Neu in getSoft 7 ist, dass die angezeigten Graphen entfernt, die Eigenschaften der 
angezeigten Graphen, wie z.B. Stil und Farbe der Linie, und die Anmerkungen geändert 
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werden können. Das ist mit einem Klick der rechten Maustaste auf die Linie in der grafischen 
Anzeige möglich. Ein kleines Fenster eröffnet die Möglichkeit zum Deaktivieren der Linie, zur 
Veränderung der Linieneigenschaften (wie im „Border Editor“ beschrieben) oder zur 
Bearbeitung von Anmerkungen. 

In der Abbildung unten wurden zwei Grafikdateien im Scope-Modus ausgewählt. Die 
Kommentare, die mit diesen Graphen gespeichert wurden, werden oben im grafischen 
Bereich gemeinsam mit Informationen über Amplitude bei momentaner Wellenlänge (amp), 
Integrationszeit (it) und Glättungseinstellungen (s) beim Moment des Abspeicherns sowie 
dem Namen der Grafikdatei angezeigt.  

Wenn die aktiven Spektrometerkanäle (z.B. Master) nicht mit der Option „View -> Channel“ 
deselektiert wurden, werden 
die aktuellen Daten für die 
aktivierten Kanäle im 
gleichen Graphen wie die 
ausgewählten Grafikdateien 
angezeigt. Durch Betätigen 
des grünen „Start“-Buttons 
können die Online-
Messungen direkt mit den 
zuvor gespeicherten 
Grafiken verglichen werden. 

Vor der Menüoption „File -> 
Display Saved Graph“ wird 
ein Häkchen angezeigt, 
solange die zuvor 
gespeicherten Grafiken 
dargestellt werden. Um 
diese Grafiken zu löschen, 
wählen Sie erneut die Option „File -> Display Saved Graph“ und das Häkchen verschwindet. 
Nun werden nur noch die Spektren für die/den momentan aktiven Spektrometer-Kanal/Kanäle 
angezeigt.  

3.1.11 File Menu: Convert Graph – To ASCII 

Um diese Option zu nutzen, müssen die Grafikdateien vorher mit der Option „File -> Save 
Experiment“ abgespeichert werden. Nachdem diese Option ausgewählt wurde, öffnet sich ein 
Fenster, welches alle Dateien im momentanen Mess-Modus anzeigt. Im Scope-Modus lautet 
die Erweiterung der gespeicherten Spektren *.ROH.  

Um Grafikdateien auszuwählen, die in anderen Mess-Modi (z.B. Absorption) gespeichert 

wurden, klicken Sie  hinter dem „Graph - … Modus“ und wählen Sie den gewünschten 
Mess-Modus aus. 

Um gespeicherte Grafikdateien von einem anderen Verzeichnis oder Laufwerk auszuwählen, 

klicken Sie  hinter dem momentan angezeigten Ordnernamen.  
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Wenn eine Grafikdatei durch einen Mausklick auf den Dateinamen markiert wurde, erscheint 
die Kommentarzeile ganz oben im grafischen Bereich im Hauptfenster. Mehrere Dateien 
können mit der Kombination CTRL oder SHIFT und der Maus ausgewählt werden. 

Wenn die CTRL-Taste gedrückt gehalten wird, werden alle mit der Maus ausgewählten 
Dateien konvertiert. Wenn die SHIFT-Taste gedrückt gehalten wird, werden alle Dateien 
zwischen zwei mit der Maus ausgewählten Dateien konvertiert. 

Wählen Sie den Namen der Datei/en, die zu ASCII konvertiert werden soll/en, und klicken Sie 
den Button „Open“. Um das Fenster zu verlassen und keine Dateien zu konvertieren, klicken 
Sie auf den Button „Cancel“. Die Erweiterung der Textdateien hängt von der Erweiterung der 
binären Grafikdateien ab (siehe unten): 

Erweiterung binäre Datei Erweiterung Textdatei 

 ROH    TRT 
 ABS    TAT 
 TRM    TTT 
 IRR    TIT 

Alle Textdateien beginnen mit einer Kopfzeile, die Informationen über die konvertierte 
Grafikdatei enthält. Die Kopfzeile enthält: 

o die Kommentarzeile, 
o die Integrationszeit, 
o die gemittelte Anzahl der Scans, 
o die Anzahl der für die Glättung verwendeten Pixel, 
o das zum Speichern der Daten benutzte Spektrometer. 

Die Daten in einer *.TRT-Datei werden in zwei Spalten dargestellt. Die erste Spalte enthält die 
Wellenlänge in Nanometern, die zweite die Scope-Daten. 

Die Daten in *.TAT und *.TTT-Dateien werden in fünf Spalten dargestellt. Die erste Spalte 
enthält die Wellenlänge in Nanometern. Die Spalten zwei bis vier stellen entsprechend die 
Dunkel-, Referenz- und Scope-Daten dar. Die fünfte Spalte zeigt den errechneten Wert für 
Absorption (in *.TAT-Dateien) oder Transmission (in *.TTT-Dateien). 

Das Format der Irradiance-Textdateien (*.TIT) hängt von der Verfügbarkeit von getSoft-IRRAD 
ab. Eine uneingeschränkte Irradiance-Textdatei, welche erstellt wird, wenn getSoft-IRRAD 
verfügbar ist, enthält sechs Spalten. Die beiden ersten Spalten enthalten die Wellenlänge und 
die Dunkeldaten. Die dritte Spalte ist die Transfer-Funktion von Zahl zu Mikrowatt. Die vierte 
Spalte enthält die gemessenen Zahlen. In den Spalten fünf und sechs werden die errechneten 
Irradiance-Werte in Mikrowatt/cm² (Spalte 5) und in Photoneinheiten (Spalte 6) dargestellt. 

Eine eingeschränkte Irradiance-Textdatei, welche erstellt wird, wenn getSoft-IRRAD nicht 
verfügbar ist, enthält fünf Spalten. Die erste enthält die Wellenlänge in Nanometern. Die 
Spalten zwei bis vier stellen entsprechend die Dunkel-, Referenz- und Scope-Daten dar. Die 
fünfte Spalte zeigt den errechneten Wert für relative Irradiance. 

3.1.12 File Menu: Convert Graph – To ASCII Equi distance 

Um diese Option zu nutzen, müssen die Grafikdateien vorher mit der Option „File -> Save 
Experiment“ abgespeichert werden. Nachdem die Option „File -> Convert Graph -> To 
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ASCII – Equi distance” ausgewählt wurde, können der Wellenlängenbereich, für welchen die 
Grafik konvertiert werden soll, und die Entfernung zwischen zwei aufeinanderfolgenden 
Datenpunkten in einem Fenster eingegeben werden (Abb. unten).  

Nachdem mit dem „OK“-Button bestätigt wurde, können die Dateien, die konvertiert werden 
sollen, ausgewählt werden. Die Auswahl der Dateien läuft analog zur Konvertierung zu ASCII 
ohne Equi distance (siehe „3.1.11 File Menu: Convert Graph – To ASCII“). 

Auch die Informationen in der Kopfzeile sind identisch mit denen bei der Konvertierung zu 
ASCII ohne Equi distance. Die Daten in den *.TRT, *.TAT, *.TTT und *.TIT-Dateien werden in 
zwei Spalten dargestellt. Die erste Spalte enthält die äquidistante Wellenlänge in Nanometern. 
Die zweite Spalte enthält die interpolierten Werte für die Scope-Daten (in *.TRT-Dateien), für 
Absorption (in *.TRT-Dateien), für Transmission (in *.TTT-Dateien) oder Bestrahlungsstärke 
(in *.TIT-Dateien).  

3.1.13 File Menu: Convert Graph – To JCAMP 

JCAMP-DX ist ein Standard-Dateiformat für den Austausch von Spektren zwischen 
verschiedenen Spektrometersystemen und Computern. Ein JCAMP-DX-Spektrum ist eine 
Textdatei, die mit einem Texteditor eingesehen, korrigiert und kommentiert werden kann. Viele 
andere komplizierte Spektrometerprogramme wie GRAMS32 und OPUS sind im Stande, 
Dateien in das JCAMP-DX-Format zu konvertieren. 

Das JCAMP-Format erfordert eine gleichwertige Entfernung zwischen Datenpunkten auf der 
X-Achse (Wellenlänge). Das Konvertieren von CCD-Pixeln zu Wellenlängenpunkten ist keine 
lineare Funktion. Deswegen werden 2048-Datenpunkte (für ein getSpec-2048) vor dem 
Schreiben in JCAMP zunächst linearisiert. 

Um diese Option zu nutzen, müssen die Grafikdateien vorher mit der Option „File -> Save 
Experiment“ abgespeichert werden. Nachdem die Option ausgewählt wurde, öffnet sich ein 
Fenster, welches alle Dateien im momentanen Messmodus anzeigt.  

Zum Beispiel lautet im Scope-Modus die Dateierweiterung der gespeicherten Spektren *.roh.  

Um Grafikdateien auszuwählen, die in anderen Messmodi (z.B. Absorption) gespeichert 

wurden, klicken Sie  hinter dem „Graph ...-Modus“ und wählen Sie den gewünschten 
Messmodus aus. 

Um gespeicherte Grafikdateien von einem anderen Verzeichnis oder Laufwerk auszuwählen, 

klicken Sie  hinter dem momentan angezeigten Ordnernamen. 

Um gespeicherte Grafikdateien von einem anderen Verzeichnis oder Laufwerk auszuwählen, 
klicken Sie den Auswahlschalter hinter dem momentan angezeigten Ordnernamen. 

Wenn eine Grafikdatei durch einen Mausklick auf den Dateinamen markiert wurde, erscheint 
die Kommentarzeile ganz oben im grafischen Bereich im Hauptfenster. Mehrere Dateien 
können mit der Kombination CTRL oder SHIFT und der Maus ausgewählt werden. 
Wenn die CTRL-Taste gedrückt gehalten wird, werden alle Dateien, die mit der Maus 
ausgewählt werden, konvertiert. Wenn die SHIFT-Taste gedrückt gehalten wird, werden alle 
Dateien zwischen zwei mit der Maus ausgewählten Dateien konvertiert. 
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Wählen Sie den Namen der Datei/en, die zu JCAMP konvertiert werden soll/en und klicken 
Sie den Button „Open“. Um das Fenster zu verlassen und keine Dateien zu konvertieren, 
klicken Sie auf den Button „Cancel“. Die Textdateien im JCAMP-Format haben immer eine 
DX-Endung. Wenn zum Beispiel die Dateien gts0001.trm und gts0001.abs zu JCAMP 
konvertiert werden sollen, wird das Ergebnis in beiden Fällen gts0001.dx lauten. 

3.1.14 File Menu: Exit 

Schließt getSoft.  

USB2 

Mit den USB2-Spektrometern werden die Messeinstellungen im EEPROM gespeichert, bevor 
die Software geschlossen wird. Während des Speicherprozesses darf das Spektrometer auf 
keinen Fall ausgeschalten werden. Ein Fenster (Abb. rechts) erscheint, so lange die Daten 
gespeichert werden (weniger als eine Sekunde bei USB2, etwa acht Sekunden bei einer 
RS232/Bluetooth-Verbindung). 
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3.2 Setup Menu 

 

3.2.1 Setup Menu: Hardware 

USB1-Plattform 

Diese Menüoption zeigt eine Liste der Seriennummern von 
Spektrometern an, die momentan mit dem USB-Anschluss 
und COM-Anschluss des Computers verbunden sind und zur 
Zeit von keiner anderen Anwendung benutzt werden. 

Diese Option kann genutzt werden, um einer Anwendung ein 
Spektrometer zuzuweisen (z.B. wenn ein Spektrometer unter 
getSoft und ein zweites unter der getSoft-Raman-Software 
betrieben werden muss). Die Option dient aber auch dem 
gleichzeitigen Betrieb mehrerer Spektrometer durch 
mehrfaches Neustarten von getSoft.  

Nachdem der Button „OK“ betätigt wurde, beginnt getSoft mit der Kommunikation der im 
Fenster ausgewählten Spektrometer. 

USB2-Plattform 

 

Diese Option zeigt alle verbundenen Spektrometer an. Es können die Namen der Kanäle 
gewechselt sowie Spektrometer aktiviert und deaktiviert werden. Für die Synchronisation der 
Scans muß ein Master Sync Spektrometer bestimmt werden. In Mehrkanal-Plattformen ist 
gewöhnlich das linke (von vorne gesehen) Spektrometer dafür vorhergesehen. 
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Nur getSpec-3648-USB 

Der Toshiba-Detektor, der im getSpec-3648 eingebaut ist, kann in zwei verschiedenen 
Kontrollmodi eingesetzt werden: 

1. Vorscan-Modus (eingestellter Modus) 

In diesem Modus wird der Toshiba-Detektor automatisch für jede Abfrage vom PC einen 
zusätzlichen Vorscan erzeugen. Der erste Scan enthält nichtlineare Daten und wird 
aussortiert. Der zweite Scan enthält lineare Daten und wird am Bildschirm angezeigt 
und/oder gesichert. 

Der voreingestellte Vorscan-Modus sollte bei den meisten Anwendungen benutzt werden. 
Zum Beispiel bei der Mittelung (nur ein Vorscan wird erstellt für eine Anzahl Mittelungen), 
bei Gebrauch der getLight-XE (ein oder mehrere Blitze pro Scan) und bei Mehrkanal-
Spektrometer. Der Vorteil dieses Modus ist ein sehr stabiles und lineares Spektrum. Der 
Nachteil dieses Modus ist, dass ein kleineres Bild (< 5 %) des vorhergehenden Scans im 
Zeichen enthalten ist (ghost spectrum).  

Dieser Modus kann nicht für den schnellen externen Trigger und für akkurate Zeitvorgaben 
benutzt werden, weil der Start des Scan stets die Integrationszeit verzögert (mind. 3,7 
ms). 

2. Der Clear-Buffer-Modus 

In diesem Modus wird der Toshiba-Detektorenpuffer gelöscht, bevor der Scan genommen 
wird. Dieser Modus sollte benutzt werden, wenn Zeitvorgaben wichtig sind, wie z.B. beim 
schnellen externen Trigger. 

Der Vorteil diese Modus ist, dass der Scan zur gleichen Zeit wie der externe Trigger 
startet. Der Nachteil dieses Modus ist, dass nach dem Löschen des Puffers der Detektor 
einen kleineren Grenzwert hat. Dort werden kleine Signale (< 500 Einheiten) nicht 
erscheinen und bei verschiedenen Integrationszeiten ist der Detektor nicht linear. 

3.2.2 Setup Menu: Wavelength Calibration Coefficients 

Nachdem Sie diese Option ausgewählt haben, öffnet sich ein Fenster, in dem die 
Koeffizienten der Wellenlängenkalibrierung manuell geändert werden können.  

Hintergrund 

Die Wellenlänge ? , die sich auf eine Pixelanzahl im Detektor im Spektrometer bezieht, kann 
durch die folgende Gleichung berechnet werden: 

4
4

3
3

2
21 pixnrXpixnrXpixnrXpixnrXIntercept ??????????  

wobei der Abschnitt (Intercept) und X1 bis X4 sich auf die Werte für Abschnitt und den ersten 
bis vierten Koeffizienten beziehen. Wenn zum Beispiel die Wellenlänge bei Pixelzahl 1000 
berechnet werden soll, erhält man unter Verwendung der Werte aus der Abbildung unten:  

?  = 384,054 + 0,136492·1000 +  
-6,71259E-6·1E6 + 
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-5,66234E-10·1E9 
= 513,267 nm. 

Der Button „Restore Factory Settings“ setzt 
die Koeffizienten für die 
Wellenlängenkalibrierung für alle 
Spektrometerkanäle auf die Koeffizienten, die 
während der Werkskalibrierung in EEPROM 
gespeichert wurden, zurück. 

Die Option „Process data only when in 
following wavelength range“ kann für den 
Transfer einer begrenzten Anzahl von Pixeln 
vom Spektrometer zum PC verwendet werden. Dies kann den Transfer entscheidend 
beschleunigen (z.B. für getSpec-2048 von 30 ms bei voller Wellenlänge auf 14 ms für eine 
kleine Auswahl von 10 Pixeln). Ein zweiter Vorteil ist die Reduzierung von Daten, weil nur die 
Spektraldaten der Pixel gespeichert werden, für welche die Wellenlänge im 
Wellenlängenbereich liegt.  

3.2.3 Setup Menu: Smoothing and Spline 

Der kubische Spline-Interpolations-Algorithmus kann für eine 
bessere Abschätzung der Spektraldaten zwischen den Pixeln im 
Detektorbereich genutzt werden. 

Die Glättung ist ein Vorgang, bei dem die Spektraldaten über eine 
Anzahl von Pixeln im Detektor-Bereich gemittelt werden. Wenn der 
Glättungsparameter zum Beispiel auf 2 eingestellt ist, werden die 
Spektraldaten für alle Pixel xn im Detektorbereich mit deren 
benachbarten Pixeln xn-2, xn-1, xn+1 und xn+2 gemittelt. 

Kubische Spline-Interpolation 

In der Abbildung unten wird der Effekt der Spline-Interpolation dargestellt. Die Masterdaten 
zeigen die AD-Einheiten für 4 Pixel, die durch eine gerade Linie verbunden sind. Die Slave1-
Daten sind für diese 4 Pixel identisch, aber diesmal wurde der kubische Spline-
Interpolationsalgorithmus angewendet. 
Dies hat zur Folge, dass die erste 
Ableitung der Daten geglättet und die 
zweite Ableitung konstant ist. 

Die Spline-Interpolation ist für 
Anwendungen sinnvoll, in denen die 
Ausgaben von „Line-Sources“ wie 
Laserdioden dargestellt werden müssen 
oder die generell eine hohe Auflösung 
erfordern. Beachten Sie, dass beim 
getSpec-2048 mit 2048 Pixeln der Effekt 
der Spline-Interpolation nicht sichtbar ist, 
wenn Daten in Originalgröße dargestellt 
werden. Die Bildschirmauflösung ist 
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wesentlich geringer als 2048 Pixel. Der Effekt der Spline-Interpolation ist nur dann sichtbar, 
wenn die Anzahl der Detektor-Pixel kleiner ist als die Anzahl der Bildschirm-Pixel auf der x-
Achse. 

Glättung 

Um ein glätteres Spektrum ohne Informationsverlust zu erhalten, ist es wichtig, die richtigen 
Glättungsparameter in der Software einzustellen. Die optimale Einstellung hängt von der 
Entfernung der Pixel im Detektorbereich und dem Lichtstrahl, der ins Spektrometer eintritt, ab. 
Für das getSpec-2048 beträgt die Entfernung zwischen den Pixeln im CCD-Bereich 14 µm. 

Wenn eine 200 µm-Faser verwendet wird, beträgt die optische Pixel-Auflösung ungefähr 14,3 
CCD-Pixel. Wenn der Glättungsparameter auf 7 eingestellt ist, wird jedes Pixel mit 7 nach 
links benachbarten und 7 nach rechts benachbarten Pixeln gemittelt. Die Mittelung von über 
15 Pixeln mit einem Höhenunterschied zwischen den CCD-Pixeln von 14 µm nimmt eine 
Fläche von 15 x 14 µm im CCD-Bereich in Anspruch. Wenn man einen Faserdurchmesser 
von 200 µm verwendet, verliert man Auflösung, wenn der Glättungsparameter auf 7 eingestellt 
ist. Theoretisch ist somit 6 der optimale Glättungsparameter.  

Wenn ein Spalt im Spektrometer installiert ist, beträgt die optische Pixel-Auflösung 3,6 CCD-
Pixel. Der Glättungsparameter sollte auf 1 eingestellt sein.  

Die Formel dafür ist ((Spaltgröße/Pixelgröße) – 1)/2. 

In der Tabelle (Abb. unten) sind die empfohlenen Werte für die Glättungsparameter des 
getSpec als eine Funktion des Lichtbalkens aufgelistet, welcher ins Spektrometer eintritt. 
Dieser Lichtstrahl entspricht dem Faserkerndurchmesser oder der Spaltbreite, sollte ein 
schmalerer Spalt im Spektrometer installiert sein. Beachten Sie, dass diese Tabelle die 
optimale Glättung ohne Auflösungsverlust darstellt. Wenn die Auflösung keine wichtige 
Kenngröße ist, kann ein höherer Glättungsparameter eingestellt werden, um Störungen für 
den Preis einer geringeren Auflösung zu verringern.   

slit/fiber 
getSpec-102 
Pixel 77 µm 

getSpec-
256/1024 
Pixel 25 µm 

getSpec-2048 
Pixel 14 µm 

getSpec-3648 
Pixel 8 µm 

getSpec-
NIR256 
Pixel 50 µm 

10 µm nicht verfügbar nicht verfügbar 0 0 nicht verfügbar 

25 µm nicht verfügbar 0 0 - 1 1 nicht verfügbar 

50 µm 0 0 - 1 1 - 2 2 - 3 0 

100 µm 0 - 1 1 - 2 3 5 - 6 0 - 1 

200 µm 1 3 - 4 6 - 7 12 1 - 2 

400 µm 2 7 - 8 13 - 14 24 - 25 3 - 4 

500 µm 3 9 - 10 17 31 4 - 5 

600 µm 3 - 4 11 - 12 21 37 5 - 6 
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3.2.4 Setup Menu: Correct for Dynamic Dark (nur getSpec-2048/3648) 

Die Pixel des CCD-Detektors (getSpec-2048/3648) sind wärmeempfindlich, was sogar ohne 
Lichteinfall einen geringen Dunkelstrom verursacht. Um einen ungefähren Wert für diesen 
Dunkelstrom zu erhalten, kann das Signal der ersten 14 optischen schwarzen Pixel des 
CCD-Detektors von den Roh-Scope-Daten aufgenommen und subtrahiert werden. Dies 
geschieht, wenn die Option „Correct for dynamic dark“ aktiviert ist. Da diese Pixel das gleiche 
Wärmeverhalten wie die aktiven Pixel besitzen, ist die Korrektur dynamisch.  

Beachten Sie, dass sich dieser Dunkelstrom von dem Dunkelstrom unterscheidet, welcher 
vor jeder Transmissions- und Absorptionsmessung gespeichert werden muss („File -> Save 
Dark“). 

Wenn die Korrektur „Correct for dynamic dark“ geändert wurde, ist es erforderlich, ein neues 
Dunkel- und Referenzspektrum zu speichern, da die Rohdaten verändert wurden. 

Wenn dieser Menüoption ein Häkchen vorangestellt ist, werden die Scope-Daten mit dem 
Dynamischen Dunkelheitsalgorithmus korrigiert. Es wird empfohlen, diese Einstellung 
markiert zu lassen, was auch den vorgegebenen Einstellungen entspricht. 

3.2.5 Setup Menu: Substract Saved Dark 

Diese Option wird verwendet um das gespeicherte Dunkelspektrum („File -> Save Dark“) von 
den Roh-Scope-Daten zu subtrahieren. Wenn Sie getSoft gestartet haben, ist diese 
Menüoption immer ungewählt, da ein Dunkelspektrum gespeichert oder geladen werden 
muss, bevor es subtrahiert werden kann. 

Wenn dieser Menüoption ein Häkchen vorangestellt ist, werden die Scope-Daten mit den 
gespeicherten Dunkeldaten korrigiert. 

3.2.6 Setup Menu: Strobe Enable 

Mit dieser Option kann eine externe gepulste Lichtquelle (z.B. XE-2000), die an das getSpec-
2048-Spektrometer angeschlossen ist, aktiviert oder deaktiviert werden. 

Die gemessene Lichtintensität der XE-2000 ist unabhängig von der Integrationszeit in getSoft. 
Um die Lichtintensität zu erhöhen, sollte die Anzahl der Impulse pro Integrationsintervall 
erhöht werden. Die Maximalfrequenz, mit der die XE-2000 arbeitet, ist 100 Hz. Dies bedeutet, 
dass die minimale Integrationszeit für einen Impuls pro Scan 10 ms beträgt. Wenn Sie die 
Anzahl der Impulse z.B. auf 3 einstellen, beträgt die entsprechende minimale Integrationszeit 
30 ms. Es wird empfohlen, die Integrationszeit so niedrig wie möglich zu halten, um einen 
unnötigen Anstieg des Rauschens zu vermeiden. 

USB1-Plattform 

getLight-2000 wird an getSpec angeschlossen, indem ein IC-DB15-2 Schnittstellenkabel mit 
15-poligem High Density SUB-D-Anschlüssen mit getSpec und getLight-XE verbunden wird.  

Falls eine alte XE-2000 benutzt wird, besitzt die Lampe die Möglichkeit zwischen Single Flash 
und Multi Flash zu wechseln, für diesen Fall gibt es einen Schalter an der Rückseite des XE-
2000. Wenn XE-2000 mit einem getSpec-Spektrometer verwendet wird, muss der Schalter 
immer auf Single Flash eingestellt sein. Im Single-Flash-Modus löst XE-2000 am Pin 1 aus, 
im Multi-Flash-Modus am Pin 2. 
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Wenn die Option „Strobe Enable“ angeklickt wird, 
öffnet sich ein Fenster, in dem die Anzahl der 
Impulse eingegeben werden kann (Abb. rechts). 
Wenn die Option im Menü mit einem Häkchen 
markiert ist, wurde sie ausgewählt. Um die extern 
gepulste Lichtquelle auszuschalten, entfernen Sie 
einfach das Häkchen vor der Option im Menü. 

Strobe (getLight-XE) Control USB2-Plattform 

getLight-XE wird an getSpec-USB2 angeschlossen, indem 
ein IC-DB26-2 Schnittstellenkabel zwischen dem 26-
poligem High Density SUB-D-Anschlüssen mit getSpec-
USB2 und dem 15-poligem DB-Anschluss von getLight-XE 
verbunden wird. Wenn es mit einem Mehrkanalsystem 
verwendet wird, muß getLight-XE mit dem Master-Sync-
Spektrometer verbunden werden. Nur die Anzahl der Flashs 
pro Scan, die für das Master-Sync-Spektrometer eingestellt 
worden ist, bestimmt die Flashrate. Um die extern gepulste 
Lichtquelle auszuschalten, tragen Sie den Wert „0“ bei 
„NrOfFlashes“ ein. 

3.2.7 Setup Menu: 1 kHz Enable (USB1-Plattform) 

Pin 2 des „High density 15-poligem Sub-D”-Anschlusses am getSpec-2048 kann für die 
Erzeugung eines 1 kHz-Signals verwendet werden. Dieses Signal kann für die Kontrolle einer 
getLight-XE-Lichtquelle gepulsten Modus verwendet werden. 

3.2.8 Setup Menu: PWM (getLight-LED) Control (USB2-Plattform) 

getLight-LED wird an getSpec-USB2 angeschlossen, indem ein IC-DB26-2 
Schnittstellenkabel zwischen dem High Density 26-poligem SUB-D-Anschlüssen mit 
getSpec-USB2 und dem 15-poligem DB-Anschluss von getLight-LED (DO1 – pin11) 
verbunden wird.  

Die Frequenz kann zwischen 500 Hz und 300 kHz eingestellt werden. Das Tastverhältnis 
(Duty Cycle) kann zwischen 0 und 100 % eingestellt werden.  

Wenn das Spektrometer zusammen mit einem Mehrkanalsystem verwendet wird, können 
alle Kanäle ihre eigene unabhängige PWM-
Einstellung für beide Frequenzen und das 
Tastverhältnis haben. 

Um die PWM-Ausgabe auszuschalten, tragen 
Sie einfach „0“ bei Aussteuerung ein. 
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3.2.9 Setup Menu: Options 

 
Alle Optionen, die in diesem Abschnitt beschrieben werden, sind standardmäßig in der 
getSoft-Vollversion enthalten. In getSoft BASIC sind diese Features nicht verfügbar. 

3.2.9.1 Setup Menu: Options – Check on Saturation 

Der 14-Bit-A/D-Konverter im getSpec ergibt Rohwerte für Scope-Pixel zwischen 0 und 16383 
Einheiten. Wenn der Wert von 16383 Einheiten bei einem oder mehreren Pixeln gemessen 
wird, dann werden diese Pixel „gesättigt“ oder „überbelichtet“ genannt. Da gesättigte Pixel das 
Messergebnis stören können, wurde in getSoft (und im Treiberpaket „as161.dll/AS-
5216.DLL“) großer Wert auf die Detektion der Sättigung gelegt. Der Nutzer wird informiert, 
wenn eine Messung gesättigte Pixel enthält. Dabei hat der Nutzer stets die Möglichkeit, die 
Sättigung zu ignorieren, zum Beispiel wenn der gesättigte Pixel außerhalb des relevanten 
Wellenlängenbereichs liegt. Das Problem der Sättigung kann in den meisten Fällen durch die 
Eingabe einer kürzeren Integrationszeit gelöst werden. Sollte bei einer minimalen Integration 
das Signal noch immer zu hoch sein, müssen eventuell Dämpfungsglieder, neutrale Dichte-
Filter oder Fasern mit geringerem Durchmesser benutzt werden. 

In getSoft können verschiedene Levels der Sättigungsdetektion eingestellt werden. Weiterhin 
existieren verschiedene Optionen für die Benachrichtigung (Abb. unten).  

Levels der Sättigungsdetektion 

Das vorgegebene Level für 
Sättigungsdetektion ist „Detect Saturated 
Pixels at saturation level”. Das dritte Level 
(autocorrect inverted pixels) ist nur für 
getSpec-2048-Spektrometer verfügbar. 
Der Grund dafür ist, dass wenn der 
Detektor-Typ im getSpec-2048 (Sony-
ILX554) stark gesättigt ist (bei einer 
Lichtintensität etwa 5-mal so hoch wie die, 
bei welcher Sättigung beginnt), wird er 
Werte < 16383 Einheiten zurücksenden. 
Die anderen Detektor-Typen in getSpec-
102, 256, 1024 und 3648 zeigen diesen 
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Effekt nicht und müssen auch nicht korrigiert werden. Im Normalfall müssen Sie das dritte 
Level für das getSpec-2048 auch nicht verwenden, aber wenn Sie ein spitzenreiches 
Spektrum mit einigen stark gesättigten Pixeln messen, kann die Autokorrektur verwendet 
werden. Zur Veranschaulichung nehmen wir an, dass eine starke Spitze der getLight-CAL-
Kalibrierlinie bei 435,84 nm stark gesättigt ist. Dies hatte zur Folge, dass die am stärksten 
gesättigten Pixelwerte umgekehrt (< 16383) zurückgesendet wurden (Abb. unten links). In der 
rechten Abbildung wurde die Sättigungsdetektion auf das dritte Level eingestellt, was nicht nur 
die gesättigten Pixel bei 16383 erkennt, sondern auch die umgekehrten Werte für die Pixel 
korrigiert. Der Nachteil der Autokorrektur ist, dass die Verarbeitung der „gesättigten“ Scans 
durch die Anwendung länger dauert. 

 

Benachrichtigung über Sättigung 

Wenn die Sättigungsdetektion nicht ausgeschaltet wurde, zeigt die Statusleiste der 
Spektrometerkanäle das Textlabel „Saturated” an, solange einer oder mehrere Pixel dieses 
Spektrometerkanals gesättigt sind: 

 
Dies ist für Messungen im Transmissions-, Absorptions- und Bestrahlungsmodus nützlich, 
da in diesen Modi die Sättigung nicht durch Beobachtung der Anzahl von Einheiten, wie im 
Scope-Modus, kontrolliert werden kann. Doch selbst im Scope-Modus kann ein Spektrum 
gesättigte Pixel enthalten, auch wenn dies nicht eindeutig aus dem Graphen hervorgeht.  

Beispiele sind: 

o Glättung. Der maximale Pixel-Wert für ein Minimum/Maximum kann gesättigt sein, 
wird aber mit Nachbarpixeln gemittelt, die nicht gesättigt sein müssen.  

o Der „Correct for dynamic dark”-Algorithmus subtrahiert die Dunkelwerte, die bei den 
optischen schwarzen Pixeln gemessen wurden, von den Spektraldaten. Somit kann 
das Sättigungslevel von 16383 Einheiten nie erreicht werden, wenn „Correct for 
dynamic dark” aktiviert ist. Die Sättigungsdetektion wird in getSoft vor der Korrektur für 
dynamische Dunkelheit durchgeführt, so dass auch bei Aktivierung von „Correct for 
dynamic dark” eine Sättigungsdetektion stattfindet. 

o Bildschirmauflösung. Der CCD hat 2048 Pixel, was einem weitaus höheren Wert als 
dem für die Monitorpixel im Graphen entspricht. Da nicht jeder CCD-Pixel auf dem 
Bildschirm angezeigt werden kann, kann eine Spitze bei einem CCD-Pixel gesättigt 
sein, obwohl dies auf dem Bildschirm nicht sichtbar ist. Benutzen Sie die Zoom-
Funktion, um den Grund der Sättigung zu überprüfen. 
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o Zoom in. Sättigung kann auch bei nicht sichtbaren Wellenlängenbereichen auftreten, 
da der Graph nicht im Originalmaßstab dargestellt ist. 

Wenn all diese Umstände eintreten, wird jeweils das „Saturated”-Zeichen in der Statusleiste 
des Spektrometerkanals angezeigt, für welchen ein oder mehrere Pixel gesättigt sind. Bei 
Zeitreihenmessungen (History-Channel-Funktionen, Farbe/Zeit, Bestrahlungsstärke/Zeit) wird 
die Sättigungsdetektion nur für den relevanten Wellenlängenbereich durchgeführt. Der 
relevante Wellenlängenbereich für Farbmessungen liegt bei 380 bis 780 nm. Für History-
Channel-Funktionen wird der relevante Wellenlängenbereich vom Nutzer festgelegt. Wenn 
beispielsweise ein Integral zwischen 500 und 505 nm überwacht werden soll, wird die 
Sättigungsdetektion und -benachrichtigung nur für diesen Bereich vorgenommen. Sollte eine 
Sättigung vorliegen, erscheint das „Saturated“-Zeichen in der History-Channel-Ausgabe. 
Wenn die Zeitreihenmessungen online in Excel gespeichert werden, ändert sich die 
Schriftfarbe für den History-Channel zu rot, solange die Ausgabe dieses Kanals gesättigt ist. 

Nur USB1-Plattform 

Die folgenden Optionen sind nur für die USB1-Plattform-Spektrometer verfügbar. Bei ihrer 
Aktivierung können Informationen über gesättigte Wellenlängenbereiche angezeigt werden 
und/oder gesichert werden: 

 

Gesättigte Pixel-Bereiche im Graphen veranschaulichen 

Wenn diese Option aktiviert wird, wird das Spektrum im Hauptfenster mit einer dickeren Linie 
in den Wellenlängen-Bereichen dargestellt, in denen die Sättigung auftritt. In 
Zeitreihenmessungen werden die Funktionsausgabewerte, die mit gesättigten Daten 
berechnet wurden, mit einem schwarzen Punkt markiert.  
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Gesättigte Pixelbereiche auf den Bildschirm einloggen 

Durch Aktivierung der zweiten Option erscheint ein kleines Fenster, in welchem die 
Spektrometer-Kanalnummer (0 = Master, 1 = Slave1 usw.) und der Wellenlängenbereich für 
die gesättigten Pixel angegeben sind. 

Gesättigte Pixelbereiche in eine Datei von „Save Measurement” einloggen 

Die dritte Option kann zum Erstellen einer Datei verwendet werden, in welcher die gesättigten 
Wellenlängenbereiche festgehalten werden, wenn in getSoft eine Messung gespeichert wird. 
Wenn Sie Spektren vom Hauptfenster aus speichern („Save”-Button oder Menüoption „File -> 
Save -> Experiment”), wird der Name der Log-Datei bis auf die Erweiterung *.sat identisch 
mit dem Name des Experiments. Wenn zum Beispiel ein Graph im Absorptionsmodus in 
test0001.abs gespeichert wird und das Spektrum gesättigte Pixel enthält, werden zusätzliche 
Zeilen in die Datei test.sat geschrieben.  

Wenn Zeitreihenmessungen, Farbmessungen oder Bestrahlungsmessungen in einer Datei 
gespeichert werden, werden die Daten auch auf Sättigung überprüft. Wenn Sättigung auftritt, 
werden in der Log-Datei zusätzliche Zeilen eingefügt. Bis auf die Erweiterung *.sat (z.B. 
History.sat) besitzt die Log-Datei den selben Namen wie die Messergebnisse  

Die Dateien mit der Erweiterung *.sat können mit jedem Editor für Textdateien, wie 
beispielsweise Notepad, geöffnet werden. 

3.2.9.2 Setup Menu: Options – Full Width Half Max  

„Full Width Half Maximum” eines Peaks ist die Bandbreite (in Nanometern), für welche die 
Intensität höher als die Hälfte der maximalen Intensität dieser Spitze ist. Das FWHM kann im 
Scope- oder Bestrahlungsmodus berechnet werden. Die Option wird in den meisten Fällen 
benutzt, um den Output von Laserdioden zu 
messen. Während FWHM-Berechnungen muss 
die Intensität für Dunkeldaten korrigiert werden. Es 
wird deswegen empfohlen, die Option „Subtract 
Saved Dark” zu aktivieren. Nachdem die Option 
ausgewählt wurde, öffnet sich ein Fenster (Abb. 
rechts).  

Nach Betätigung des „OK“-Buttons werden die FWHM-Werte für eine Anzahl von Spitzen 
berechnet. Um eine Spitze zu markieren, für die der FWHM-Wert berechnet werden soll, 
drücken Sie die ALT-Taste und klicken sie mit der linken Maustaste auf die Spitze. Wenn 
lediglich ein Spektrometerkanal aktiviert ist und keine älteren gespeicherten Graphen 
dargestellt werden, wird der FWHM-Wert für die markierte Spitze direkt darüber angezeigt. 
Weiterhin wird diese Spitze über die Breite des FWHM-Wertes gelb markiert (unter 
Umständen muss die Zoom-in-Funktion verwendet werden, um die Markierung sichtbar zu 
machen).Wenn mehr als ein Spektrum dargestellt wird, öffnet sich ein Fenster („Select 
Graph“), in welchem das Spektrum, für das FWHM aktiviert werden soll, aus allen 
dargestellten Spektren ausgewählt werden kann. 

Im Beispiel (Abb. unten) wurden Peaks für die FWHM-Kalkulation ausgewählt. Die FWHM-
Werte werden in derselben Farbe wie das entsprechende Spektrum dargestellt.  
 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 38 

 

 

…more than spectroscopy! 

Um die FWHM-Berechnung zu deaktivieren, muss die Menüoption (mit Häkchen markiert, 
solange FWHM aktiviert ist) ein weiteres Mal ausgewählt werden.  

3.2.9.3 Setup Menu: Options – Integrals 

Diese Option kann man verwenden, um den gesamten Betrag an Energie zu berechnen, der 
in das Spektrometer eintritt. 

Bis zu 10 Integrale können 
gleichzeitig dargestellt werden. Die 
Integralberechnungen sind dann 
aktiviert, wenn sie im entsprechenden 
Fenster (Abb. rechts) definiert 
wurden. Das Fenster wird nach 
Auswahl der Menüoption „Setup -> 
Options -> Integrals” geöffnet. Im 
Beispiel rechts wurden zwei Integrale 
definiert (die ersten zwei sind mit 
Häkchen in den Checkboxen der 
ersten Spalte versehen). In der 
zweiten Spalte kann ein Spektrum 
aus allen Spektren, die momentan im 
Hauptfenster von getSoft dargestellt 
sind, ausgewählt werden. Eine 
vollständige Liste aller auswählbaren Spektren (dies schließt früher gespeicherte Spektren, 
wie Integral 2 im Beispiel, ein) wird angezeigt, wenn man auf den Button (rechts in der 
zweiten Spalte) klickt. In der dritten und vierten Spalte kann der Wellenlängenbereich, über 
den das Integral berechnet werden soll, eingegeben werden. Zuletzt kann ein 
Multiplikationsfaktor für Skalierungszwecke eingegeben werden. Nach Betätigen des „OK“-
Buttons werden die Integralwerte wie im Beispiel unten angezeigt. 
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Um die Integralberechnung zu deaktivieren, muss die Menüoption (mit Häkchen markiert, 
solange Integralberechnung aktiviert ist) ein weiteres Mal ausgewählt werden.  

Um ein Integral in Abhängigkeit von der Zeit zu messen, können bis zu 8 verschiedene 
Funktionen in der History-Anwendung eingegeben werden. 

3.2.9.4 Setup Menu: Options – Autosave Spectra Periodically 

Mit dieser Option können vollständige Spektren automatisch in bestimmten Zeitabständen 
gespeichert werden. Folgende Parameter können eingestellt werden: 

o Time delay before first scan muss 
in Sekunden eingegeben werden. 
Nachdem der „OK“-Button betätigt 
wurde, wartet getSoft diese Anzahl 
von Sekunden ab, bis der nächste 
Scan gespeichert wird. 

o Time delay between scans muss in 
Sekunden eingegeben werden. Dieser 
Wert beschreibt die Zeit zwischen 
dem Speichern von zwei 
aufeinanderfolgenden Spektren. 
Wenn Sie den Wert auf „0“ setzen, 
wird getSoft die Spektren so schnell wie möglich speichern. 

o Number of scans to save: Die Anzahl der Spektren, die gespeichert werden soll, 
kann hier eingegeben werden. 

Oberhalb der Parameter wird die Checkbox „Save As Fast As Possible (no screen updates)” 
angezeigt. 

Wenn das weiße Kästchen vor der Textzeile markiert ist, speichert die automatische 
Speicherfunktion die eingegebene Anzahl von Scans immer so schnell wie möglich. Um dies 
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zu bewerkstelligen, wird das Zeitintervall zwischen den Scans auf 0 ms gesetzt, sobald die 
Checkbox aktiviert wurde. Wenn diese Option ausgewählt ist, werden die Spektren im 
Vergleich zu vorher 5 bis 10mal schneller gespeichert. Die Erhöhung der Geschwindigkeit 
wurde vor allem aus zwei Gründen erreicht: 

1. Während die eingegebene Anzahl von Scans gespeichert wird, ist die Bildschirm-
Aktualisierung, welche sehr viel Zeit in Anspruch nimmt, deaktiviert. Dafür wird das 
Hauptfenster minimiert und die Anzahl der zu speichernden Scans wird in einem neuen 
Fenster heruntergezählt.  

2. Es werden keine Kommentardateien erstellt.  

Andere Faktoren, die eine positive Auswirkung auf die Geschwindigkeit der Datenerfassung 
haben und welche in getSoft eingestellt werden können, sind: 

o Glättungsparameter, 
o Integrationszeit, 
o Mittelung, 
o Anzahl der zu transferierenden Pixel (siehe Abschnitt „3.2.2 Setup Menu: Wavelength 

Calibration Coefficients“). 

Weiterhin ist es empfehlenswert, die Anzahl der Dateien in Ihrem Experimentverzeichnis auf 
eine Maximalzahl von einigen wenigen Hundert zu begrenzen, da eine größere Anzahl von 
Dateien eine negative Auswirkung auf die Systemgeschwindigkeit hat. Wenn das 
automatische Speichern abgebrochen werden soll, bevor alle Spektren gespeichert wurden, 
muss die Menüoption „Setup -> Options -> Autosave Spectra Periodically” erneut ausgewählt 
werden und bei der Anzahl der zu speichernden Spektren „0“ eingegeben werden. 

Save on Digital IN (nur USB2-Plattform) 

Bei der USB2-Plattform kann der DB26-Anschluss mit den Pins 7, 16 und 24 benutzt werden, 
um ein Spektrum, eine Referenz oder Dunkeldaten zu speichern. 

Das ist besonders nützlich für 
automatische Abfragen in einer 
Prozeßkontroll-Umgebung mit 
periodischen Updates von Dunkel- 
und Referenzsignalen. 

Es empfiehlt sich, den „Automatic 
Save Dark by TTL Shutter“ in 
Kombination mit der Einstellung 
„Save On Digital IN - Dark“ zu 
aktivieren. 
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3.2.9.5 Setup Menu: Options – Correct for Drift (nur USB1-Plattform) 

 
Einleitung 

Wenn man die Reflexion einer weißen Referenzkachel oder die Transmission einer Ver-
gleichslösung in Abhängigkeit von der Zeit misst, sollte der Output bei 100 % +/- Rauschanteil 
gleich bleiben. In der Praxis wird der Output-Wert nicht genau um 100 % schwanken, aber 
das Signal kann langsam abdriften. Die Ursache dieser Drift im Messsystem kann eine 
Temperaturveränderung in der optischen Bank sein, was eine Mikrokrümmung der Kompo-
nenten, die das Licht auf den Detektor lenken, verursachen kann. Auch eine Drift der zur 
Bestrahlung der Referenzprobe verwendeten Lichtquelle ist denkbar.  

Um eine Drift im System zu korrigieren, muss sie zunächst gemessen werden. Dies kann mit 
einem 2-Kanal-Faseroptikschalter (FOS-2-INLINE-UV/VIS) bewerkstelligt werden, wobei ein 
Kanal an der Referenzprobe und der zweite an der zu messenden Probe angeschlossen 
wird. Durch regelmäßiges Umschalten der Kanäle (manuell oder automatisch) kann die 
gemessene Abweichung von 100 % beim Referenzkanal zur Kompensation der gemessenen 
Daten des Probekanals verwendet werden.  

Das gleiche Prinzip kann auf ein 2-Kanal oder Multi-Kanal-Spektrometer angewendet werden. 
In diesem Fall können Referenz- und Probe-Daten gleichzeitig gemessen und die 
Referenzdaten direkt zur Korrektur der Probedaten verwendet werden. Der Nachteil des 
„Correct for drift by spectrometer channel”-Prinzips ist, dass Referenz- und Probe-Daten 
unter Verwendung von zwei optischen Bänken gemessen werden, welche unterschiedlich auf 
Temperaturveränderungen reagieren können. Wenn die Drift hauptsächlich von der 
Lichtquelle verursacht wird (wie beispielsweise Unterschiede in der Flashintensität einer XE-
2000), wird diese Art der Korrektur empfohlen. Der Vorteil des „Correct for drift by FOS-2-
INLINE-UV/VIS”-Prinzips ist, dass es auch die Drift korrigiert, die durch Temperaturver-
änderungen der optischen Bank auftreten. Der Nachteil des Prinzips ist, dass die Korrektur 
seriell erfolgt, so dass nicht jeder Scan sofort korrigiert wird. Weiterhin muss ausreichend Zeit 
verfügbar sein, um die Kanäle zu wechseln. 

Driftkorrektur mit FOS-2-INLINE-UV/VIS 

Der FOS-2-INLINE-UV/VIS ist ein 2-Kanal-Faseroptikschalter. Das Wechseln zwischen den 
optischen Kanälen kann manuell oder durch ein TTL-Signal (siehe Betriebs- oder FOS-2-
INLINE-UV/VIS–Hardware-Handbuch) erfolgen. Durch den Anschluss eines IC-DB15-2-
Schnittstellenkabels zwischen dem getSpec-2048 und FOS-2 (oder eines IC-DB15-FOS2-2, 
wenn vom getSpec-2048 außerdem ein Shutter kontrolliert werden muss) kann das 
Spektrometer die Position des Schalters steuern. In getSoft wurde der untere Kanal als 
Referenzkanal definiert, während der obere Kanal an den Lichtweg angeschlossen werden 
sollte, der zur Messung der Proben verwendet wird.  

Die Driftkorrektur mit dem FOS-2 kann in zwei Wegen bewerkstelligt werden.  

1. Durch regelmäßiges Wechseln in den FOS-Referenzkanal kann das gemessene 
Spektrum mit dem gespeicherten FOS-Referenzspektrum verglichen werden. Die 
Unterschiede können für die Korrektur der Daten genutzt werden, die mit dem FOS-
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Probekanal gemessen werden. Um die Probedaten korrigieren zu können, müssen 
folgende Daten verfügbar sein: 

o Dunkelspektrum FOS-Probekanal, 
o Dunkelspektrum FOS-Referenzkanal (wenn die Integrationszeit des Referenzkanals 

von der des Probekanals abweicht), 
o Referenzspektrum des FOS-Referenzkanals 

2. Im Transmissions-/Reflexions- oder Absorptionsmodus kann das am FOS-Referenzkanal 
gemessene Spektrum als neue Referenz für den FOS-Probekanal verwendet werden. 
Um die Unterschiede in der Empfindlichkeit zwischen beiden FOS-Kanälen zu korrigieren, 
muss das Referenzmaterial (weiße Kachel oder leer) im FOS-Referenzkanal sowie im 
FOS-Probekanal gespeichert werden. Diese Option erfordert außerdem eine identische 
Integrationszeit für beide Kanäle. Folgende Daten müssen verfügbar sein: 

o Dunkelspektrum FOS-Probe- oder Referenzkanal, 
o Referenzspektrum des FOS-Probekanals, 
o Referenzspektrum des FOS-Referenzkanals 

Der Unterschied dieser beiden Korrekturmethoden ist, dass in der ersten Methode kein 
Verhältnis zwischen den gemessenen Daten an beiden Kanälen existiert. GetSoft benutzt 
lediglich die Unterschiede, die in bestimmten Zeitabständen im FOS-Referenzkanal 
gemessen wurden, um damit die Daten des FOS-Probekanals zu korrigieren. Bei der zweiten 
Korrekturmethode wird zunächst der Korrekturfaktor für beide FOS-Kanäle bestimmt. Dann 
erst wird die mit dem FOS-Referenzkanal gemessene (weiße) Referenz neu berechnet und 
als neue Referenz für den FOS-Probekanal gespeichert. 

Da für beide Methoden ein Dunkelspektrum zur Verfügung stehen muss, speichern Sie 
Dunkeldaten bevor Sie die Menüoption „Setup -> Options -> Correct for Drift -> by FOS-2-
INLINE-UV/VIS” aktivieren. Nachdem die Menüoption ausgewählt wurde, öffnet sich dieses 
Fenster: 
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Wenn das Schnittstellenkabel zwischen getSpec-2048 und FOS-2 sowie dem Netzteil richtig 
angeschlossen ist, schließt der FOS-2 den oberen (Probe-) Kanal und öffnet den unteren 
(Referenz-) Kanal. Solange das Fenster für die FOS-2 Einstellungen nicht geschlossen ist, 
bleibt FOS-2 in dieser Position.  

Wenn Sie die zweite Methode für die Driftkorrektur verwenden wollen (durch Speichern einer 
neuen Referenz, siehe vorherige Seite), klicken Sie auf die Checkbox „FOS Reference = 
Sample Reference” unten im Fenster. Wenn Sie die erste Korrekturmethode verwenden, 
kann die Integrationszeit für den FOS-Referenzkanal auf einen anderen Wert als für den 
FOS-Probekanal gesetzt werden. Bedenken Sie, dass Sie neue Dunkeldaten und eine neue 
Referenz für den FOS-Referenzkanal speichern müssen, nachdem Sie die Integrationszeit 
geändert haben. Bestimmen Sie eine geeignete Integrationszeit und speichern Sie eine FOS-
Referenz durch Betätigen des weißen Buttons. Schalten Sie danach die Lichtquelle aus und 
speichern Sie ein Dunkelspektrum durch Betätigung des schwarzen Buttons. 

Der FOS-Korrekturmodus kann im Fenster für die FOS-Einstellungen auf „Software” oder 
„Auto” eingestellt werden. Die Einstellung „Auto“ bestimmt, wann getSoft die Kanäle während 
der Messungen wechseln soll. Wenn der Korrekturmodus auf „Software” eingestellt ist, kann 
der Nutzer bestimmen, wann die Kanäle gewechselt werden sollen. 

Nachdem der „OK“-Button betätigt wurde, öffnet sich ein Fenster (Abb. unten). Solange der 
Referenzkanal der aktive FOS-Kanal ist, geschieht die Datenverarbeitung nicht im 
Hauptfenster. Eine kleine Grafik (siehe Abb. unten) zeigt die A/D-Einheiten an, die im FOS-
Referenzkanal gemessen wurden. Wenn der Button „Sample channel” betätigt wird, wechselt 
FOS-2 die Kanäle und die (korrigierten) Daten werden wie gewohnt verarbeitet.  

Ein kleines Fenster bleibt sichtbar, in dem der FOS-Kanal zurück auf den FOS-
Referenzkanal gewechselt und ein neues Referenzspektrum gemessen werden kann. 

 
 

Wenn „Auto” ausgewählt ist, geschieht der 
Wechsel nach einer voreingestellten Anzahl 
von Sekunden. Weiterhin können Sie ein 
Update des FOS-Referenzspektrums aller 
x Sekunden auswählen oder lediglich eine 
Probemessung aller x Sekunden aufnehmen. 
In der Abbildung rechts wird der Probekanal während des Großteils der 60 Sekunden 
gemessen. Aller 60 Sekunden wechselt FOS zum FOS-Referenzkanal, um ein neues FOS-
Referenzspektrum aufzunehmen, welches für die Korrektur verwendet wird.  



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 44 

 

 

…more than spectroscopy! 

Nachdem Sie im Fenster für die FOS-Einstellungen den „OK“-Button betätigt haben, wird 
FOS eines der beiden unteren Fenster öffnen. Solange der Probekanal aktiv ist (linke Abb.), 
werden die Messergebnisse wie gewohnt verarbeitet. Solange der Referenzkanal aktiv ist 
(rechte Abb.), werden die Messergebnisse verwendet, um das Referenzspektrum zu 
aktualisieren. Die A/D-Einheiten dieses Spektrums werden im Fenster angezeigt.  

 

 
 

Driftkorrektur mit dem Spektrometerkanal (nur USB1-Plattform) 

Diese Option ist verfügbar, wenn das Spektrometersystem einen oder mehrere Slave-Kanäle 
besitzt. Ein Spektrometerkanal wird als Referenzkanal verwendet, welcher unaufhörlich das 
Referenzspektrum misst (z.B. die weiße Fliese in Reflexionsmes-
sungen oder die Küvette mit einer Vergleichslösung in Transmis-
sionsmessungen). Veränderungen in diesem Referenzsignal, z.B. 
aufgrund einer Drift in der Lichtquelle, werden für die Korrektur der 
Daten der anderen (ausgewählten) Spektrometerkanäle verwendet. 
Der Wellenlängenbereich, über welchen die Daten korrigiert werden 
können, wird der überlappende Wellenlängenbereich zwischen dem 
Referenzspektrometerkanal und dem zu korrigierenden Spektro-
meterkanal sein. 

Wenn diese Option aktiviert ist, wird ein Fenster geöffnet, in dem der 
Referenzkanal und ein bzw. mehrere Kanäle (abhängig von der 
Anzahl der verfügbaren Spektrometerkanäle) für die Korrektur 
ausgewählt werden können. Nachdem die richtige Einstellung gewählt 
und der „OK“-Button betätigt wurde, zeigt getSoft folgende Information 
(Abb. rechts) an: 

Schalten Sie ihre Lichtquelle ein, wählen Sie die richtige Integrationszeit und speichern Sie die 
Referenz. Schalten Sie dann die Lichtquelle aus und speichern Sie die Dunkeldaten. 
Nachdem der „OK“-Button betätigt wurde, aktiviert getSoft die Spektrometerkanäle, die für die 
Driftkorrekturapplikation relevant sind. Nachdem die Referenz- und Dunkeldaten gespeichert 
wurden, zeigt ein Fenster an, dass die Daten driftkorrigiert werden. Die Menüoption ist durch 
ein Häkchen markiert. Um die Option „Correct for drift” zu deaktivieren, muss die Menüoption 
(wenn durch ein Häkchen markiert) ein weiteres Mal ausgewählt werden. 

3.2.9.6 Setup Menu: Options – Automatic Save Dark by TTL shutter 

Um die Option „Automatic Save Dark” zu verwenden, muss zunächst ein Schnittstellenkabel 
vom Spektrometer zur Lichtquelle mit dem Shutter (getLight-HAL-S, getLight-DHc, getLight-
D(H)-S-(DUV) ) angeschlossen werden. Das Schnittstellenkabel zwischen dem TTL-Shutter 
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und dem Spektrometer ist für die USB1-Plattform ein 15 zu 15 Pin-Kabel (IC-DB15-2) und für 
die USB2-Plattform ein 26 zu 15 Pin-Kabel (IC-DB26-2).  

Der TTL-Schalter an der Lichtquelle muss sich in TTL-Position befinden. In getSoft muss im 
Menü „Setup -> Options“ die Option „Automatic Save Dark by TTL Shutter” aktiviert sein. 
Wenn die Option aktiviert ist, schließt der TTL den Shutter der Lichtquelle in dem Moment, in 
dem die Dunkeldaten gespeichert werden. Nachdem die Dunkeldaten gespeichert wurden, 
wird der Shutter automatisch wieder geöffnet. 

3.2.9.7 Setup Menu: Options – External Trigger Setting 

USB1-Plattform 

Der DB15-Anschluss am getSpec-2048-Spektrometer verwendet zwei Pins für die digitale IN-
Kommunikation: Pin 4 und 8. 

Pin 4 wird für den Hardware-Triggermodus verwendet und Pin 8 ist ein regulär digitaler, in 
welchem der Status abgefragt werden kann. 

In getSoft wurden zwei 
Funktionen für die 
Nutzung des „Digital In“ 
bei Pin 8 angelegt. Viele 
andere zusätzliche 
Features können einfach 
und benutzerspezifisch 
implementiert werden. Für 
die manuelle Erzeugung 
eines + 5 V-Signals in Pin 
8, sollte eventuell das 
tragbare Drucktasterkabel 
IC-Extrig-2 bestellt werden oder wenn die Option „Setup -> Options -> Automatic Save Dark 
by TTL Shutter” auch unterstützt werden muss, kann ein „IC-DB15-Extrig-2”-Y-Kabel bestellt 
werden. Die verschiedenen Optionen, die im Fenster (Abb. oben) angezeigt sind, werden im 
Folgenden beschrieben. 

Kontinuierlicher Scanbetrieb mit Speicherung des ersten verfügbaren Spektrums 
(wenn TTL-Signal Pin 8 = high) 

In diesem Modus fragt getSoft den Status von Pin 8 nach jedem eingehenden Scan ab. Ist der 
Status von Pin 8 HIGH (+ 5 V), wird das Spektrum (oder die Spektren, wenn mehrere 
Spektrometerkanäle aktiv sind) wie in Abschnitt „3.1.7 File Menu: Save Experiment“ 
beschrieben, automatisch gespeichert. Ein Fenster wird hierbei nicht geöffnet, sondern die 
Spektrometer-Kanalnummer und ein Zeitstempel werden der Kommentardatei zugefügt.  

Beachten Sie, dass das Spektrum nur dann gespeichert wird, wenn das Signal im Moment 
der Abfrage (getSoft erhält ein neues Spektrum vom Datenerfassungstreiber) hoch ist. Wenn 
ein kurzer TTL-Impuls an Pin 8 erzeugt wird, wird das Spektrum wahrscheinlich nicht 
gespeichert. Um ein Spektrum zu speichern, sollte die Dauer des TTL-Signals so lang wie 
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das Produkt aus Integrationszeit und Anzahl der zu mittelnden Scans sein. Für zeitkritische 
Situationen wird der Modus „Externer Hardwaretrigger“ empfohlen. 

Kontinuierlicher Scanbetrieb mit Speicherung des ersten verfügbaren Spektrums als 
Referenz (wenn TTL-Signal Pin 8 = high) 

Für Absorptions- oder Reflexions-/Transmissionsmessungen wird empfohlen, die Referenz-
daten regelmäßig zu aktualisieren, um Effekte wie eine Drift in der Lichtquelle oder Tempe-
raturveränderungen im Detektor oder der optischen Bank zu vermeiden. In den meisten Fäl-
len wird die Referenz manuell durch Betätigen des weißen Buttons gespeichert. Diese Refe-
renzdaten werden automatisch gespeichert, wenn diese externe Triggeroption ausgewählt 
und der Status von Pin 8 dann HIGH (+ 5 V) ist, wenn ein neues Spektrum zur Verfügung 
steht. Informationen über die erforderliche Dauer und Zeitsteuerung des TTL-Signals finden 
Sie in der Beschreibung zum Speichern von Spektren bei hohem TTL-Signal (siehe oben). 

Externer Hardwaretrigger, Einzelscan an ansteigender TTL-Impulsflanke (Pin 4) 

Durch die Auswahl der Option „Setup -> Options -> External Trigger Setting” wird der Daten-
erfassungsmodus des Spektrometers geändert. Es findet keine Datenerfassung statt, bis 
nicht ein TTL-Impuls an Pin 4 des DB15-Anschlusses empfangen wird. Die Verzögerung 
zwischen ansteigender TTL-Impulsflanke und dem Beginn des Integrationszeitzyklus ist vom 
Spektrometertyp abhängig (siehe Tabelle unten). 

Spektrometertyp Minimale Verzögerung 
[? s] 

Maximale Verzögerung 
[? s] 

getSpec-102 1000 1500 

getSpec-2048 (S/N = 0405054S1) 2000 2500 

getSpec-2048 (S/N > 0405054S1) 1,26 1,30 

getSpec-2048FT 1,26 1,30 
 

Zum Beispiel beginnt die Integrationszeit (wie in getSoft festgelegt) für ein Standard-getSpec-
102 bei 1,0 bis 1,5 ms nach dem Empfang des TTL-Impulses an Pin 4 des DB15-
Anschlusses. Wenn die Integrationszeit abgelaufen ist, werden die Daten von getSoft verar-
beitet und das Spektrometer wartet auf den nächsten Impuls. Der externe Hardwaretrigger ist 
für die Betrachtung von kurzen Impulsvorgängen (z.B. Laserimpulse). Um einen Laserimpuls 
zu messen, enthält das getSpec-2048FT eine Option, mit der man einen Impuls an Pin DO2 
aussenden kann, um den Laser unmittelbar vor dem Beginn des Integrationszeitzyklus 
(Verzögerung = - 42 ns) abzufeuern. Durch die Einstellung der Verzögerung zwischen dem 
TTL-Out an DO2 und dem Beginn der Integrationszeit zu einem positiven Wert, kann das 
getSpec-2048FT in LIBS-Applikationen (Laser-Induced Breakdown Spectroscopy = Laser-
induzierte Störfallspektroskopie) verwendet werden. Hier soll der Laserimpuls selbst nicht 
gemessen werden, aber die Plasma-Emission z.B. 1 ?s nach dem Abfeuern des Lasers. 
Detaillierte Informationen zu den Delay-Einstellungen für das getSpec-2048FT im Modus 
„Externer Hardwaretrigger“ werden im Folgenden beschrieben. 
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Wenn die weiße Box „Automatic save on trigger” markiert ist, wird jedes Spektrum, das im 
Modus „Externer Hardwaretrigger“ automatisch gespeichert. 

Vergewissern Sie sich vor der Auswahl des externer Hardwaretriggers und der Bestätigung 
mit dem „OK“-Button, dass ein +5V-TTL-Impuls an Pin 4 eingestellt werden kann. Um den 
Modus „Externer Hardwaretrigger“ zu verlassen, muss die Menüoption „External Trigger 
Setting” ausgewählt und der Radiobutton „None” gefolgt vom „OK“-Button betätigt werden. 
Dennoch wird die Spektrometer-Firmware nicht in den normalen Erfassungsmodus zurück-
wechseln, wenn sie nicht vorher den TTL-Impuls an Pin 4 empfangen hat. 

getSpec-2048FT und externer Hardwaretrigger 

Das getSpec-2048FT wurde für LIBS-Applikationen entwickelt. Natürlich kann es auch in 
Applikationen zum Einsatz kommen, die eine schnelle Ansprechzeit auf ein externes Trigger-
signal erfordern, wie beispielsweise Produktmessung an einer Förderanlage.  

Wenn der Scanbetrieb des getSpec-2048FT durch ein externes Hardwaretriggersignal an Pin 
4 des DB15-Anschlusses gesteuert wird, wird es nach dem Empfang des Signals folgende 
Schritte ausführen: 

1. Als erste Reaktion wird an Pin 2 des DB15-Anschlusses ein TTL-Outputsignal ange-
bracht. Dieser TTL-Output kann zum Abfeuern des Lasers in der LIBS-Applikation 
verwendet werden. 

2. Der Integrationszeitzyklus startet ein benutzerspezifisches Delay nachdem der TTL-
Output für den Laser eingerichtet wurde. Die Mindestdauer für dieses Delay beträgt - 42 
ns. In diesem Fall würde der Laserimpuls selbst gemessen werden, da die Integrations-
zeit 42 ns vor dem TTL-Out an DO2 beginnt. Die Einstellung für die Delaydauer kann in 
Schritten von 42 ns verändert werden. Das maximale Delay beträgt 2730583 ns. Eine der 
am meisten benutzten Delayeinstellungen in LIBS-Applikationen ist 1000 ns. Da die 
Delaydauer nicht durch Flackern beeinflusst wird, ist das getSpec-2048FT nicht nur für 
fundamentale, sondern auch für präzise quantitative analytische Applikationen geeignet. 

 

Programmierbares Delay: -42 ns bis +2730583 ns in 42 ns-Schritten, Flackern = 0 ns 
Dieser Teil der Plasma-Emission ist nicht in der Integrationszeit enthalten. 
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Das in der Software einstellbare Delay zwischen Output an DO2 (zum Abfeuern des 
Lasers) und dem Beginn der Integrationszeit wird verwendet, um die Messung der ersten 
Zeitspanne direkt nach dem Laserimpuls zu vermeiden, bei welcher eine hohe Intensität 
der Plasma-Emission zu verzeichnen ist, aber keinerlei hilfreiche Informationen gewon-
nen werden. Die Abbildung unten zeigt ein Beispiel für die Intensität der Plasma-Emission 
nach dem Laserimpuls. Die Integrationszeit für das getSpec-2048FT kann von 2 ms auf 
60000 ms eingestellt werden. In LIBS-Applikationen wird eine minimale Integrationszeit 
von 2 ms verwendet. 

Um das Delay in getSoft 
einzustellen, wählen Sie die Option 
„Externer Hardwaretrigger“ im 
Fenster „External Trigger Setting“. 
Geben Sie das Delay zwischen 
dem Output an Pin 2 und dem 
Beginn des Integrationszeitzyklus in 
ns ein. Wenn Sie ein automatisches 
Speichern der Spektren wünschen, 
aktivieren Sie die Option 
„Automatically save on Hardware 
Trigger”. Klicken Sie OK.  

Wenn Sie im externen Hardwaremodus messen, wird die Datenerfassung vom externen 
Triggerimpuls-Input gesteuert. Deswegen wird der „Start/Stop“-Button deaktiviert. Die 
Editleiste zeigt die momentane Einstellung für das Delay (1000 ns im Beispiel unten) an.  

Solange das Spektrometer in diesem Modus arbeitet, können Sie von getSoft aus keine 
Befehle an das Spektrometer senden. Wenn Sie das Delay verändern möchten, müssen Sie 
zunächst den externen Triggermodus deaktivieren. Dies kann im Fenster für den externen 
Triggermodus durch Betätigen des „None“-Buttons bewerkstelligt werden. Alternativ kann in 
der Editleiste des Hauptfensters die Trigger-Checkbox angeklickt werden. Beachten Sie, dass 
ein weiterer Triggerimpuls benötigt wird, bevor der externe Triggermodus deaktiviert wird, da 
das Spektrometer nur auf einen externen Trigger an Pin 4 reagieren kann, bevor es auf den 
Befehl „Disable external trigger mode” ansprechen kann. 

Nachdem der Externe Triggermodus deaktiviert und ein weiterer Triggerimpuls erstellt wurde, 
erscheint eine Edit-Box, welche die momentane Delayeinstellung anzeigt (Abb. unten). In 
dieser Edit-Box kann die Delayeinstellung geändert werden (- 42 bis 2730583 ns).Nachdem 
Sie das Delay geändert haben, können Sie den externen Hardwaretrigger in der Trigger-
Checkbox aktivieren. 

Trigger-Checkbox 
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Beachten Sie, dass die Auflösung des Delays (ns) in 41,67 ns-Schritten erfolgt und ein 
Versatz/Ausgleich von –41,67 ns existiert. Wenn Sie also ein Delay von 800 ns eingeben, 
berechnet die Software den nächsten Schritt (= - 41.67 + 20 * 41,67 = 792 ns).  

Für diejenigen Spektren, die im Modus „Externer Hardwaretrigger“ gespeichert werden, wird 
automatisch eine Kommentardatei erstellt, in welcher das Datum, die Zeit und das Delay 
festgehalten werden. Somit wird der Vergleich von Spektren, die mit unterschiedlicher 
Delayeinstellung aufgenommen wurden, wesentlich erleichtert und ein optimales Delay kann 
schneller gefunden werden („File -> Display Saved Graph“). Das optimale Delay hängt vom 
Material und dem Laser in der LIBS-Applikation ab. 

External Trigger setting USB2 platform 

 

Wenn der externe Trigger aktiviert ist, wartet das Spektrometer bis ein TTL-Signal bei Pin 6 
vom DB26-Anschluss hoch kommt und wird dann die Integrationszeit starten. Die 
Verzögerung zwischen der ansteigenden Flanke des TTL-Impuls und dem Start des 
Integrationszeitzyklus hängt vom Spektrometertyp ab (siehe Tab. unten). 

Spektrometertyp Minimale Verzögerung [? s] Maximale Verzögerung [? s] 

getSpec–102-USB2 9 60 

getSpec–256-USB2 0,80 0,84 

getSpec–1024-USB2 0,80 0,84 

getSpec–2048-USB2 1,28 1,30 

getSpec–3648-USB2 1,28 1,30 

getSpec–NIR-256 0 600 

 

NrOfScans 

Wenn eine Anzahl von Scans mit einem Wert größer als 1 eingestellt werden, wird das 
Spektrometer bei jeder ansteigenden Flanke des externen TTL-Triggers mehrere Scans 
zusammenfassen. Diese Einstellung wird aufgehoben, wenn „Level Triggered“ aktiviert ist. 
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Save Spectrum 

Wenn diese Box markiert ist, werden die vom Spektrometer zusammengefaßten Scans auf 
der Festplatte gespeichert. Ist „NrOfScans > 1”, wird die Datenspeicherung so schnell wie 
möglich ohne Bildschirm-Updates erledigt. 

Edge Triggered 

Bei diesem Modus starten ein oder mehrere Scans an der ansteigenden Flanke des TTL-
Impulses beim Pin 6 des DB26-Anschlusses. Die Verzögerung zwischen der ansteigenden 
Flanke und dem aktuellen Start der Integrationszeit ist in der Tabelle oben aufgeschrieben. 

Level Triggered 

Bei diesem Modus beginnt das Spektrometer Daten an der ansteigenden Flanke des TTL-
Impulses zusammenzufassen (es werden Scans in der ausgewählten Integrationszeit 
genommen). Das dauert solange an bis das TTL-Signal hoch bleibt. Wenn das Signal abfällt, 
wird der Mittelwert der zusammengefaßten Daten (außer dem letzten Scan) angezeigt oder 
gesichert. Dieser Modus ist besonders geeignet bei Anwendungen am Förderband, wenn ein 
Produkt unabhängig von der Transportgeschwindigkeit gescannt werden muß. 

3.2.9.8 Setup Menu: Options – Autoconfigure Integrationtime 

Nachdem diese Menüoption ausgewählt wurde, beginnt getSoft mit der Suche nach einer 
optimalen Integrationszeit. Abhängig von der Maximaleinheit des letzten Scans wird die 
Integrationszeit erhöht/herabgesetzt, bis ein optimales Signal gemessen wird. 

Die Veränderung der gegenwärtigen Integrationszeit während des Suchvorgangs kann im 
Feld für die Integrationszeit in der Editleiste verfolgt werden. Wenn der Vorgang „Auto-
configure Integrationtime” abgebrochen werden soll, bevor eine optimale Integrationszeit 
gefunden wurde, klicken Sie den „?AC“-Button (befindet sich während des Suchvorgangs in 
gedrückter Position) oder wählen Sie die Menüoption „Setup -> Options -> Autoconfigure 
Integrationtime“ ein weiteres Mal aus. 

Wenn die maximale Spitze bei ca. 14000 Einheiten ist, wird ein Fenster geöffnet, welches die 
neue Integrationszeit anzeigt. Da die Integrationszeit geändert wurde, müssen neue 
Referenz- und Dunkelspektren gespeichert werden. Vorher ist ein Wechsel in den 
Transmissions- oder Absorptionsmodus nicht möglich. Daher ist diese Option nur im Scope-
Modus verfügbar.  

3.2.9.9 Setup Menu: Options – Use Custom Reflectance Reference 

Im Transmissions-/Reflexionsmodus wird die Transmission/Reflexion bei Pixeln unter 
Verwendung der aktuellen Probe-, Referenz- und Dunkeldaten mit der unten stehenden 
Gleichung berechnet: 

??
?

?
??
?

?
?

?
?

nn

nn
nn darkref

darksample
CT *  

Cn entspricht dem anwenderspezifischen Reflexions-Referenzfaktor bei Pixel n. In älteren 
Versionen von getSoft war dieser Faktor für jeden Pixel auf 100 eingestellt und konnte nicht 
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geändert werden. In getSoft 
Version 7 ist der Reflexions-
Referenzfaktor auf 100 
voreingestellt, kann aber bei 
Bedarf geändert werden. 
Wenn das Reflexions-
spektrum einer „weißen“ 
Kalibrierkachel bekannt ist, 
können die Daten aus einer 
Datei gelesen oder in eine 
Tabelle in getSoft eingegeben 
werden. Die resultierenden 
anwenderspezifischen 
Referenzdaten können unter 
einem beliebigen Namen 
gespeichert und später neu 
geladen werden.Klicken Sie 
auf den Radiobutton „Enable Custom Standard” und anschließend auf „OK” im Fenster 
„Custom Reflectance Settings“, um die anwenderspezifischen Referenzdaten in getSoft zu 
verwenden.  

Der Status dieser Option wird in der Symbolleiste durch das Hinzufügen einer grünen 
Umrahmung um den weißen Button angezeigt. Wenn die Umrahmung nicht vorhanden ist, 
werden 100 % Reflexion für die Referenzkachel angenommen. Wenn die Umrahmung 
angezeigt wird (wie in der Abb. oben), werden für alle Berechnungen anwenderspezifische 
Reflexionswerte verwendet. 

3.2.9.10 Setup Menu: Options – Suppress Save Comments Dialog 

Wenn diese Option durch ein Häkchen markiert ist, wird das Kommentarfenster bei der 
Speicherung von Experimenten (wie in Abschnitt „3.1.7 File Menu: Save Experiment“ 
beschrieben) unterbunden. In der Voreinstellung ist diese Option deaktiviert. Durch Auswahl 
der Menüoption wird sie aktiv (durch Häkchen markiert). 

3.2.9.11 Setup Menu: Options – View Reflectance instead of Transmittance 

Obwohl sie mathematisch äquivalent sind, unterscheiden sich die Experimenteinstellungen 
im Transmissions- und Reflexions-Modus. Deswegen kann eine Auswahl des Namens 
„Reflexion” anstelle von „Transmission” durchgeführt werden. In der vorgegebenen 
Einstellung ist der Option kein Häkchen vorangestellt. Dies bedeutet, dass das Programm mit 
dem Transmissions-Modus operiert. Durch die Auswahl der Menüoption erscheint ein 
Häkchen und das Programm wird mit dem Titel „Reflexion” anstelle von „Transmission“ 
operieren. Diese Änderung hat zwei Auswirkungen:  

o Im Reflexions-/Transmissions-Modus wird der Name „Reflexion” an der X-Achse 
angezeigt. 

o Die Beschriftung des Buttons „Reflexion/Transmission” wird von T zu R geändert und 
die entsprechende Menüoption unter „View” ändert sich von „Transmittance Mode” zu 
„Reflectance Mode”. 
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3.3 View Menu  

 
 

3.3.1 View Menu: Scope Mode 

Die Anzeige ist auf den Scope-Modus eingestellt und zeigt ein Echtzeitrohdatensignal mit der 
Auslese des AD-Konverters auf der Y- und der berechneten Wellenlänge auf der X-Achse. 

3.3.2 View Menu: Absorbance Mode 

Im Absorptionsmodus wird die Absorption bei Pixel n unter Verwendung der aktuellen Proben-
, Referenz- und Dunkeldateneinstellungen mit folgender Gleichung berechnet : 

??
?

?
??
?

?
?

?
??

nn

nn
n darkref

darksample
A log  

3.3.3 View Menu: Transmittance/Reflectance Mode 

Im Transmissionsmodus wird die Transmission bei Pixel n unter Verwendung der aktuellen 
Proben-, Referenz- und Dunkeldateneinstellungen mit folgender Gleichung berechnet : 

??
?

?
??
?

?
?

?
?

nn

nn
n darkref

darksample
T *100  

Wie im Abschnitt „3.2.9.9 Setup Menu: Options – Use Custom Reflectance Reference“ 
beschrieben, kann der (weiße) Referenzprozentsatz von 100 angepasst werden. Der 
Prozentsatz der Transmission ist mathematisch identisch mit dem der Reflexion und kann 
auch für Reflexionsexperimente verwendet werden (siehe auch Abschnitt „3.2.9.11 Setup 
Menu: Options – View Reflectance instead of Transmittance“). 

3.3.4 View Menu: Irradiance Mode 

Wenn die Softwareerweiterung „Absolute Irradiance Measurements” gemeinsam mit getSoft 
bestellt wurde, zeigt diese Option die absolute Strahlungsenergie in µWatt/cm2/nm an. Eine 
ausführliche Beschreibung des Experiment-Setups für den Fall von absoluter 
Bestrahlungsstärke finden Sie im Abschnitt „Perform Intensity Calibration“. 
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Wenn die Anwendung „Absolute Irradiance” nicht verfügbar ist, wird eine Lichtquelle mit 
bekannter Farbtemperatur als Referenz benötigt. Dies kann zum Beispiel die getLight-HAL 
mit Farbtemperaturen von 2850 K bei vorgegebener Jumper-Einstellung sein. Die relative 
Strahlungsenergie bei Wellenlänge ?  wird dann unter Verwendung der aktuellen Probe-, 
Referenz und Dunkeldateneinstellungen berechnet: 

? ????? darksampleBS ?? *  

B? ist der berechnete Bestandteil der spektralen Verteilung der Schwarzkörperausstrahlung 
(bei anwenderausgewählter Temperatur in Kelvin) geteilt durch die momentanen 
Referenzdaten bei Wellenlänge ? . 

Messungen der relativen Bestrahlungsstärke mit getSoft aufnehmen 

1. Starten Sie die getSoft-Software und klicken Sie den Button „Start” im Hauptfenster. 

2. Schließen Sie eine Faser an den Eingangsanschluss des Spektrometers an. 

3. Stellen Sie die Glättungsparameter im Setup-Menü ein, um die Glättung für den 
verwendeten Faser-/Spaltdurchmesser zu optimieren. 

4 Bereiten Sie das Experiment so vor, dass das andere Ende der Faser auf die zu 
bestimmende Lichtprobe zeigt (nutzen Sie eine Spannvorrichtung für optimale 
Ergebnisse). Möglicherweise erscheint eine Art Spektrum auf dem Bildschirm, da 
eventuell zu wenig oder zu viel Licht das Spektrometer unter den momentanen 
Datenerfassungseinstellungen erreicht.  

Zu viel Licht bedeutet, dass über einer bestimmten Wellenlänge das Signal gesättigt ist. 
Dies wird durch eine gerade Linie – möglicherweise sogar nahe 0 – angezeigt. Durch 
ein Verringern der Integrationszeit kann das normalerweise verhindert werden. Die 
Integrationszeit kann im Hauptfenster im weißen Feld unter dem „Start/Stop“-Button 
geändert werden.  

 Wenn getSoft Daten erfasst, zeigt der „Start/Stop“-Button ein rotes „Stop“ und das Feld 
für die Integrationszeit ist grau, um anzuzeigen, dass sie im Augenblick nicht geändert 
werden kann.  

 Wird der „Stop“-Button betätigt, wird die Datenerfassung beendet. Die Integrationszeit 
kann nun geändert werden. Das Ergebnis der geänderten Integrationszeit kann nach 
Betätigung des grünen „Start“-Buttons betrachtet werden.  

 Versuchen Sie, die Integrationszeit so einzustellen, dass die Maximaleinheit über dem 
Wellenlängenbereich bei ungefähr 14000 liegt. Sollte bei einer minimalen Integration das 
Signal noch immer zu hoch sein, müssen eventuell Fasern mit geringerem Durch-
messer benutzt werden. Sollte nicht genügend Licht das Spektrometer erreichen, sollte 
eine längere Integrationszeit eingegeben werden. 

5. Wenn ein gutes und verwertbares Spektrum angezeigt wird, schalten Sie die 
Lichtquelle aus. 

6. Speichern Sie nun die Dunkeldaten. Dies kann vom Menü aus mit „File -> Save -> 
Dark” oder durch Klicken mit der Maus auf das schwarze Quadrat in der linken oberen 
Bildschirmecke geschehen.  



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 54 

 

 

…more than spectroscopy! 

7. Schalten Sie die Lichtquelle mit bekannter Farbtemperatur (2850 K für getLight-HAL mit 
vorgegebener Jumper-Einstellung) ein und richten Sie das Faserende, welches nicht an 
das Spektrometer angeschlossen ist, so aus, dass auf dem Bildschirm ein gutes 
Spektrum angezeigt wird. Beachten Sie, dass die Integrationszeit und der Fasertyp 
während der Messung der Referenzdaten nicht verändert werden sollten.  

 Wenn zu viel Licht anliegt, stellen Sie die Fokussierung der Lichtquelle so ein, dass 
weniger Licht in die Faser gekoppelt wird. Solange lediglich Licht der Referenzlicht-
quelle und kein Umgebungslicht in die Faser gelangt, wird dies die spektrale Verteilung 
nicht beeinflussen, sondern nur ihre Höhe. Versuchen Sie die Faser so einzustellen, 
dass die maximale Einheit ungefähr 14000 über dem Wellenlängenbereich liegt. 

8. Speichern Sie die Referenzdaten. Dies wird durch „File -> Save -> Reference“ oder 
durch Anklicken des weißen Quadrats in der linken oberen Ecke des Bildschirms mit 
der Maus erreicht. 

9. Beachten Sie, dass das gesamte Verfahren des Speicherns von Referenzdateien nicht 
jedes Mal vor dem Start eines neuen Experiments ausgeführt werden muss. Die 
Referenzdaten werden in einer Datei mit der Erweiterung ref*.dat gespeichert und 
können beim nächsten Mal mit der Option „File -> Load -> Reference” geladen werden.  

Nach dem Speichern der Referenz- und Dunkeldaten kann der Bestrahlungsstärke-
Modus durch Betätigen des Buttons „I“ oder durch die Menüoption „View -> Irradiance 
Mode” ausgewählt werden. Zunächst öffnet sich ein Fenster, in dem der Wert für die 
Farbtemperatur der Lichtquelle (in Kelvin), die als Referenz benutzt wurde, eingegeben 
werden kann. Wenn Licht von der Referenzlichtquelle betrachtet wird, wird die Planck-
Kurve für die Farb-Temperatur der Referenzlichtquelle angezeigt. Das Maximum der 
Referenz-Planckkurve wurde auf 100 eingestellt. 

3.3.5 View Menu: Channel (nur USB1-Plattform) 

Nachdem diese Option ausgewählt wurde, wird ein Fenster geöffnet, in dem 
die darzustellenden Kanäle ausgewählt werden können. Abhängig von der 
Anzahl der verfügbaren Kanäle im verwendeten Spektrometersystem können 
bis zu 8 Spektrometerkanäle ausgewählt werden. Wenn Graphen dargestellt 
werden, die zuvor gespeichert wurden („File -> Display Saved Graph“) bleiben 
die aktiven Kanäle auch sichtbar. Dies ermöglicht Online-Messungen in 
Abhängigkeit von einem bereits gespeicherten Graphenhintergrund. Um nur die 

gespeicherten Graphen zu betrachten, müssen alle aktiven Kanäle abgewählt werden. 
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3.3.6 View Menu: Change Graph Scale 

Nachdem diese Option ausgewählt wurde, öffnet 
sich ein Fenster, in welchem die Bereiche für X- und 
Y-Achse eingegeben werden können. Um in den 
Originalmaßstab zu wechseln, können die Option 
„View -> Graphic Reset“ oder die Zoom-Out-Funktion 
der Maus genutzt werden. Wenn in diesem Fenster 
der Button „Save“ betätigt wird, werden die 
Einstellungen für X- und Y-Achse in einer Datei 
gespeichert und können in der Zukunft mir der Option 
„View -> Goto Preset Scale“ oder durch Betätigen 
des entsprechenden Buttons in der Symbolleiste geladen werden. 

3.3.7 View Menu: Graphic Reset 

Wenn diese Option ausgewählt wird, wird der Graph auf die vorgegebenen Einstellungen für 
X- und Y-Achse zurückgesetzt. 

3.3.8 View Menu: Autoscale y-axis 

Wenn diese Option verwendet wird, wird der Graph online neu skaliert. Ein maximales Signal 
wird bei ungefähr 75 % der vertikalen Skala angezeigt.  

3.3.9 View Menu: Goto Preset Scale 

Wenn diese Option ausgewählt wird, werden die Skalen der X- und Y-Achse auf den vorher 
eingestellten Maßstab zurückgesetzt. Dies kann auch durch Betätigen des entsprechenden 
Buttons „Goto Preset Scale“ in der Symbolleiste bewerkstelligt werden. 

3.3.10 View Menu: Grid Enable 

Wenn die Option „View -> Grid Enable” aktiviert wurde, wird ein Raster im Graphen angezeigt 
(siehe nächste Abb.).  
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3.3.11 View Menu: Progress Bar Enable 

Wenn lange Integrationszeiten oder eine hohe Anzahl von Mittelungen eingegeben werden, 
kann es einige Sekunden dauern, bis ein neuer Scan von der Anwendung erfasst wird. Um zu 
erfahren, wie lange es dauert, bis der nächste Scan erfasst wird, kann ein Fortschrittsbalken 
angezeigt werden. Nachdem der Fortschrittsbalken durch die Auswahl der Option aktiviert 
wurde, wird der Balken nach der Erfassung des nächsten Scans angezeigt.  

Der Fortschrittsbalken wird nur dann angezeigt, wenn die Zeit zwischen zwei Scans mehr als 
eine Sekunde beträgt. Die Zeit zwischen den Scans entspricht ungefähr der Integrationszeit 
multipliziert mit der Anzahl der Mittelungen. Dennoch kann bei einer hohen Anzahl von 
Mittelungen die Zeit zwischen den Scans aufgrund der zusätzlichen Zeit, die durch die 
Übertragung der vielen Mittelungsspektren auf den PC benötigt wird, zunehmen. 
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4 Anwendungen 

 
 

4.1 Application: History Channel Functions  

4.1.1 History Application: Function Entry 

Mit der History-
Anwendung kann der 
Output von selbst-
definierten Funktionen 
oder Integralen in einem 
Graph in Abhängigkeit 
von der Zeit verfolgt 
werden. Bis zu 8 
Funktionen können 
gleichzeitig betrachtet 
werden.  

Die Funktionen werden 
im Fenster (Abb. rechts) 
definiert, welches nach 
der Auswahl der Option 
„Application -> History -> 
Function Entry“ 
ausgewählt wird. 

Die Funktionen F1 bis F8 
können durch Klicken auf 
das entsprechende 
Register oben im Fenster ausgewählt werden.  

Weiterhin können einige allgemeine (funktionstunabhängige) Parameter unterhalb der 
einzelnen Register (F1 bis F8) eingegeben werden.   

Function Type 

Wenn das Fenster zum ersten Mal geöffnet wurde, ist noch keine der 8 Funktionen aktiviert 
(„Function Type = None“). Um eine Funktion zu definieren muss der Radiobutton „Function 
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Type” von „None” auf „Integral”, „User Defined”, „View Spectrum” oder „Peak” eingestellt 
werden. Nachdem die Funktion definiert wurde, können Messmodus, Funktionsdefinition und 
Funktionsanzeige eingestellt werden. 

Measure Mode 

Die vier verfügbaren Modi (Scope, Absorption, Transmission oder Bestrahlung) werden in den 
Abschnitten 3.3.1. bis 3.3.4. beschrieben. Beachten Sie, dass im Absorptions-, 
Transmissions- und Bestrahlungsmodus ein Referenz- und Dunkelspektrum vor dem Start 
der History-Channel-Messung gespeichert oder geladen werden muss, um die Messung zu 
ermöglichen. 

Function Definition 

Die Parameter, welche in der Funktionsdefinitions-Box eingegeben werden müssen, hängen 
vom ausgewählten Funktionstyp ab: Integral, User Defined, View Spectrum oder Peak. 

Funktionstyp: Integral 

 
Wenn eine Funktion definiert wurde, um das Integral in Abhängigkeit von der Zeit darzustellen, 
können die folgenden Parameter eingestellt werden: 

o Der Spektrometerkanal. Voreingestellt ist der Masterkanal. Wenn mehrere Kanäle 
verfügbar sind, kann der Spektrometerkanal auf Slave1 bis Slave7 geändert werden.  

o Die „From” und „To”-Eingaben können geändert werden, um den Wellenlängenbereich 
(in nm), über den das Integral berechnet werden soll, festzulegen.  

o Letztendlich kann ein Multiplikationsfaktor eingegeben werden. Der hier eingegebene 
Wert wird mit dem berechneten Integral multipliziert.  

Funktionstyp: User Defined 

 
Wenn Sie den Output einer selbstdefinierten Funktion in Abhängigkeit von der Zeit darstellen 
wollen, muss zunächst eine Funktion definiert werden. Sie können entweder eine 
nutzerspezifische „Input Function“ in die Zeile eingeben oder dem History-Channel ein Skript 
zuweisen. 
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Input Functions 

Im Fenster oben ist ein übergreifendes Beispiel für eine Inputfunktion gegeben. Das zeigt aber 
nur einige wenige der Funktionen, die getSoft ausführen kann. Im Folgenden sind alle 
erlaubten Operatoren und Funktionen aufgelistet: 

Operatoren: *, /, +,- 

Funktionen: log(x) = natürlicher Logarithmus 
log10(x) = Logarithmus mit Basis 10 
exp(x) = ex 
sqrt(x) = Quadratwurzel 

Zusätzlich kann das Wellenlängensignal für Master- und Slavekanal/-kanäle eingegeben 
werden durch: 

m (Wellenlänge in nm)  = Master 
s1 (Wellenlänge in nm) = Slave1, s2 (Wellenlänge in nm) =  Slave2, usw. 

Beispiel: Die einzugebende Funktion, welche die Intensität der HG-Spitze in Abhängigkeit von 
der Zeit im zweiten Slavekanal verfolgt, ist: s2 (253,65) 

Scripts 

Ein Skript-Feature wurde beigefügt. um wesentlich schwierigere Berechnungen mit viel mehr 
mathematischen und logischen Funktionen ausführen zu können. Skripte ermöglichen Ihnen 
auch, die Ergebnisse mehrerer History-Channels zu kombinieren. 

getSoft verwendet die in Ihrem Windows-Betriebssystem enthaltene Microsoft VBScript-
Sprache. Wir haben für Sie eine Hilfedatei für VBScript integriert. Sie erreichen die Hilfe vom 
Hauptmenü aus durch Auswahl von „Help -> VB Scripts“. In ihr ist neben vielen anderen 
Erklärungen eine Liste aller verfügbaren Operatoren und Funktionen enthalten. 

Wenn Sie ein Skript editieren, wird entweder das vorherige Skript für den Kanal angezeigt 
oder ein neues Startskript wird erstellt, sollte kein vorheriges Skript existieren. getSoft enthält 
einen einfachen Skripteditor. Die Skripte sind einfache ASCII-Dateien mit dem Namen 
„Fx_script.txt“, wobei x die Nummer des History-Channel (1 – 8) repräsentiert. Ein Startskript 
hat den folgenden Inhalt: 

Function F2 (value) 
 F2 = 0 
End Function 

Sie können diese Funktion näher ausführen, solange am Ende F2 ein Wert zugewiesen ist. In 
diesem Fall wird F2 der Wert 0 zugewiesen. Sie können sich mit Hilfe der vordefinierten 
Variablen F1 bis F8 auf die anderen History-Channels beziehen 

Wenn Sie die Daten des Spektrometers verwenden wollen, müssen Sie den anderen History-
Channels beispielsweise Wellenlängenwerte oder Integrale zuweisen. Das folgende Skript 
definiert den Funktionswert für F3 als Quotient von F1 und F2. 

Function F3(value) 
 F3=F1/F2 
End Function 
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Bitte beziehen Sie sich nicht auf den Funktionswert für das Skript selbst. Sie können sich 
weiterhin auch nicht auf andere Funktionen beziehen, wenn diese selber einem Skript 
zugewiesen sind. Das führt zu einem Skript-Laufzeitfehler. Wenn Sie einen Code eines 
anderen Skripts verwenden wollen, kopieren Sie die Zeilen aus dem entsprechenden Skript in 
das Skript, mit dem Sie gerade arbeiten. 

Bitte verstehen Sie, dass ein Skript zeilenweise von einem Interpreter abgearbeitet wird. 
Wenn Sie einen Syntaxfehler in ihrem Skript machen, wird der Laufzeitfehler für gewöhnlich in 
dem Moment angezeigt, in dem die fehlerhafte Zeile ausgeführt werden soll.  

Beispielsweise können Sie folgendes Skript für Funktion 3 eingeben: 

Function F3(value) 
 F3=F1/0 
End Function 

Das Ausführen dieses 
Skripts wird in einen 
Laufzeitfehler resultieren 
(Abb. rechts). 

Wenn Sie sich auf Kanäle 
beziehen, die nicht definiert sind („Function Type: None”), werden diese als nichtinitialisierte 
Variablen mit dem Wert 0 von VBScript behandelt. Dies trifft auf alle nicht initialisierten 
Variablen in allen ihren Skripten zu. 

Zuletzt ein einfaches Beispiel für die Überwachung eines Integrals zwischen 522 nm und 
550 nm, wobei ein Ausgleich subtrahiert wird. Der Ausgleichsbereich ist der Bereich unter der 
geraden Linie zwischen dem Output bei 522 nm und dem Output bei 550 nm.  

F1 ist definiert als nutzerdefinierte Inputfunktion: m(522) 
F2 ist definiert als nutzerdefinierte Inputfunktion: m(550)  
F3 ist definiert als das nullpunktbasiertes Integral zwischen 522 nm und 550 nm. 

Das Skript für Funktion F4 kann dann so geschrieben werden: 

Function F4(value) 
 If F1 > F2 Then 
  offset = 28*(F2 + (0.5*(F1-F2))) 
 Else 
  offset = 28*(F1 + (0.5*(F2-F1))) 
 End If 
 F4 = F3 - offset 
End Function 

Funktionstyp: View Spectrum 
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Die Funktion „View Spectrum” stellt die Funktionsausgabe nicht in Abhängigkeit von der Zeit 
dar. Statt dessen wird auf der x-Achse der Wellenlängenbereich dargestellt, der in dem 
Kasten „Function Definition” eingegeben wurde. Das Spektrum für den ausgewählten 
Spektrometerkanal wird im ausgewählten Messmodus dargestellt. In Kombination mit getSoft-
XLS kann der Modus „View Spectrum” auch für den Online-Export der Spektren nach Excel 
verwendet werden (siehe Abschnitt „4.5 Application: Excel Output“). 

Wenn die History-Channel-Funktionen verwendet werden, um die Intensität oder die Wellen-
länge eines Peaks zu verfolgen (siehe unten „Funktionstyp: Peak“), kann ein grafisches 
Feature verwendet werden, um die Spitzenänderungen in einem Spektrum zu veranschau-
lichen. Die Anzahl der Spitzen, die im Spektrum dargestellt werden sollen, kann eingegeben 
werden. Diese Zahl (zwischen 0 und 100) ist die Anzahl der vertikalen Linien, welche im 
Spektrum gezeichnet werden. Jede vertikale Linie repräsentiert eine vorher entdeckte Spitze. 

o Die Höhe der vertikalen Linie ist gleich der Spitzenintensität. 

o Die Wellenlänge, bei welcher die vertikale Linie im Spektrum gezeichnet wird, 
entspricht der Wellenlänge der erkannten Spitze. 

o Die Farbe einer vertikalen Linien repräsentiert das Alter der Spitze: die jüngste Spitze 
ist rot, in der Zeit zurückschreitend gefolgt von orange, grün und blau. Alle älteren 
Spitzen sind grau: hellgrau (älteste Spitze) bis dunkelgrau (eine Spitze älter als blau). 

Das Zeitintervall, innerhalb dem die vertikalen Linien aktualisiert werden, ist identisch mit dem 
Zeitintervall für die Speicherung des Funktionsoutput (einzugeben in „Save every x seconds“ 
unter „Save Function Output“). 

Angenommen der Funktionsoutput wird alle 3 Sekunden gespeichert und die Anzahl der 
anzuzeigenden Spitzen wurde in Funktion F1 auf 10 eingestellt. Nachdem die History-
Channel-Messung gestartet wurde, wird die Spitze im für F1 gezeichneten Spektrum 
unmittelbar durch eine rote vertikale Linie markiert. In den nächsten 3 Sekunden variieren 
eventuell Höhe und Position der Spitze, aber die rote Linie bleibt in gleicher Position und 
Höhe. Nach 3 Sekunden wird die rote Linie orange und eine neue rote Linie wird an der 
Position gezeichnet, an der bei (t = 3) eine Spitze erkannt wurde. Nach 6 Sekunden wird eine 
weitere Linie gezeichnet und die Farben werden weiter verschoben, so dass die jüngste rot 
ist und die danach folgenden orange und grün. Bei t = 27 Sekunden, wird die zehnte vertikale 
Linie in rot gezeichnet, die älteste wird nun durch ein helles grau visualisiert. Bei t = 30 
Sekunden wird die älteste Spitze von der Liste entfernt (da in diesem Beispiel nur 10 Spitzen 
angezeigt werden sollen), und die Farben werden wieder verschoben usw. 

Funktionstyp: Peak 

 
Wenn die Spitzenfunktion ausgewählt wurde, um eine Spitze in Abhängigkeit von der Zeit 
darzustellen, können die folgenden Parameter eingestellt werden: 
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o Der Spektrometerkanal. Voreingestellt ist der Masterkanal. Wenn mehr Kanäle 
verfügbar sind, kann der Spektrometerkanal auf Slave1 bis Slave7 geändert werden.  

o Die „From” und „To”-Eingaben können geändert werden, um den Wellenlängenbereich 
(in nm), welcher für die Spitzensuche ausgewertet werden soll, festzulegen.  

o Letztendlich kann in einer Auswahl der Spitzenoutput definiert werden: „Wellenlänge” 
oder „Intensität”.  

Wenn Wellenlänge und Intensität in Abhängigkeit von der Zeit verfolgt werden sollen, kann 
eine der Funktionen (F1…F8) verwendet werden, um die Spitzenwellenlänge zu verfolgen, 
und eine andere Funktion um die Spitzenintensität zu verfolgen. Um die Spitzenverände-
rungen zu veranschaulichen, kann eine dritte Funktion (mit beispielsweise dem Wellenlän-
genbereich von 455 – 457 nm und einer Anzahl der darzustellenden Scans von 10) auf „View 
Spectrum” eingestellt werden. In der oberen Abbildung entspricht der daraus resultierende 
Output der Wellenlänge der höchsten Spitze zwischen 455 und 457 nm. Wenn der Button 
„Intensity“ ausgewählt wäre, entspräche der Funktionsoutput der Intensität der höchsten 
Spitze zwischen 455 und 457 nm. 

Function Display Settings 

 
Für Integral-, benutzerdefinierte und Spitzenfunktionen kann die Ausgabe grafisch in 
Abhängigkeit von der Zeit dargestellt werden. Der Zeitbetrag, welcher an der x-Achse 
dargestellt wird, kann manuell mit Hilfe des Radiobuttons „Fixed“ eingestellt werden. Wenn 
der Button „Auto“ ausgewählt wurde, wird die Zeitachse auf eine Minute gesetzt. Diese Option 
ist nicht verfügbar, wenn der Funktionstyp „View Spectrum” ausgewählt wurde, da die Skala 
der X-Achse in diesem Fall in Nanometern und wie oben beschrieben durch den 
Wellenlängenbereich bestimmt wird. 

Auch die Y-Achse kann auf „Fixed” oder „Auto” eingestellt werden. Die Option „Auto” setzt den 
Y-Achsenbereich auf die minimalen und maximalen Funktionswerte, die in der Liste der 
gemessenen Datenpunkte enthalten sind.  

Funktionsunabhängige Parameter 

 

 

Funktionsunabhängige Parameter: Display No Graphics To Speed Up Data Processing 
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Unterhalb der Register für Funktionsdefinition kann eine Option aktiviert/deaktiviert werden, 
welche die Datenverarbeitung dadurch beschleunigt, dass sie die grafische Darstellung von 
Grafiken während den Messungen unterbindet. Wenn eine Applikation schnelle 
Datenverarbeitung erfordert (z.B. mehr als 10 Scans pro Sekunde), sollte diese Option 
aktiviert werden. Wenn sie in einer Outputdatei gespeichert wurden, können die Daten 
grafisch dargestellt werden, nachdem die Zeitreihenmessung abgeschlossen ist 
(beschrieben in Abschnitt „4.1.3 History Application: Display Saved History Graph“). 

Funktionsunabhängige Parameter: Save Function Output 

Die Ergebnisse einer Zeitreihenmessung werden in einer ASCII-Datei gespeichert, wenn der 
Radiobutton „Save Function Output” ausgewählt wurde. Eine Anzahl von Sekunden zwischen 
der Speicherung können für die Datenreduzierung eingegeben werden, sollten die Messungen 
über lange Zeiträume erfolgen. Die Eingabe des Wertes „0“ veranlasst die Speicherung jedes 
Scans. Der Name der Datei, in welcher die Daten gespeichert werden, kann durch Betätigen 
des Buttons „Change Output File…” geändert werden.  

Die Option „Create Backup File“ im „Save Function Output”-Fenster aktiviert bzw. deaktiviert 
die Erstellung einer Backupdatei während der Messungen. Wenn diese Option aktiviert 
wurde, erstellt getSoft eine Backupdatei mit dem selben Namen bis auf die Erweiterung *.bak 
(auch in ASCII). Diese Backupdatei wird nach jedem Scan aktualisiert und kann im Falle einer 
fehlerhaften Speicherung (z.B. Stromversorgungsstörung während einer Messung) unter dem 
ausgewählten Dateinamen verwendet werden. 

Buttons „Save HCF…/Load HCF…“  

getSoft speichert automatisch alle Parameter (Funktionsdefinition, Speicheroptionen) in der 
Datei „hcf.ini” und stellt diese Parameter beim nächsten Starten von getSoft wieder her. Mit 
den Buttons „Save HCF…” und „Load HCF…” können auch Parameter in einer *.hcf-Datei 
gespeichert und geladen werden. Mit dieser Option kann für jedes Experiment eine andere 
*.hcf-Datei gespeichert werden, so dass die Einstellung das nächste Mal bei Bedarf geladen 
werden kann. Die Abbildung links unten zeigt das Fenster, in dem der Name der *.hcf-Datei 
eingegeben werden kann, nachdem der Button „Save HCF…“ betätigt wurde. Die Abbildung 
unten rechts zeigt, wie eine vorher gespeicherte *hcf-Datei nach Betätigen des Buttons „Load 
HCF…“ ausgewählt werden kann.   

Nach der genauen Bestimmung von einer oder mehreren Funktionen wird der „OK“-Button für 

die Bestätigung bzw. der „Cancel”-Button zum Verlassen des Fensters ohne Änderungen 
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betätigt. Wenn der „OK“-Button betätigt wurde, führt getSoft eine Reihe von Tests an den 
eingegebenen Daten aus. Wenn keine Warnung angezeigt wird, sind die eingegebenen 
Parameter akzeptiert. Die Messung kann mit der Menüoption „Application -> History -> Start 
Measuring” gestartet werden. 

4.1.2 History Application: Start Measuring 

Diese Option stellt die Ausgabe in Abhängigkeit von der Zeit für die Verlaufsfunktionen dar, die 
im H.C.F.-Eingabefeld definiert wurden. Falls die Option „Display no graphics to speed up 
data processing“ im Funktionseingabe-Fenster ausgewählt wurde, erfolgt die Darstellung der 
Funktionsausgabe nur durch Nummern. Diese werden immer dann aktualisiert, wenn ein 
neuer Scan in der Ausgabedatei gespeichert wird.  

Es befinden sich 6 Buttons am oberen Bildschirmrand: ein „Exit”-Button, ein „Pause/Start“-
Button, ein „Save Reference“-Button, ein „Save Dark“-Button, ein „Info“-Button und ein „Print“- 
Button.  

Wenn der rote „Exit“-Button betätigt wird, werden die Zeitmessungen beendet und 
Hauptfenster und 
Hauptmenü werden 
wieder aktiviert.  

Der gelbe „Pause“-
Button kann zum 
temporären Anhalten 
der Messung 
verwendet werden.  

Nachdem der 
„Pause“-Button 
betätigt wurde, stoppt 
die Datenerfassung 
und die 
Buttonbeschriftung 
ändert sich zu einem 
grünen „Start“.  

Wenn der „Start“-
Button betätigt wird, 
wird die 
Datenerfassung fortgesetzt und die Beschriftung zeigt erneut „Pause“ (gelb). 

Die Buttons „Save Reference” und „Save Dark” besitzen die gleiche Funktion wie im 
Hauptfenster. 

Der „Info”-Button zeigt das Fenster „Function Entry”, in dem während einer laufenden 
Messung alle Parameter betrachtet und nicht bearbeitet werden können. 

Durch Betätigung des „Print”-Buttons können die dargestellten Grafiken während des 
Durchlaufs ausgedruckt werden. Ein Fenster, in dem die Druckoptionen eingestellt werden 
können, wird geöffnet. Wenn beispielsweise bei der Abbildung oben nur einer der vier 
Graphen gedruckt werden soll, kann dieser Graph mit Hilfe des „Page(s)“-Radiobuttons 
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ausgewählt werden. Alle Grafiken werden im Originalmaßstab auf eine separate Seite 
gedruckt. 

Zoomfeatures 

In jedem Graphen können die gleichen Zoomfeatures wie im Hauptfenster angewendet 
werden (außer der Skalierung der Y-Achse mit dem Scrollrad der Maus). Dennoch sind 
Zoom-Ins über die X-Achse während einer Messung (mit einer bereits scrollenden X-Achse) 
nicht möglich, da in diesem Fall die X-Achse mit jedem neuen Scan aktualisiert wird. Der 
„Pause“-Button hält den Messvorgang an und kann somit zur Betrachtung eines Auszugs 
verwendet werden. 

Zoom in: Wählen Sie einen Bereich aus, der auf die Größe des gesamten Graphen 
vergrößert werden soll. Dazu klicken Sie mit der linken Maustaste in den weißen 
Grafikbereich und ziehen Sie ihn nach unten rechts. Nachdem Sie die linke Maustaste im 
Grafik-Display losgelassen haben, werden X- und Y-Achse entsprechend der neuen Werte 
des ausgewählten Bereichs neu skaliert. 

Zoom out: Ziehen Sie mit der linken Maustaste innerhalb des weißen Rechtecks, aber anstatt 
die Maus nach unten zu ziehen, bewegen Sie diese in eine andere Richtung. Nachdem Sie 
die Maustaste losgelassen haben, werden X- und Y-Achse auf ihre voreingestellten 
Ausgangswerte zurückgesetzt. 

Move X-Y: Mit der rechten Maustaste können Sie das gesamte Spektrum nach oben und 
unten sowie nach rechts und links verschieben. 

4.1.3 History Application: Display Saved History Graph 

Wenn Zeitmessdaten gespeichert wurden, 
kann die resultierende ASCII-Datei durch 
Auswahl der Datei im Fenster (Menüoption 
„Application -> History -> Display Saved 
History Graph”) grafisch dargestellt werden.  

Nachdem der „Open”-Button betätigt wurde, 
wird die Ausgabe der Funktionen mit dem 
Funktionstyp „Integral” oder „User Defined” in 
Abhängigkeit von der Zeit dargestellt. X- und 
Y-Achse werden auf ihre Vollskala 
zurückgesetzt, welche von den Minimum- 
und Maximumwerten in der Liste bestimmt wird. 
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Die Zoomfeatures (wie in Abschnitt „History Application: Start Measuring“ beschrieben) 
können verwendet werden, um in ein relevantes Zeitintervall hineinzuzoomen. Eine 
Beschreibung zum „Print“-Button finden Sie auch dort. 

Da die History-Channel-Outputdatei in ASCII gespeichert wurde, kann diese Datei einfach in 
ein Tabellenkalkulationsprogramm wie Microsoft Excel importiert werden. Die Daten in der 
Datei können auch mit einem Texteditor eingesehen werden. Ein Beispiel für das Dateiformat 
wird auf der folgenden Seite erklärt.
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History-Channel Funktionen Messbericht 

Messungen gestartet am 29/06/01   Zeit: 15:06:29 

Integrationszeit: 3 ms 

Mittelung: 1 scans 

Funktionsbeschreibung: 

FUNKTION 1: nutzerdefinierte Funktion: m(400). Scope-Modus. 

FUNKTION 2: nutzerdefinierte Funktion: m(500). Absorptionsmodus. 

FUNKTION 3: nutzerdefinierte Funktion: m(600). Transmissionmodus. 

FUNKTION 4: nutzerdefinierte Funktion: m(700). Bestrahlungsmodus. 

FUNKTION 5: festgelegter Masterkanal, zwischen 380,0 und 780,0 nm. Multipliziert mit: 1000. 
Transmissionmodus. 

FUNKTION 6: „View Spectrum” im Transmissionsmodus. Keine Speicherung von Daten. 

FUNKTION 7:Nicht aktiviert 

FUNKTION 8:Nicht aktiviert 

Zeit Sekunden F1 F2  F3 F4 F5         

15:06:29 0,62  79,79 -2,294E-3 100,8 74,11 40192      

15:06:30 0,77  81,84 -2,059E-3 100,9 74,17 40236      

15:06:30 0,92  81,79 -3,756E-3 100,2 73,77 40201      

15:06:30 1,07  84,69 -3,209E-3 101,0 73,43 40202      

15:06:30 1,22  82,19 -7,877E-4 100,3 74,11 40188 

4.2 Application: Wavelength Calibration 

Im Abschnitt „3.2.2 Setup Menu: Wavelength Calibration Coefficients“ wird das Polynom, 
welches die Pixelanzahl auf dem Detektor in die entsprechende Wellenlänge auf der X-Achse 
in getSoft konvertiert, näher beschrieben.  

Wenn eine Mercury-Argon-Lichtquelle (getLight-CAL) mit entsprechendem optischen 
Lichtwellenleiter verfügbar ist, kann eine automatische Wellenlängenkalibrierung durchgeführt 
werden. Die empfohlenen Lichtwellenleiter (für Autokalibrierung) sind: 

GS-SMA-IR-008-2 8 µm Kerndurchmesser, Vis/NIR, 2 m lang, SMA 
GS-SMA-IR-050-2 50 µm Kerndurchmesser, Vis/NIR, 2 m lang, SMA 
GS-SMA-UV-050-2 50 µm Kerndurchmesser, UV/Vis, 2 m lang, SMA 

Für eine erfolgreiche Autokalibrierung ist das Verhindern einer Sättigung sehr wichtig. Der 
einfachste Weg, um eine Sättigung auszuschließen ist die Option „Setup -> Options -> 
Check on Saturation“. Wenn das Spektrometer bei einer minimalen Integrationszeit gesättigt 
ist, sollte eine Faser mit einem geringeren Kerndurchmesser (z.B. GS-SMA-IR-008-2) 
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verwendet werden. Alternativ kann das eingehende Licht z.B. mit einen Dämpfungsglied 
(FOA-Inline) oder einem neutralen Dichtefilter gedämpft werden. 

4.2.1 Wavelength Calibration: Perform New Calibration 

Die Prozedur für eine Autokalibrierung wird im Folgenden beschrieben: 

1. Schließen Sie die Faser an die 
getLight-CAL-Lichtquelle und an 
den zu kalibrierenden 
Spektrometerkanal an. 

2. Wählen Sie eine geeignete 
Integrationszeit, so dass der 
Detektor nicht gesättigt ist. Die 
Spitzen können im Scope-Modus 
betrachtet werden. 

3. Wählen Sie die Menüoption 
„Application -> Wavelength 
Calibration -> Perform New 
Calibration” aus.  

4. Die Autokalibrieroption wird nun 
nach einer Anzahl von Spitzen 
suchen. Diese Anzahl beträgt 
zunächst 5 Spitzen in den Daten 
des Masterkanals. 

5. Der Spektrometerkanal und die Anzahl der gesuchten Spitzen kann verändert werden. 
Eine neue Suche kann durch Betätigen des Buttons „Find Peaks“ gestartet werden. Die 
Spitzen werden in 3 Spalten angezeigt. Erstere zeigt die Position der erkannten Spitzen 
an. Die zweite Spalte die Position einer suggerierten Standardspitze an, wenn diese ver-
fügbar ist. Die letzte Spalte listet die Unterschiede zwischen den ersten beiden Spalten 
auf. Sie können die Werte der zweiten Spalte nach Anwählen mit der Maus editieren.  

6. Wählen Sie den Polynomgrad aus. In den meisten 
Fällen wird ein Polynom dritten Grades die beste 
Übereinstimmung anzeigen. 

7. Die Option „include 2nd order peaks” kann aktiviert 
werden, wenn Polynome zweiten oder dritten Grades 
der Liste mit verfügbaren Spitzen (z.B. 507,30 nm als 
Spitze 2. Ordnung für 253,65) hinzugefügt werden 
sollen. In den meisten Spektrometern wird der Effekt 
2. Ordnung durch Filter oder Beschichtungen elimi-
niert, aber wenn diese Optionen dem Spektrometer 
nicht hinzugefügt wurden und Spitzen 2. Ordnung 
verfügbar sind, können diese in die Kalibrierung 
eingebunden werden. Die Zellen der mittleren Spalte werden grün markiert, wenn eine 
Spitze 2. Ordnung und gelb, wenn eine Spitze 3. Ordnung erkannt wurde. 
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8. Betätigen Sie den Button „Calculate”. Wenn eine Kalibrierung erfolgreich war, werden Sie 
gebeten, neue Koeffizienten zu bestätigen. Wählen Sie „OK“ und die neue Kalibrierung 
wird augenblicklich angewendet. 

9. Mindestens 3 Spitzen werden benötigt, um eine neue Kalibrierung erfolgreich abzu-
schließen. Versuchen Sie, mit mehr Spitzen zu kalibrieren. Die Auswahl von zu vielen 
Spitzen kann aber dennoch zu Spitzen führen, die nicht mit Standard-Wellenlängen 
übereinstimmen. 

4.2.2 Wavelength Calibration: Restore Original Calibration 

Diese Option ermöglicht dem Nutzer, die Kalibrierkoeffizienten auf die Ausgangswerte 
zurückzusetzen, d.h. auf die Werte, mit denen getSoft ausgeliefert wurde. Wenn eine neue 
Kalibrierung mit einer beschränkten Anzahl von Spitzen oder über einem beschränkten 
Wellenlängenbereich durchgeführt wurde, könnten die Ergebnisse weniger günstig sein. 

Die Option erlaubt dem Nutzer ungewollte Veränderungen in der Kalibrierung rückgängig zu 
machen.  

4.3 Application: Color Measurement  

 
Die getSoft-Farbapplikation wurde entwickelt, um Online-Farbmessungen mit einem 
Spektrometersystem durchzuführen. Sie kann für Reflexions-Farbmessungen (in älteren 
Versionen von getSoft „Color of object measurements” genannt) verwendet werden. Die CIE 
1976 L*a*b*-Farbparameter werden wie auch andere gebräuchliche Parameter (z.B. Farbton, 
Chrominanz und X, Y, Z) berechnet. 

Diese Parameter können in einem CIE LAB-Diagramm oder in einem Graph in Abhängigkeit 
von der Zeit dargestellt werden. Es ist weiterhin möglich, die gemessenen L*a*b*-Werte 
online in einer Datenbank zu speichern und eines der Produkte aus der Datenbank als 
Referenzfarbe zu verwenden. Durch den Vergleich der gemessenen  L*a*b*-Werte mit den 
gespeicherten Werten in der Datenbank können auch Farbunterschiede  (? ELab, ? L*, ? a*, 
oder ? b*) gemessen werden.  

Farbmessungen können durchgeführt werden, um die Farbe einer Lichtquelle (z.B. LEDs) zu 
messen. Diese Messungen erfordern ein Bestrahlungsspektrum, um die Berechnung der 
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Farbparameter x, y und z zu ermöglichen. Mit der Bestrahlungsapplikation in getSoft ist es 
möglich, Bestrahlungsmessungen mit einer wesentlich höheren Genauigkeit als im normalen 
relativen Bestrahlungsmodus (welcher eine perfekte Schwarzkörper-Lichtquelle mit bekannter 
Farbtemperatur voraussetzt) vorzunehmen. Aus diesem Grund ist die Berechnung der 
aussendenden Farbe oder „Color of light” eine der Besonderheiten in der Bestrahlungs-
applikation. 

4.3.1 Color of an Object – Hintergrund 

Die Farbe eines Objekts kann mit dem CIE 1976 (L*a*b*)–Farbraum ausgedrückt werden.  
L* beschreibt die Helligkeit der Farbe. Ein positiver Wert für a* beschreibt den Rotanteil, ein 
negativer Wert für a* den Grünanteil. In ähnlicher Weise wird der Gelbanteil und Blauanteil 
durch die Koordinate b* ausgedrückt, wobei ein positiver Wert Gelb und ein negativer Blau 
repräsentiert. Die L*a*b*-Werte werden von den CIE-Tristimuluslwerten X, Y und Z der Probe 
(Objekt) und den Standardlicht-Tristimuluswerten Xn, Yn und Znabgeleitet. 

Die Standardlicht-Tristimuluswerte für Xn, Yn, und Zn sind konstant und hängen nur vom Typ 
des ausgewählten Standardlichts ab. 

Die CIE-Tristimuluswerte X, Y und Z der Farbe des Objekts werden durch Multiplikation der 
relativen Leistung P einer Standardlichtquelle, der Reflexion R (oder Transmission) des 
Objekts und der CIE-Standard-Betrachtungsfunktionen x?, y? und z? (Winkel von 2 Grad oder 
10 Grad) bestimmt. Das Integral dieser Produkte über allen Wellenlängen im sichtbaren 
Spektrum (380 bis 780 nm mit einem 5 nm–Intervall) ergibt die Tristimuluswerte. 

Die chromatischen Koordinaten x, y und z werden aus der Summe der Anteile der 
Tristimuluswerte (X, Y und Z) erhalten: 

? ?ZYX
X

x
??

?
   ? ?ZYX

Y
y

??
?

  ? ?ZYX
Z

z
??

?
 

Eine andere verbreitete Art der Darstellung der Farbparameter a* und b* ist die Präsentation 
ihres Farbtonwinkels (h*) und der Chrominanz (C*). Der Farbtonwinkel wird in Grad 
gemessen beginnend bei h* = 0 in Rotrichtung (+a*) und Erhöhung entgegen dem 
Uhrzeigersinn: 

*

*
* arctan

a
b

h ?
 

Die Chrominanz wird als Länge der Linie vom Punkt a*=b*=0 zum Probepunkt (Objektpunkt) 
ermittelt: 

22 *** baC ??  

Um Farbunterschiede zu beschreiben, ist ? ELab ein verbreiteter Parameter, welcher wie folgt 
definiert ist: 

222 *)(*)(*)( baLELab ???????  

Wobei ? L*, ? a* und ? b* die Unterschiede in den L*a*b*-Werten der Referenzfarbe und den 
aktuell gemessenen L*a*b*-Werten beschreibt. 
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4.3.2 Color Measurement  

Nachdem die Option „Application -> Color Measurement” ausgewählt wurde, wird ein Fenster 
geöffnet, in dem die Inputparameter eingestellt werden können. Das Fenster enthält zwei 
Register: „LABChart” zeigt die Inputparameter für die Darstellung der Farbmessung in einem 
Farbdiagramm an, „Time Series” zeigt alle Inputparameter für die Darstellung von bis zu 8 
Farbparametern in einem Graphen in Abhängigkeit von der Zeit an. Die Inputparameter 
werden detailliert in den Abschnitten „4.3.2.1 LABChart“ und „4.3.2.2 Time Series“ 
beschrieben. 

Die Farbmessungen werden gestartet, sobald der „OK”-Button betätigt wurde. getSoft kehrt in 
das Hauptfenster zurück, wenn der „Cancel”-Button betätigt wird. 

4.3.2.1 LABChart 

  
Die Farbmessungen im LABChart werden durch Betätigen des „OK”-Buttons gestartet (Abb. 
oben). Die folgenden Parameter können vor Beginn der Messungen eingestellt werden: 

o Spektrometerkanal. Wenn das Spektrometersystem einen oder mehrere Slave-
Spektrometerkanäle enthält, kann der Spektrometerkanal auf dem die Farbe 
gemessen wird, in dem Auswahlfeld in der oberen linken Ecke (zeigt voreingestellt 
„Master” an) ausgewählt werden. Vergewissern Sie sich, dass vorher weiße 
Referenz- und Dunkelspektren für den ausgewählten Spektrometerkanal gespeichert 
wurden. 

o Illuminant. Die CIE-Standardquellen A, B oder C oder eine der Quellen D50, D55, 
D65 oder D75 können durch Klicken auf die Radiobuttons ausgewählt werden. 
Vorgegeben ist die D65 – eine weitgehend gebräuchliche Lichtquelle. Sie repräsentiert 
die Strahlungsverteilung von durchschnittlichem Tageslicht mit einer korrelierten 
Farbtemperatur von 6500 K. Die D50, D55 und D75 besitzen korrelierte 
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Farbtemperaturen von 5000 K, 5500 K und 7500 K. Die CIE-Standardquellen A, B 
oder C repräsentieren jeweils: glühendes Licht (2854 K Schwarzkörper), simuliertes 
Mittagssonnenlicht und simuliertes Trübtageslicht. Beachten Sie, dass keinerlei 
Beziehung zwischen der hier eingestellten Quelle und der Lichtquelle, die zur 
Farbmessung eines Objektes verwendet wird, besteht. Die ausgewählte Quelle wird 
in der Berechnung der Farbparameter verwendet. Diese Farbparameter sind 
unterschiedlich, wenn beispielsweise A anstelle von D65 ausgewählt wird, genauso 
wie die Farbe eines Objektes unter verschiedenen Bedingungen (normales 
Tageslicht, oder glühendes Licht 2854 K Schwarzkörper) verschieden aussieht. 

o CIE Standard Observer. Die ursprünglichen CIE-Standardbetrachtungsfunktionen 
x?, y? und z? wurden 1931 definiert und sind als 2-Grad-Standardbetrachtungswerte 
bekannt. Die 2 Grad entsprechen dem Betrachtungswinkel, der in den Experimenten 
zur Bestimmung dieser Standardwerte verwendet wurde. 1964 empfahl die CIE die 
Verwendung anderer Betrachtungswerte für eine höhere Korrelation mit bildlicher 
Vorstellung. Diese sind die 1964-Supplementär-Standardbetrachtung oder 10-Grad-
Betrachtungwerte. Beide Standards werden noch immer verwendet und in getSoft 
können die CIE-Standardbetrachtungen durch Betätigen der Radiobuttons ausgewählt 
werden, die Voreinstellung ist 2 Grad.  

o Display settings. Die Messergebnisse können grafisch in drei Diagrammen 
dargestellt werden: 

1. Das LABChart, in welchem a* und b* durch einen beweglichen Punkt in einem 
CIELAB-Graphen dargestellt werden. 

2. Die gemessene Farbkonsole, welche die Farbe, die gemessen wurde, darstellt. 
Beachten Sie, dass die auf dem Bildschirm dargestellte Farbe eventuell nicht 
exakt mit der tatsächlichen Farbe des Objekts übereinstimmt (abhängig vom 
Bildschirm), dennoch erhält man eine gute Vorstellung. 

3. Die Referenzfarbkonsole, welche die Referenzfarbe anzeigt, welche unter 
„Reference color“-Einstellungen ausgewählt wurde.  

Das grafische Display kann mit einem Mausklick für jeden Graphen separat aktiviert bzw. 
deaktiviert werden. 

o Display following Color Parameters. Die Werte der aktiven Farbparameter werden 
während den Messungen unter den Diagrammen angezeigt.  

o Save Settings. Die Farbparameter können während der Messungen in einer ASCII-
Datei gespeichert werden. Der 
momentane Name und Ort dieser 
ASCII-Datei wird unter „Save setting” 
angezeigt. Dieser Dateiname (und Pfad) 
kann durch Betätigen des Buttons 
„Change Output File” geändert werden. 
Das nächste Fenster wird geöffnet: 

Um eine neue Datei zur Speicherung der 
Farbparameter zu erstellen, geben Sie 
einen Dateinamen ein, der noch nicht 
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existiert (getSoft fügt die .txt-Erweiterung an) und klicken Sie „Open“.  

Wenn eine existierende Datei ausgewählt wird, werden die zu speichernden 
Farbparameter dieser Datei zugefügt. Auf diesem Weg können zuvor gespeicherte 
Experimente unter Verwendung der selben Outputdatei weitergeführt werden.  

o Reference Color 

 

 

 

 

Die Referenzfarbe kann eingestellt werden, um die L*, a* und b*-Farbparameter während 
der Online-Messungen mit den LREF, aREF und bREF der Referenzfarbe zu vergleichen. 
Die Farbunterschiede können während der Messung durch dL (= L*-LREF), da (= a* - 
aREF), db (= b* - bREF) und/oder dE (= ?  (dL2+da2+db2)) angezeigt werden. 

Die Referenzfarbe kann manuell unter „Current Reference Color” eingegeben (Abb. oben) 
oder aus einer Datenbankdatei ausgewählt werden. Die Datenbankdatei ist eine Liste von 
Referenzfarben, welche zuvor in dieser Datei gespeichert wurden, alle mit einer 
einzigartigen ProductID. In der Voreinstellung ist der Dateiname der Datenbankdatei 
„empty.pct”. Durch Betätigung des Buttons „DB“ kann eine andere Datenbankdatei 
ausgewählt oder eine neue Datenbankdatei erstellt werden. 

Um eine neue Datenbankdatei für die 
Speicherung von Referenzfarben zu 
beginnen, geben Sie einen Dateinamen ein, 
der noch nicht existiert (getSoft fügt die 
Erweiterung *.pct zu) und klicken Sie auf 
„Open“.  

Um eine bereits existierende Datei zu 
öffnen, doppelklicken Sie einfach auf den 
Dateinamen oder wählen Sie ihn aus und 
klicken Sie den Button „Open“. Im 
Hauptverzeichnis von getSoft ist die Datei 
„example.pct” enthalten (voreingestellt C:\getSpec60), sie enthält einige gemessene 
Referenzfarben. 

Um eine Referenzfarbe von der Datenbank auszuwählen, klicken Sie den Button „Select” 
unterhalb des „DB”-Buttons. Die Inhalte der Datenbankdatei werden angezeigt (Abb. unten). 

Um eines der Produkte von der Liste auszuwählen, klicken Sie auf eine der Nummer (1...11) 
in der ersten (grauen) Spalte. Um ein Produkt von der Liste zu löschen, wählen Sie es aus 
und klicken Sie die „Entfernen“-Taste auf der Tastatur. 

Um nach einer bestimmten ProductID oder -Nummer zu suchen, klicken Sie auf den Button 
„Find”. 
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Um die Liste nach ProductID, L-REF, a-
REF oder b-REF zu sortieren, klicken 
sie in den entsprechenden Spaltenkopf. 
Eine gelb markierte „1“ wird im 
Spaltenkopf angezeigt. Durch erneutes 
Klicken auf den Spaltenkopf wird die 
Sortierreihenfolge umgekehrt. 

Durch Anklicken des „Cancel”-Buttons 
wird das ausgewählte Produkt nicht zur 
aktuellen Referenzfarbe im LABChart-
Einstellungsfenster bewegt und 
Änderungen (z.B. Löschen eines 
Produkts aus der Liste) werden 
ignoriert. 

Durch Betätigen des „OK”-Buttons wird 
die momentane Referenzfarbe im 
LABChart-Einstellungsfenster zur 
ausgewählten Farbe geändert. 

Um die momentane Referenzfarbe (im LABChart-Einstellungsfenster spezifiziert) der 
Datenbankdatei zuzufügen, kann der „Add“-Button (unterhalb des „Select“-Buttons) betätigt 
werden. Wenn die ProductID bereits existiert, wird ein Fenster geöffnet, in welchem man 
zwischen Überschreiben des alten Parameters mit einem neuen Parameter oder der 
Beibehaltung des alten Parameters unter diesem Namen wählen kann. Alternativ kann eine 
Referenzfarbe während der Online-Messung der Datenbank zugefügt werden. Dies kann nur 
geschehen, wenn im LABChart-Einstellungsfenster die Option „Add new reference colors to 
DB when measuring” aktiviert wurde. 

Nachdem alle Einstellungen korrekt 
eingegeben wurden, können die Messungen 
mittels des „OK”-Buttons oder der „Enter“-
Taste gestartet werden. Eine schnellere 
Variante mit Umgehung des Einstellungs-
fensters ist die Betätigung des „LABChart“-
Buttons im Hauptfenster von getSoft. 

Die Abbildung rechts zeigt alle 
Farbparameter und alle drei Diagramme 
aktiviert an. Die Messungen in der Abbildung 
werden mit dem Master-Spektrometerkanal 
durchgeführt und Lichtquelle D65 wurde 
ausgewählt. Die Farbparameter werden mit der 2-Grad-CIE-Standardbetrachtung berechnet. 
Der Dateiname der Datei, in welcher die Daten gespeichert werden, wird in der unteren linken 
Ecke angezeigt. 

Die Symbolleiste LABChart enthält folgende Buttons: 

o Der Button „Exit“ wird betätigt, um die Farbmessung abzubrechen und in das 
Hauptfenster von getSoft zurückzukehren 
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o Der weiße und der schwarze Referenzbutton haben den gleichen Effekt wie im 
getSoft-Hauptfenster. 

o Der Button „Save as reference color” wird für die Aktualisierung der momentanen 
Referenzfarbe verwendet. Nachdem dieser Button betätigt wurde, wird ein Fenster 
geöffnet, in dem der Name der ProductID eingegeben werden muss. Wenn die 
ProductID bereits in der Datenbank-
datei existiert und wenn die Option 
„Add new reference colors to DB 
when measuring” im LABChart-
Einstellungsfenster aktiviert ist, wird 
ein Fenster geöffnet, in welchem 
man zwischen Überschreiben des 
alten Parameters mit einem neuen 
Parameter oder der Beibehaltung 
des alten Parameters unter diesem 
Namen wählen kann (siehe Abb. 
rechts). 

o Der „Select”-Button kann für die 
Auswahl einer neuen Referenzfarbe aus der Datenbank verwendet werden, wie 
detailliert auf der vorangegangenen Seite beschrieben.  

o Jedes Mal, wenn der „Save“-Button betätigt wird, wird ein neuer Beleg zum 
Dateinamen in der unteren linken Ecke hinzugefügt. Ein Beleg enthält die folgenden 
Felder: Datum, Zeit, Kommentare, L, a, b, h, c, X, Y, Z, RefProductID, Lref, aRef, 
bRef, dL, da, db, dE, Kanal, Lichtquelle und Betrachtung. Das Kommentarfeld enthält 
einen Text, der nach Betätigung des „Save“-Buttons eingegeben werden kann. 
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4.3.2.2 Time Series 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mit Zeitreihen-Farbmessungen können bis zu 8 Farbparameter oder Farbunterschiede 
gleichzeitig in einem Graphen in Abhängigkeit von der Zeit betrachtet werden. Die Zeitreihen-
Einstellungen werden im Fenster (Abb. oben) definiert, welches nach der Auswahl des 
Registers „Time Series“ angezeigt wird. Die Funktionen F1 bis F8 können durch Klicken auf 
die entsprechende Registerkarte oben im Fenster ausgewählt werden. 

Weiterhin können einige allgemeine (funktionsunabhängige) Parameter unterhalb der 
einzelnen Register (F1 bis F8) eingegeben werden. Folgende Einstellungen können separat 
für alle Funktionen F1 bis F8 vorgenommen werden:  

o Spektrometerkanal. Wenn das Spektrometersystem einen oder mehrere Slave-
Spektrometerkanäle enthält, kann der Spektrometerkanal auf dem die Farbe 
gemessen wird, in dem Auswahlfenster in der oberen linken Ecke (zeigt voreingestellt 
„Master” an) ausgewählt werden. Vergewissern Sie sich, dass vorher weiße 
Referenz- und Dunkelspektren für den ausgewählten Spektrometerkanal gespeichert 
wurden.   

o Illuminant. Die CIE-Standardquellen A, B oder C oder eine der Quellen D50, D55, 
D65 oder D75 können durch Klicken auf die Radiobuttons ausgewählt werden. 
Vorgegeben ist die D65 – eine weitgehend gebräuchliche Lichtquelle. Sie repräsentiert 
die Strahlungsverteilung von durchschnittlichem Tageslicht mit einer korrelierten 
Farbtemperatur von 6500 K. Die D50, D55 und D75 besitzen korrelierte 
Farbtemperaturen von 5000 K, 5500 K und 7500 K. Die CIE-Standardquellen A, B 
oder C repräsentieren jeweils: glühendes Licht (2854 K Schwarzkörper), simuliertes 
Mittagssonnenlicht und simuliertes Trübtageslicht. Beachten Sie, dass keinerlei 
Beziehung zwischen der hier eingestellten Quelle und der Lichtquelle, die zur 
Farbmessung eines Objektes verwendet wird, besteht. Die ausgewählte Quelle wird 
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in der Berechnung der Farbparameter verwendet. Diese Farbparameter sind 
unterschiedlich, wenn beispielsweise A anstelle von D65 ausgewählt wird, genauso 
wie die Farbe eines Objektes unter verschiedenen Bedingungen (normales 
Tageslicht, oder glühendes Licht 2854K Schwarzkörper) verschieden aussieht. 

o CIE Standard Observer. Die ursprünglichen CIE-Standard-Betrachtungsfunktionen 
x?, y? and z? wurden 1931 definiert und sind als 2-Grad-Standardbetrachtungswerte 
bekannt. Die 2 Grad entsprechen dem Betrachtungswinkel, der in den Experimenten 
zur Bestimmung dieser Standardwerte verwendet wurde. 1964 empfahl die CIE die 
Verwendung anderer Betrachtungswerte für eine höhere Korrelation mit bildlicher 
Vorstellung. Diese sind die 1964-Supplementär-Standardbetrachtung oder 10-Grad-
Betrachtungwerte.Beide Standards werden noch immer verwendet und in getSoft 
können die CIE-Standardbetrachtungen durch Betätigen der Radiobuttons ausgewählt 
werden, die Voreinstellung ist 2 Grad.  

o Function display settings. Für jede Funktion kann einer der Farbparameter 
ausgewählt werden. Funktionen, für die der Farbparameter auf „None” eingestellt 
wurde, werden deaktiviert. Wenn einer der Farbunterschiedsparameter (dL, da, db or 
dE) ausgewählt wurde, muss die Referenzfarbe, mit der die gemessene Farbe 
verglichen werden muss, auch definiert werden. Deswegen wird die Referenzfarbe-
Definitionsbox angezeigt, wenn dL, da, db oder dE ausgewählt wird. 

 

Für jede Funktion kann eine unterschiedliche Referenzfarbe ausgewählt werden. Eine 
detaillierte Beschreibung zu den „DB-“, „Select”- und „Add“.Buttons finden Sie im 
vorhergehenden Abschnitt. 

Die Farbparameter, die in den Funktionen eingestellt wurden, können grafisch in 
Abhängigkeit von der Zeit dargestellt werden. Der Zeitbetrag, der auf der X-Achse 
dargestellt wird, kann manuell durch Betätigen des Radiobuttons „Fixed“ eingestellt 
werden (siehe Abb. unten).Wenn der Button „Auto“ ausgewählt wurde, wird die 
Zeitachse auf eine Minute gesetzt. Die Y-Achse kann auch auf „Fixed“ oder „Auto“ 
eingestellt werden. Die Option „Auto“ setzt die Y-Achse auf die minimalen und 
maximalen Funktionswerte, welche in der Liste der gemessenen Datenpunkte 
enthalten sind.   
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Funktionsunabhängige Parameter 

 
Funktionsunabhängige Parameter – Display no graphics to speed up data processing 

Unterhalb der Register für Funktionsdefinition kann eine Option aktiviert/deaktiviert werden, 
welche die Datenverarbeitung dadurch beschleunigt, dass sie die grafische Darstellung von 
Grafiken während den Messungen unterbindet. Wenn eine Applikation schnelle Datenverar-
beitung erfordert (z.B. mehr als 10 Scans pro Sekunde), sollte diese Option aktiviert werden. 
Wenn sie in einer Outputdatei gespeichert wurden, können die Daten grafisch dargestellt 
werden nachdem die Zeitreihenmessung abgeschlossen ist (beschrieben im Abschnitt „4.1.3 
History Application: Display Saved History Graph“). 

Funktionsunabhängige Parameter – Save Function Output 

Die Ergebnisse einer Zeitreihenmessung werden in einer ASCII-Datei gespeichert, wenn der 
Radiobutton „Save Function Output” ausgewählt wurde. Eine Anzahl von Sekunden zwischen 
der Speicherung können für Datenreduzierung eingegeben werden, sollten die Messungen 
über lange Zeiträume erfolgen. Die Eingabe des Wertes „0“ veranlasst die Speicherung jedes 
Scans. Der Name der Datei, in welcher die Daten gespeichert werden, kann durch Betätigen 
des Buttons „Change Output File…” geändert werden. Die letzte Option im „Save Function 
Output”-Feld aktiviert bzw. deaktiviert die Erstellung einer Backupdatei während der 
Messungen. Wenn diese Option aktiviert wurde, erstellt getSoft eine Backupdatei mit dem 
selben Namen bis auf die Erweiterung *.bak (auch in ASCII). Diese Backupdatei wird nach 
jedem Scan aktualisiert und kann im Falle einer fehlerhaften Speicherung (z.B. 
Stromversorgungsstörung während einer Messung) unter dem ausgewählten Dateinamen 
verwendet werden.  

Save Setting/Load Settings-Buttons 

getSoft speichert automatisch alle Parameter (Farbparameter, Speicheroptionen) in die Datei 
„cootime.ini” und stellt diese Parameter wieder her, wenn getSoft das nächste Mal gestartet 
wird. Mit den Buttons „Save Settings” und „Load Settings” ist es auch möglich, diese 
Parametereinstellungen in eine Datei mit der Erweiterung *.coo zu speichern (und sie von 
dort zu laden). Mit diesem Feature ist es möglich, für jedes Experiment eine unterschiedliche 
*.coo-Datei zu erstellen, so dass sie bei Bedarf geladen werden können. Die untere linke 
Abbildung zeigt das Fenster, in dem der Dateiname dieser Datei nach Betätigen des Buttons 
„Save Settings“ eingegeben werden kann. Die Abbildung unten rechts, die angezeigt wird, 
wenn der Button „Load Settings“ betätigt wurde, veranschaulicht, wie man eine vorher 
gespeicherte *.coo-Datei auswählt.   
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Nach der Definition von einer oder mehr Funktionen, kann der „OK”-Button zum Starten der 
Messung betätigt werden. Wird der „Cancel“-Button betätigt, verlassen Sie das Fenster und 
kehren Sie in das getSoft-Hauptfenster zurück.  

Nach dem die Farbmessungen durch Betätigen des „OK”-Buttons gestartet wurden, wird der 
Output der ausgewählten Farbparameter in Abhängigkeit von der Zeit dargestellt. Wenn die 
Option „Display No Graphics To Speed Up Data Processing” im Funktionseingabefenster 
markiert wurde, wird der Funktionsoutput lediglich durch Nummern angezeigt, welche 
aktualisiert werden, wenn ein neuer Scan in der Output-Datei gespeichert wird.  

Es befinden sich 6 Buttons am oberen Bildschirmrand: ein „Exit”-Button, ein „Pause/Start“-
Button, ein „Save Reference“-Button, ein „Save Dark“-Button, ein „Info“-Button und ein „Print“-
Button. 

Wenn der rote „Exit“-Button 
betätigt wird, werden die 
Zeitmessungen beendet und 
Hauptfenster und Hauptmenü 
werden wieder aktiviert.  

Der gelbe „Pause“-Button kann 
zum temporären Anhalten der 
Messung verwendet werden. 
Nachdem der „Pause“-Button 
betätigt wurde, stoppt die 
Datenerfassung und die 
Buttonbeschriftung ändert sich zu 
einem grünen „Start“.  

Wenn der „Start“-Button betätigt 
wird, wird die Datenerfassung 
fortgesetzt und die Beschriftung 
zeigt erneut „Pause“ (gelb). 

Die Buttons „Save Reference” und „Save Dark” haben die selbe Funktionalität wie im 
Hauptfenster. 

Der „Info“-Button zeigt das Fenster an, in welchem alle Parameter betrachtet (und nicht 
bearbeitet) werden können, während der Messvorgang läuft.  
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Durch Betätigung des „Print”-Buttons können die dargestellten Grafiken während des 
Durchlaufs gedruckt werden. Ein Fenster wird geöffnet, in dem die Druckoptionen eingestellt 
werden können. Wenn beispielsweise nur einer der vier Graphen in der Abbildung gedruckt 
werden soll, kann dieser Graph mit Hilfe des „Page(s)“-Radiobuttons ausgewählt werden. Alle 
Grafiken werden im Originalmaßstab auf eine separate Seite gedruckt. 

In der rechten oberen Ecke jedes Graphen zeigt eine Farbanzeige die Farbe der gemessenen 
Probe. Wenn der Funktionsoutput ein Farbunterschiedwert ist, wie dE in der Abbildung unten, 
wird eine zweite Farbanzeige für die Referenzfarbe angezeigt. 

Wenn Zeitreihenmessdaten gespeichert wurden, kann die resultierende ASCII-Datei durch die 
Auswahl im Fenster, welches nach Auswahl der Menüoption „Application -> History -> Display 
Saved History Graph“ geöffnet wird, grafisch dargestellt werden.  

Nach dem der „Open”-Button in diesem Fenster betätigt wurde, wird der Funktionsoutput in 
Abhängigkeit von der Zeit dargestellt. X- und Y-Achse werden auf ihre Vollskala zurück-
gesetzt, welche aus den Minimum- und Maximumwerten in der Liste bestimmt wird. 

Zoomfeatures 

In jedem Graphen können die gleichen Zoomfeatures wie im Hauptfenster angewendet 
werden (außer der Skalierung der Y-Achse mit dem Scrollrad der Maus). Dennoch sind 
Zoom-Ins über die X-Achse während einer Messung (mit einer bereits scrollenden X-Achse) 
nicht möglich, da in diesem Fall die X-Achse mit jedem neuen Scan aktualisiert wird. Der 
„Pause“-Button hält den Messvorgang an und kann somit zur Betrachtung eines Auszugs 
verwendet werden. 

Zoom in:. Wählen Sie einen Bereich aus, der auf die Größe des gesamten Graphen 
vergrößert werden soll. Um diesen Bereich auszuwählen, klicken Sie mit der linken Maustaste 
in den weißen Grafikbereich und ziehen Sie ihn nach unten rechts. Nachdem Sie die linke 
Maustaste im Grafik-Display losgelassen haben, werden X- und Y-Achse entsprechend der 
neuen Werte des ausgewählten Bereichs neu skaliert. 

Zoom out: Ziehen Sie mit der linken Maustaste innerhalb des weißen Rechtecks, aber anstatt 
die Maus nach unten zu ziehen, bewegen Sie diese in eine andere Richtung. Nachdem Sie 
die Maustaste losgelassen haben, werden X- und Y-Achse auf ihre voreingestellten 
Ausgangswerte zurückgesetzt. 

Move X-Y: Mit der rechten Maustaste können Sie das gesamte Spektrum nach oben und 
unten sowie nach rechts und links verschieben. 
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4.4 Application: Absolute Irradiance Measurement 

 
 

GetSoft-IRRAD wurde entwickelt, um Online-Messungen der absoluten Bestrahlungsstärke 
mit einem Spektrometersystem von getSpec durchzuführen. Eine kalibrierte Lichtquelle 
(getLight-HAL-CAL oder getLight-DH-CAL) mit bekanntem Energieoutput (in µWatt/cm2/nm) 
wird als Referenz verwendet. Weiterhin kann die Kalibrierung eines Spektrometersystems 
von getSpec in unserem Kalibrierlabor erfolgen, wonach diese Kalibrierung geladen werden 
kann.  

Lichtfarbenparameter werden durch die Chromatizitätskoordinaten x, y und z ausgedrückt. 
Diese Koordinaten erhält man, indem die Summe der Anteile der Tristimuluswerte (X, Y und 
Z) gebildet wird. Die Tristimuluswerte X, Y, Z und die spektrale Bestrahlungsstärke werden in 
einem Wellenlängenbereich von 380 nm bis 780 nm unter Verwendung eines 1 nm-Intervalls 
berechnet. Diese Parameter sowie die Koordinaten u, v und die Farbtemperatur einer 
externen Lichtquelle können in Echtzeit berechnet und dargestellt werden. Auch für LED-
Messungen können relevante Parameter wie dominante Wellenlänge oder Reinheitsgrad 
(purity) berechnet werden.  

Das gleiche Experiment-Setup (Spektrometer mit Lichtwellenleiter und Kosinuskorrektor oder 
Ulbrichtkugel) wird zur Berechnung der photometrischen und/oder radiometrischen 
Parameter des zu messenden Lichts verwendet. Der berechnete Output kann auf drei 
Wegen dargestellt und gespeichert werden: 

o Im Hauptfenster können die Daten als spektrale Bestrahlungsstärke in µWatt/cm2/nm 
verglichen mit der Wellenlänge dargestellt werden. 
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o Die Messergebnisse können auch in einem Bestrahlungsstärkediagramm (Abb. 
oben), welches das Chromatizitätsdiagramm, das Bestrahlungsstärke-Spektrum, das 
Spektrum im Scope-Modus und viele Parameter für Colorimetrie, Photometrie, 
Radiometrie und Peak-Messungen anzeigt. Bis zu 10 verschiedene radiometrische 
Parameter und/oder Wellenlängenbereiche können für die Darstellung ihres Outputs 
ausgewählt werden. 

o Im Modus „Time Measurement” können bis zu 8 Funktionen gleichzeitig in 
Abhängigkeit von der Zeit dargestellt werden. Für jede Funktion kann ein 
verschiedener radiometrischer, photometrischer, Farbkoordinaten- oder Peakoutput-
Parameter und/oder Wellenlängenbereich sowie ein anderer Spektrometerkanal 
ausgewählt werden. 

4.4.1 Hintergrund 

Bevor die Bestrahlungsstärkemessungen begonnen werden können, ist eine 
Intensitätskalibrierung erforderlich. Die Intensitätskalibrierung enthält die Datentransferfunktion 
für jeden Pixel. Die Datentransferfunktion wird für die Konvertierung der Scopedaten (A/D-
Einheiten) in Bestrahlungsdaten (in µWatt/cm2) verwendet. Um die Transferfunktion 
berechnen zu können, muss eine kalibrierte Lichtquelle mit bekannter Leistung (in 
µWatt/cm2/nm) verfügbar sein. 

Wenn die A/D-Einheiten mit aktiver/inaktiver Referenzlichtquelle gespeichert werden, erkennt 
man die Beziehung zwischen A/D-Einheiten und µWatt/cm2: 

??
?

?
??
?

?
? nn

n

darkcalrefcal
Caldata

 

Caldatan = Intensität der kalibrierten Lichtquelle bei Pixel n (in µWatt/cm2) der 
Lampendatei 

refcaln = A/D-Einheiten bei Pixel n, die mit der Referenzlichtquelle (= ON) 
gespeichert wurden 

darkcaln = A/D-Einheiten bei Pixel n, die mit der Referenzlichtquelle (= OFF) 
gespeichert wurden 

Beim Messen der A/D-Einheiten einer anderen Lichtquelle als der kalibrierten (aber mit dem 
gleichen Lichtwellenleiter und Diffuser), kann diese Beziehung zur Messung der Intensität (in 
µWatt/cm2) bei jedem Pixel n verwendet werden. Wenn samplen die gemessene A/D-Einheit 
bei Pixel n ist (bei Betrachtung der Probe-Lichtquelle) und darkn der gemessenen A/D-Einheit 
bei ausgeschalteter Probe-Lichtquelle entspricht, so erhält man für die Gleichung der 
Intensität In (in µWatt/cm2):  

??
?

?
??
?

?
?

?
?

nn

nn
nn darkcalrefcal

darksample
CaldataI *  

Wenn während der Intensitätskalibrierung eine andere Integrationszeit verwendet wurde, 
beispielsweise die Integrationszeit der Probenmessung (z.B. von 2 ms auf 100 ms), muss 
der Gleichung ein Faktor hinzugefügt werden, um diese Veränderung zu kompensieren. Im 
Beispiel ist entspricht der Faktor 100/2 = 50.  
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Wenn die Intensität (in µWatt/cm2) aus dem gemessenen Probenspektrum (in A/D-Einheiten) 
berechnet werden soll, kann dies mit der folgenden Gleichung geschehen: 

factor
darkcalrefcal

darksample
CaldataI

nn

nn
nn ** ??

?

?
??
?

?
?

?
?  

Auf der Grundlage des Bestrahlungsstärkespektrums (in µWatt/cm2) können viele 
Lichtausbeuteparameter (colorimetrisch, photometrisch und radiometrisch) berechnet 
werden.  

Im Folgenden werden kurze Hintergrundinformationen zu den colorimetrischen, 
radiometrischen und photometrischen Parametern aufgeführt. Auch die Definition der 
messbaren Spitzenparameter wird beschrieben.  

Colorimetrie 

Die Farbe von Licht kann durch die Chromatizitätskoordinaten x, y und z ausgedrückt werden. 
Diese Koordinaten erhält man durch die Summenbildung der Anteile der Tristimuluswerte (X, 
Y und Z): 

 

Die Tristimuluswerte X, Y und Z werden berechnet durch: 

 

wobei: 

k  = konstant (= 1/(? y? ) = 0,00934 
I?   = Spektrale Bestrahlungsstärke bei Wellenlänge ?  
x? , y? , z?  = CIE 1931- oder 1964-Standardbetrachtungswert (2- oder 10 Grad-Winkel)  
   bei Wellenlänge ?  

Die Tristimuluswerte X, Y, Z und die spektrale Bestrahlungsstärke werden in einem 
Wellenlängenbereich von 380 nm bis 780 nm unter Verwendung eines 1 nm-Intervalls 
berechnet. 

Die CIE1960 UCS Farbkoordinaten u und v werden wie folgt ermittelt:  

? ?3122
4

???
?

yx
x

u   
? ?3122

6
???

?
yx

y
v  

Die Gleichung, welche für die Berechnung der Farbtemperatur verwendet wird, ist empirisch 
und setzt einen Schwarzkörperstrahler voraus: 

? ?ZYX
X

x
??

?
? ?ZYX

Y
y

??
?

? ?ZYX
Z

z
??

?

?? xIkX **?? ?? yIkY **?? ?? zIkZ **??
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1858,0
332,0

?
??

y
xp

 

³)449(²)3525()3,6823(33,5520 pppaturFarbtemper ???????  

In LED-Messungen werden die dominante Wellenlänge und Reinheit (auch als Helmholtz-
Koordinaten bekannt) oft für die Beschreibung einer Farbe verwendet. Die dominante 
Wellenlänge kann für einen gemessenen Probepunkt S mit Chromatizitätskoordinaten 
(Sx, Sy) durch das Zeichnen einer geraden Linie vom Mittelpunkt im Chromatizitätsdiagramm 
(E mit x = y = 0,333) durch S in Richtung der Flanke des Chromatizitätsdiagramms 
(Spektrum-Ortslinie) berechnet werden. Die Punkte an der Spektrum-Ortslinie entsprechen 
einer Wellenlänge und die Unterbrechung der geraden Linie durch E und S mit der Ortslinie 
heißt dominante Wellenlänge. 

Reinheit (purity) ist die Entfernung vom Mittelpunkt (E) zum Probepunkt (S) geteilt durch 
Entfernung Mittelpunkt (E) bis Spektrum-Ortslinie (DW): 

DWE
SE

Purity
?

?
?  

Die Methode, welche oben beschrieben wird, wird für alle Farben mit einer dominanten 
Wellenlänge von 380 bis 699 nm verwendet. Wenn sich die x, y-Koordinaten in der 
Triangelform befinden, welche von den drei Punkten E, A und B umspannt wird, kann die 
dominante Wellenlänge nicht berechnet werden, da der Unterbrechungspunkt durch E und S 
mit der Spektrum-Ortslinie (zwischen A und B) nicht mit einer Wellenlänge überein stimmt. In 
diesem Fall wird die komplementäre dominante Wellenlänge (CDW) verwendet. Die Linie von 
E durch S wird nach hinten verlängert um die CDW zu bestimmen.  

 

 

E 

S 
DW 

A 

B 
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Spitzenmessungen 

Eine typische spektrale Strahlungsverteilung einer (grünen) 
LED wird in der Abbildung rechts angezeigt. Eine Anzahl von 
Spitzenparametern kann aus diesem Spektrum berechnet 
werden: 

FWHM und Mittlere Wellenlänge (Center Wavelength) 

FWHM einer Spitze entspricht der Bandbreite (in nm), für welche die 
Intensität höher als die Hälfte der maximalen Intensität der Spitze ist. 
Die mittlere Wellenlänge ist die Wellenlänge auf halbem Weg 
zwischen linker und rechter Wellenlänge, bei der die Intensität halb so 
groß wie die maximale Intensität ist. 

Spitzenwellenlänge (Peak Wavelength) 

Wellenlänge bei maximaler spektraler Leistung 

Schwerpunktwellenlänge (Centroid Wavelength) 

Die gesamte spektrale Leistung rechts und links von der Schwerpunktwellenlänge (Integral) 
ist identisch. 

Radiometrie 

Die radiometrischen Parameter können in drei Kategorien zusammengefasst werden: 

o Strahlungsfluss [µWatt]: Der Strahlungsfluss entspricht der gesamten von der Quelle 
in alle Richtungen ausgestrahlten optischen Leistung. Der einfachste Weg, um die 
von einer Quelle ausgestrahlte Leistung zu messen, ist die Messung der Quelle 
innerhalb einer U-Kugel. Das ist bei den meisten LED-Messungen üblich. Weiterhin ist 
es auch möglich, den Fluss einer Quelle durch Messung der Bestrahlungsstärke an 
der Oberfläche des Diffusors (Kosinuskorrektor- oder U-Kugel-Probenport) bei einer 
bestimmten Entfernung von einer Lichtquelle zu bestimmen. Wichtige 
Voraussetzungen sind, dass die Quelle isotrop und die Entfernung zwischen Quelle 
und Diffuser größer als fünfmal die größte Dimension der Quelle sein sollte (Annahme 
Punktquelle). 

o Strahlstärke [µWatt/sr]: Die Strahlstärke entspricht der optischen Leistung pro 
Raumwinkeleinheit. Sie wird zur Quantifizierung der von einer Quelle in eine 
bestimmte Richtung ausgestrahlten optischen Leistung verwendet. Die Strahlstärke 
wird aus der gemessenen Bestrahlungsstärke multipliziert mit dem Quadrat der 
Entfernung zwischen Diffuseroberfläche und Quelle berechnet. Es wird 
vorausgesetzt, dass es sich bei der Quelle um eine Punktquelle handelt. 

o Bestrahlungsstärke [µWatt/cm2]: Bestrahlungsstärke misst die Leistung, die von einer 
Oberfläche aufgenommen wird. 

Eine radiometrische Messung kann mittels verschiedener Messaufbauten erfolgen, 
beispielsweise mit faseroptischem Kosinuskorrektor oder Ulbrichtkugel. Beide Aufbauten 
können verwendet werden, um das an der Diffuseroberfläche (Kosinuskorrektor oder U-
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Kugel-Probeport) aufgenommene Bestrahlungsstärkespektrum in einer bestimmten 
Entfernung von einer Lichtquelle zu messen. Wenn in einer bestimmten Entfernung von der 
Quelle gemessen wird, können der Strahlungsfluss und Strahlstärke wie oben beschrieben 
berechnet werden. 

Wenn eine Lichtquelle innerhalb einer U-Kugel gemessen wird, kann der Strahlungsfluss 
gemessen werden, aber nicht die Strahlungsstärke und Bestrahlungsstärkeparameter. 

Radiometrische Parameter berechnet aus der Strahlungsverteilung 

Die Strahlungsverteilung kann einfach durch Multiplikation der Leistung mit der Integrationszeit 
in eine Energieverteilung konvertiert werden. Das Ergebnis ist der Betrag der Energie, 
welcher während eines Integrationszeitzyklus ausgestrahlt oder empfangen wurde. 

Ein anderer radiometrischer Parameter, welcher aus dem Bestrahlungsstärkespektrum 
berechnet werden kann, ist die Anzahl der Photonen, die an der Oberfläche aufgenommen 
werden. Da die Anzahl der Photonen pro nm (selbst bei geringer Lichtintensität) riesig ist, 
wird die Avogadro-Zahl verwendet, um die Anzahl der Photonen in mol oder wie in unserer 
Applikation in µmols auszudrücken. Die Anzahl der Photonen pro nm können aus der 
wellenlängenabhängigen Photonenergie und der gemessenen absoluten Lichtenergie 
berechnet werden. Eine detaillierte Beschreibung finden Sie auf der folgenden Seite. 

Die Photoneinheits-Verteilung [µmol/(s.m2.nm)] zeigt den aufgenommenen Photonfluss pro 
Quadratmeter an.  

Andere Photoneinheiten, welche hier berechnet werden können, sind: 

o [µmol/(s.nm)] = an Diffuseroberfläche aufgenommener Photondurchfluss 

o [µmol/(m2.nm)] = während eines Integrationszeitzyklus pro Quadratmeter  
aufgenommene Photonen 

o [µmol/nm] = während eines Integrationszeitzyklus auf der Diffuseroberfläche 
aufgenommene Photonen 
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Wie eine Leistungsverteilung [µWatt/(cm2.nm)] in eine Photoneinheiten-Verteilung 
[µMol/(s.m2.nm)] konvertiert wird 

 
Photonenergie E(?) = h.c/?  e 
 
h = Plancksches Wirkungsquantum 6,626 068 76 x10-34 
c = Lichtgeschwindigkeit 2,998 x108 m/s 
?  = Wellenlänge in m 
 
Zum Beispiel ist die Photonenergie bei 250 nm und 1000 nm: 
E(250) = (6,626 x 10-34. 2,998 x 108)/ 250.10-9  = 7,946 x10-19  (Joule/Photon)   (1) 
E(1000)= (6,626 x 10-34. 2,998 x 108)/ 1000.10-9  = 1,986 x10-19  (Joule/Photon)  (2) 
 
1eV = 1,60207 x 10-19 Joule, so gilt für die Photonenergie in eV/Photon: 
E(250) = 7,946 x10-19 /1,60207 x 10-19 = 4,9592 (eV/photon)    (3) 
E(1000)= 1,986 x10-19 /1,60207 x 10-19 = 1,2398 (eV/photon)    (4) 
 
Angenommen, wir messen 20 ?Watt/cm2 bei einer bestimmten Wellenlänge 
 
20 ?Watt/cm2  = 20 ?Joule/s/cm2 = 0.2 Joule/s/m2  

= 0.2/(1,60207 x 10-19 ) eV/s/m2 
= 1,248 . 1018 eV/s/m2       (5) 
 

Mit der bekannten Photonenergie bei 250 nm und 1000 nm von (3) und (4) kann die Anzahl der 
Photonen, die mit 20 ?Watt/cm2 bei 250 nm und bei 1000 nm übereinstimmt, mit (5) berechnet 
werden: 

 
für 250 nm : #Photonen = 1,248 . 1018 / 4,9592 = 2,517 . 1017 Photonen/s/m2 
für 1000 nm  : #Photonen = 1,248 . 1018 / 1,2398 = 1,007 . 1018 Photonen/s/m2 
   
mit 1 mol = 6,02308 x1023 (Avogadro-Zahl)  
1 ?mol = 6,02308 x1017 

 
Für die Anzahl der Photonen, ausgedrückt in ?mol/s/m2 und bei Messung von 20 ?Watt/cm2 bei 
Wellenlänge 250 nm sowie 20 ?Watt/cm2 bei 1000 nm gilt: 
für 250 nm : 2,517 . 1017 / 6,02308 .1017  = 0,418 ?mol/s/m2 
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In der Tabelle unten sind die radiometrischen Parameter aufgelistet, die mit der Software 
getSoft gemessen werden können. Beachten Sie, dass ein Wellenlängenbereich spezifiziert 
werden muss, über den der Parameter-Spektraloutput integriert wird. In der ersten Spalte 
(Hardwaresetup), bezieht sich „innerhalb der U-Kugel” auf Messungen, die mit einer 
Lichtquelle innerhalb einer U-Kugel durchgeführt werden. „Außerhalb der U-Kugel oder KK” 
bezieht sich auf Messungen, die mit einer Lichtquelle in einer bestimmten Entfernung von der 
U-Kugel oder mit einem Kosinuskorrektor (KK) durchgeführt wurden. 

Hardwaresetu
p Parameter Einheit Beschreibung 

Innerhalb der U-
Kugel 

Strahlungsfluss 
(ausgestrahlte 
Leistung) 

µWatt Gesamte von einer Quelle ausgestrahlte 
optische Leistung 

Innerhalb der U-
Kugel 

Ausgestrahlte 
Energie 

µJoule Gesamte von einer Quelle ausgestrahlte 
optische Energie, berechnet durch 
Multiplikation der Leistung mit der 
Integrationszeit  

Außerhalb der 
U-Kugel oder 
KK 

Strahlungsfluss 
(ausgestrahlte 
Leistung) 

µWatt Gesamte von einer Quelle ausgestrahlte 
optische Leistung, berechnet durch 
Multiplikation von Strahlstärke mit dem 
festen Winkel der Lichtquelle 

Außerhalb der 
U-Kugel oder 
KK 

Ausgestrahlte 
Energie  

µJoule Gesamte von einer Quelle ausgestrahlte 
optische Energie, berechnet durch 
Multiplikation der Leistung mit der 
Integrationszeit  

Außerhalb der 
U-Kugel oder 
KK 

Strahlstärke µWatt/sr Optische Leistung pro 
Raumwinkeleinheit, berechnet durch 
Multiplikation von Bestrahlungsstärke und 
Entfernungsquadrat zwischen 
Punktquelle und Diffuseroberfläche  

Außerhalb der 
U-Kugel oder 
KK 

Strahlungsenergie  µJoule/sr Gesamte von einer Quelle ausgestrahlte 
optische Energie, berechnet durch 
Multiplikation der Strahlstärke mit der 
Integrationszeit 

Außerhalb der 
U-Kugel oder 
KK 

Empfangene 
Leistung  

µWatt Auf Diffuseroberfläche aufgenommene 
Leistung 

Außerhalb der 
U-Kugel oder 
KK 

Empfangene 
Energie 

µJoule Auf Diffuseroberfläche aufgenommene 
Energie, berechnet durch Multiplikation 
von Leitung mit Integrationszeit  

Außerhalb der 
U-Kugel oder 
KK 

Bestrahlungsstärke  µWatt/cm2 Pro Quadratzentimeter aufgenommene 
Leistung  

Außerhalb der 
U-Kugel oder 
KK 

Energie/cm2  µJoule/cm
2 

Pro Quadratzentimeter aufgenommene 
Energie, berechnet durch Multiplikation 
der Bestrahlungsstärke mit 
Integrationszeit  
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Außerhalb der 
U-Kugel oder 
KK 

Photonfluss/m2  µMol/(s.m2) Pro Sekunde und pro Quadratmeter 
empfangene Photonen, siehe vorherige 
Seite für Berechnung 

Außerhalb der 
U-Kugel oder 
KK 

Photonfluss µMol/s Pro Sekunde auf der Diffuseroberfläche 
aufgenommene Photonen 

Außerhalb der 
U-Kugel oder 
KK 

Photonen/m2 µMol/m2 Innerhalb eines Integrationszeitzyklus pro 
Quadratmeter aufgenommene Photonen 

Außerhalb der 
U-Kugel oder 
KK 

Photonen µMol Auf der Diffuseroberfläche während eines 
Integrationszeitzyklus aufgenommene 
Photonen 

 

Photometrie 

Photometrie ist die Messung von sichtbarem Licht. Im Gegensatz zur Radiometrie handelt es 
sich hier nicht um eine ausschließlich physikalische Messung. Zur Berechnung bezieht man 
sich auf eine „standardmenschliche” optische Wahrnehmung. Dies wird durch Multiplizieren 
der radiometrischen Daten mit der Lichtausbeute-Kurve (siehe Abb. unten) und der 
Integration des Produkts über den sichtbaren Bereich (380 – 780 nm) erreicht.  

 

Die drei Kategorien, welche für die radiometrischen Parameter definiert wurden, können auch 
für die photometrischen Parameter verwendet werden. 
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o Das photometrische Äquivalent zum Strahlungsfluss/Strahlungsleistung [µWatt] ist 
der Lichtstrom (in Lumen).  

o Das photometrische Äquivalent zur Strahlstärke [µWatt/sr] ist die Lichtstärke in 
Lumen/sr. Diese Einheit ist gleich der Einheit Candela. 

o Das photometrische Äquivalent zur Bestrahlungsstärke [µWatt/cm2] wird 
Beleuchtungsstärke genannt (in Lumen/m²). Diese Einheit ist gleich der Einheit Lux. 

Da die Geometrie der drei Kategorien für Radiometrie und Photometrie identisch ist, kann das 
gleiche über das Hardwaresetup geschrieben werden. Der Strahlungsfluss kann innerhalb 
einer Ulbrichtkugel gemessen werden. Bei Messungen einer Quelle in einer bestimmten 
Entfernung von der Ulbrichtkugel oder dem Kosinuskorrektor, kann der Strahlungsfluss in der 
Annahme, dass es sich um eine isotropische Punktquelle handelt, berechnet werden. Die 
Lichtstärke [Candela] und Beleuchtungsstärke [Lux] einer Quelle kann außerhalb der U-Kugel 
oder mit einem Kosinuskorrektor gemessen werden.  

4.4.2 Schnellstart 

Schnellstart (1): Durchführung von Messungen der absoluten Bestrahlungsstärke 
unter Benutzung einer Kalibrierlampe 

1. Starten Sie getSoft und klicken Sie auf den Button „Start” im Hauptfenster. 

2. Schließen Sie eine Faser an den Spektrometereingangsport an.  

3. Starten Sie die Anwendung „Absolute Irradiance Measurement” im Menü „Application“. 
Betätigen Sie den Button „Perform Intensity Calibration”. 

4. Wählen Sie den zu kalibrierenden Spektrometerkanal und die Kalibrierlampendatei aus. 
Geben Sie den Durchmesser der verwendeten Faser bzw. des verwendeten Kosinus-
korrektors oder des U-Kugel-Probeports ein (beschrieben im Abschnitt „Perform Intensity 
Calibration“). 

5. Schalten Sie die Referenzlichtquelle ein (z.B. getLight-HAL-CAL oder getLight-HAL-CAL-
ISP). Wenn am Ende der Faser ein Kosinuskorrektor verwendet wird, bringen Sie diesen 
direkt an die Referenzlichtquelle an. Wenn eine U-Kugel am Ende der Faser verwendet 
wird, bringen Sie den U-Kugel-Probeport über der Quelle an. 

6. Überprüfen Sie, dass die Kalibrierlampe sich für mindestens 15 Minuten im „ON”-Status 
befunden hat. Klicken Sie dann auf den Button „Start Intensity Calibration”. Versuchen Sie, 
unter Beobachtung des Referenzlichts die Integrationszeit so einzustellen, so das der 
Maximalwert über dem Wellenlängenbereich bei ungefähr 14000 Einheiten liegt. Es ist 
auch möglich, getSoft durch Betätigung des Buttons „?AC“ nach einer geeigneten 
Integrationszeit suchen zu lassen.  

7. Stellen Sie den Glättungsparameter für den verwendeten Faser/Spaltdurchmesser ein, 
um die Glättung zu optimieren. 

8. Wenn ein gut verwertbares Referenzsignal dargestellt wird, klicken Sie den weißen Button 
„Save Reference” im Fenster oben. Eine weiße Linie wird das Referenzspektrum 
markieren. Schalten Sie dann die Kalibrierlampe aus, warten Sie, bis das Spektrum 
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abflacht (nahe dem unteren Ende der Skala) und klicken Sie den schwarzen Button, um 
ein Dunkelspektrum zu speichern. Eine schwarze Linie zeigt dieses Dunkelspektrum an.  

9. Betätigen Sie den Button „Save Intensity Calibration”. Ein Fenster wird geöffnet, in 
welchem die momentanen Einstellungen für diese Intensitätskalibrierung angezeigt 
werden. Wenn die Kalibrierung mit einem Diffuser durchgeführt wurde, werden die 
Intensitätskalibrierdaten in einer ASCII-Datei mit der Erweiterung *.dfr, für blanke Fasern 
mit der Erweiterung *.fbr gespeichert. Der Name der Intensitätskalibrierdatei kann nach 
Betätigen des Buttons „Save As” eingegeben werden. 

Mit USB2-Spektrometern kann die Intensitätskalibrierung auch im EEPROM gespeichert 
werden. Betätigen Sie dazu den „Save to EEPROM“-Button. Schließen Sie mit dem 
„Close“-Button das Fenster. 

10. Wechseln Sie in das Register „Irradiance Chart” um das Hardwaresetup einzugeben und 
die relevanten colorimetrischen, radiometrischen, photometrischen und/oder Spitzen-
parameter auszuwählen (siehe Abschnitt „Irradiance Chart - Settings“). Klicken Sie dann 
auf „OK“. 

11. Messen Sie die Outputparameter im Experiment. Wenn nötig, ändern Sie die 
Integrationszeit, so dass das Maximum im Scope-Modus bei ungefähr 14000 A/D-
Einheiten liegt. Blockieren Sie den Lichtweg zum Spektrometer und speichern Sie ein 
Dunkelspektrum. Wenn die (Be)Strahlungsstärke des zu messenden Lichts in 
Abhängigkeit von der Zeit dargestellt werden soll, klicken Sie die Registerkarte „Time 
measurement“ im Einstellungsfenster (beschrieben in Abschnitt „4.4.6 Time Series 
Measurement“). 

12. Die Intensitätskalibrierung gemäß Punkt 9 kann in zukünftigen Experimenten durch die 
Auswahl der Option „Load Intensity Calibration” geladen werden, wie unter Punkt 2 
beschrieben. Für die USB2-Spektrometer wird die im EEPROM gespeicherte 
Intensitätskalibrierung automatisch während der Initialisierung von getSoft geladen.  

Nachdem eine Intensitätskalibrierung geladen wurde, muss ein Dunkelspektrum 
gespeichert werden, bevor in den Bestrahlungsmodus gewechselt werden kann. 

Schnellstart (2): Messungen der absoluten Bestrahlungsstärke durch Laden einer 
Intensitätskalibrierung  

1. Starten Sie getSoft und klicken Sie den Button „Start” im Hauptfenster. 

2. Schließen Sie die gleiche Faser (und Diffuser oder U-Kugel), die während der zu 
ladenden Intensitätskalibrierung verwendet wurde, an den Spektrometer-Eingansport an. 

3. Starten Sie die Anwendung „Absolute Irradiance Measurement ” in der Menüoption 
„Application“. Ein Fenster wird geöffnet, in dem die Intensitätskalibrierdatei ausgewählt 
werden kann. Wählen Sie die Datei aus und klicken Sie auf den Button „Open“. 

Bei der USB2-Plattform wird die Intensitätskalibrierung im EEPROM gespeichert und 
gleichzeitig mit der getSoft-Initialisierung automatisch geladen. 

4. Wechseln Sie in das Register „Irradiance Chart” um das Hardwaresetup einzugeben und 
die relevanten colorimetrischen, radiometrischen, photometrischen und/oder 
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Spitzenparameter auszuwählen (siehe Abschnitt „4.4.5.1 Irradiance Chart Settings“). 
Klicken Sie dann auf „OK“. 

5. Messen Sie die Outputparameter im Experiment. Wenn nötig, ändern Sie die 
Integrationszeit, so dass das Maximum im Scope-Modus bei ungefähr 14000 A/D-
Einheiten liegt. Blockieren Sie den Lichtweg zum Spektrometer und speichern Sie ein 
Dunkelspektrum. Wenn die (Be)Strahlungsstärke des zu messenden Lichts in 
Abhängigkeit von der Zeit dargestellt werden soll, klicken Sie die Registerkarte „Time 
measurement“ im 
Einstellungsfenster (beschrieben 
in Abschnitt „4.4.6 Time Series“). 

4.4.3 Load Intensity Calibration 

Durch die Auswahl der Menüoption 
„Application -> Absolute Irradiance 
Measurement“ wird ein Fenster 
geöffnet, in welchem die zuvor 
gespeicherte Intensitätskalibrierung 
durch Betätigen des „Load”-Buttons 
geladen werden kann. Die Datei der 
Intensitätskalibrierung enthält jene 
Daten, die für die Konvertierung der 
Scope-Daten in Irradiance-Daten nötig sind. Sollte das Spektrometersystem einen oder 
mehrere Slave-Kanäle besitzen, muss beachtet werden, dass die Kalibrierdaten für jedes 
Spektrometer in einer separaten Datei gespeichert wird. Um Irradiance-Daten mit mehreren 
Spektrometerkanälen gleichzeitig zu messen, müssen zunächst die Kalibrierdateien für jeden 
einzelnen Kanal geladen werden. Nachdem eine Intensitätskalibrierdatei geladen wurde, wird 
ein Graph dargestellt, welcher die Datentransferfunktion für den geladenen Kanal anzeigt. 
Das Bestrahlungsspektrum wird durch Multiplikation der gemessenen Scope-Daten (von 
denen ein gespeichertes Dunkelspektrum subtrahiert wird) mit dieser Datentransferfunktion 
ermittelt.   

Wenn die Intensitätskalibrierung geladen wurde, werden die 
Register „Irradiance Chart” und „Irradiance Time Series” 
aktiviert. Wählt man eines der beiden Register aus, so erhält 
man die Möglichkeit, die Einstellungen für die 
Bestrahlungsdiagramme oder Zeitreihenmessungen. Danach 
können die Messungen durch Betätigen des „OK“-Buttons 
gestartet werden. Bestrahlungsdiagramme und 
Zeitreihenmessungen werden in Abschnitt 4.4.5 und 4.4.6. beschrieben. 
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4.4.4 Perform Intensity Calibration 

Wenn eine kalibrierte Lichtquelle wie getLight-HAL-
CAL oder getLight-DH-CAL zur Verfügung steht, kann 
eine Intensitätskalibrierung durchgeführt werden. 
Durch Auswahl der Menüoption „Application -> 
Absolute Irradiance Measurement” wird ein Fenster 
geöffnet, in dem die Einstellungen für die 
Intensitätskalibrierung angezeigt werden, nachdem 
der Button „Perform Intensity Calibration” betätigt 
wurde.  

Die folgenden Einstellungen müssen vor dem Beginn 
der Intensitätskalibrierung eingegeben werden: 

o Spektrometerkanal  

o Kalibrierlampendatei 

o CC-UV/VIS, Faser oder U-Kugel-
Portdurchmesser 

Für ein Einkanalspektrometer ist der Spektrometerkanal immer der Masterkanal.  

In Multikanalspektrometersystemen kann der Spektrometerkanal, für den die Intensitäts-
kalibrierung durchgeführt werden soll, aus der Liste (Master, Slave1…) ausgewählt werden. 

Kalibrierlampe 

Der Energieleistung (in µWatt/cm²/nm) der verwendeten Kalibrierlampe ist in einer Datei mit 
der Erweiterung *.lmp enthalten. Diese Datei muss mit dem Button „Select“ ausgewählt 
werden.  

Nachdem die Kalibrierdatei ausgewählt wurde, können die Daten durch Betätigen des Buttons 
„View/Edit Lamp Data” eingesehen, bearbeitet und/oder unter einem anderen Dateinamen 
gespeichert werden.  

Ein Fenster wird geöffnet, in dem die Intensitäts- und Wellenlängenwerte für die verwendete 
Lichtquelle vergleichend dargestellt 
werden. Des weiteren wird ein Graph 
angezeigt, welcher die Intensität in 
Abhängigkeit von der Wellenlänge 
darstellt: 

Nach Wunsch können die Daten editiert 
und durch Betätigung des Buttons „Save 
As....“ unter einem anderen Dateinamen 
abgespeichert werden. Bevor die 
geänderten Daten wirksam werden, muss 
der neue Dateiname mit der Option 
„Select lamp” (siehe Abb.) geladen 
werden.  
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CC-UV/VIS, Faser oder Ulbrichtkugel-Probenportdurchmesser 

Das Hardwaresetup, für welches die Kalibrierlampe kalibriert wurde (CC-UV/VIS 
Kosinuskorrektor, blanke Faser oder Integriersphäre), sollte mit dem Hardwaresetup 
übereinstimmen, das während der Intensitätskalibrierung verwendet wird. Der Durchmesser 
des Kosinuskorrektors (3900 µm), der nicht isolierten Faser oder der getSphere (6000, 10000 
oder 15000 µm für entsprechend getSphere-30, getSphere-50 und getSphere-80) muss in 
µm eingegeben werden.   

Es ist wichtig, dass das Hardwaresetup, welches während der Kalibrierung verwendet wird, 
das gleiche Hardwaresetup wie in Bestrahlungsmessungen ist. 

4.4.4.1 Start Intensity Calibration 

Überprüfen Sie, dass die Kalibrierung 
für mindestens 15 Minuten im „ON”-
Status ist und dass die Hardware 
korrekt eingestellt wurde. Klicken Sie 
dann auf den Button „Start Calibration”.  

Im Folgenden werden die Scopedaten 
(A/D-Einheiten) für den ausgewählten 
Spektrometerkanal grafisch dargestellt. 

Stellen Sie den Glättungsparameter 
ein, um die Glättung für den 
verwendeten Faser-/ 
Spaltdurchmesser zu optimieren 
(siehe auch Abschnitt 3.2.3. „Setup 
Menu: Smooting and Spline“). 

Stellen Sie die Integrationszeit so ein, 
dass ein gutes Signal (maximal ca. 
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14000 – 15000 Einheiten) gemessen werden kann. Es ist auch möglich, getSoft nach einer 
optimalen Integrationszeit suchen zu lassen durch Betätigen des Buttons „Autoconfigure 
Integration time (?AC)“. 

Stellen Sie eine hohe Anzahl der zu mittelnden Scans ein, um Rauschen während der 
Kalibrierung zu reduzieren, 

Wenn ein gutes verwertbares Referenzsignal dargestellt wird, klicken Sie den weißen Button 
„Save Reference” im Fenster oben. Eine weiße Linie wird das Referenzspektrum markieren. 
Schalten Sie dann die Kalibrierlampe aus, warten Sie, bis das Spektrum glatt wird (nahe 
unterem Ende der Skala) und klicken Sie den schwarzen Button, um ein Dunkelspektrum zu 
speichern. Eine schwarze Linie zeigt dieses Dunkelspektrum an. 

4.4.4.2 Save Intensity Calibration 

Wenn Referenz- und Dunkeldaten im Fenster oben gespeichert wurden, kann die 
Intensitätskalibrierung durch Betätigung des Buttons „Save Calibration” gespeichert werden. 

Ein Fenster öffnet sich, welches die momentanen Einstellungen dieser Intensitätskalibrierung 
anzeigt. Wenn die Kalibrierung mit einem 
Diffusor durchgeführt wurde, werden die 
Intensitätskalibrierdaten in einer ASCII-Datei 
mit der Erweiterung *.dfr gespeichert, für 
Fasern existiert entsprechend die 
Erweiterung *.fbr. Der Name der 
Intensitätskalibrierung kann nach Betätigen 
des Buttons „Save As” eingegeben werden. 
Bei USB2-Plattform-Spektrometern kann 
die Intensitätskalibrierung durch Betätigen 
des Button „Save to EEPROM“ im 
EEPROM gespeichert werden. 

Die folgenden Daten werden in der 
Intensitätskalibrierdatei gespeichert: 

o Name der Lichtquellen-Kalibrierdatei (*.lmp) 

o Spektrometerkanal (0 = Master, 1 = Slave1 usw.) 

o Integrationszeit in ms 

o Durchmesser der Diffuseroberfläche in µm 

o TOTAL_PIXELS (= 2048 für getSpec-2048)-Werte, welche den dynamischen Bereich 
(Referenzdaten minus Dunkeldaten) für jeden Pixel während der Intensitäts-
kalibrierung geteilt durch die Intensität der verwendeten kalibrierten Lichtquelle. 

o Einstellung für den Glättungsparameter während der Intensitätskalibrierung. 

Nachdem eine Intensitätskalibrierung durchgeführt wurde, wird ein Graph angezeigt, welcher 
die Datentransferfunktion für den Spektrometerkanal darstellt. Das Bestrahlungsspektrum 
wird berechnet, indem die gemessenen Scopedaten (von denen ein gespeichertes 
Dunkelspektrum subtrahiert wird) mit der Datentransferfunktion multipliziert werden.   
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Wenn die Intensitätskalibrierung durchgeführt 
wurde, werden die Register „Irradiance Chart” 
und „Irradiance Time Series” aktiviert. Durch 
Klicken auf eines der beiden Register erhalten 
Sie die Möglichkeit, die Einstellungen für das 
Bestrahlungsdiagramm oder die 
Zeitreihenmessungen zu ändern. Danach 
können die Messungen mit „OK“ gestartet 
werden. Die Einstellungen für 
Bestrahlungsdiagramm und Zeitreihen 
werden in den Abschnitten 4.4.5 und 4.4.6. 
beschrieben. 

4.4.5 Irradiance Chart 

4.4.5.1 Irradiance Chart - Settings 

Nachdem eine Intensitätskalibrierung durchgeführt oder geladen wurde, wird im Fenster 
„Irradiance Settings“ das Register „Bestrahlungsstärkediagramm“ aktiviert. Durch Klicken auf 
das Register werden die Diagrammeinstellungen angezeigt. Die Abbildung rechts zeigt die 
vorgegebene Einstellungen für Spektrometerkanal-, Hardwaresetup-, Parameter-, Grafik- und 
Speichereinstellung. 

Die Einstellungen für den Spektrometerkanal können geändert 
werden, wenn Kalibrierungen für ein Multikanal-Spektrometer-
system durchgeführt oder für mehr als einen Kanal geladen 
wurden. 

Die Einstellung für das Hardwaresetup stellt einen wichtigen 
Parameter dar (siehe Abschnitt „4.4.1 Hintergrund“), da sie die 
radiometrischen und photometrischen Parameter bestimmt, die 
gemessen werden sowie die Art ihrer Berechnung. Wird ein 
getSphere verwendet, ist es wichtig zu wissen, ob die Lichtquelle 
innerhalb oder außerhalb der U-Kugel gemessen wird (wie es mit 
LEDs üblich ist). Diese Einstellung kann nach Betätigen des 
„getSphere“-Buttons und anschließender Auswahl von „inside“ oder 
„outside sphere“ eingegeben werden. 

Die Einstellungen der Parametergruppe bestimmt, welche 
Parameter im Bestrahlungsstärkediagramm angezeigt werden. 
Nach Anklicken einer Gruppe Parameter werden die detaillierten 
Einstellungen für diese Gruppe sichtbar. Eine Beschreibung dieser 
Parameter und ihrer Berechnung finden Sie in Abschnitt „4.4.1 
Hintergrund“. 

In der vorgegebenen Einstellung sind nur die colorimetrischen Parameter aktiviert. 
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Die Parameter, die in der oberen Abbildung aktiviert sind, werden im Bestrahlungsstärke-
diagramm dargestellt. 

Die detaillierte Einstellung für die radiometrischen Parameter wird während der Messung im 
Fenster des Bestrahlungsstärkediagramms vorgenommen. Wenn für das Hardwaresetup 
nicht „Source inside sphere” ausgewählt wurde, können Sie bereits auswählen, ob Sie nur 
radiometrische Parameter an der Diffuseroberfläche messen oder auch die von der Quelle 
ausgestrahlte Kraft und/oder Energie berechnen wollen. Eine wichtige Voraussetzung für die 
Berechnung der ausgestrahlten Kraft und/oder Energie ist eine isotropische punktförmige 
Quelle. 

 
Wenn für das Hardwaresetup „Source inside sphere” ausgewählt wurde, werden die 
detaillierten Einstellungen für die radiometrischen Parameter (ausgestrahlte Leistung in µWatt 
oder ausgestrahlte Energie in µJoule) während der Messung im Fenster des 
Bestrahlungsstärkediagramms vorgenommen. 

Der gleiche Unterschied im Hardwaresetup bestimmt, welche photometrischen Parameter 
gemessen werden können. Wenn für das Hardwaresetup nicht „Source inside sphere” 
ausgewählt wurde, kann die Lichtintensität in Lux gemessen werden. Der Lichtstrom (das 
photometrische Äquivalent der radiometrischen Leistung) kann an der Diffuseroberfläche 
gemessen werden. Es ist jedoch auch möglich zu berechnen, wie viele Lumen durch die 
Quelle ausgestrahlt werden. Eine wichtige Voraussetzung ist eine isotropische punktförmige 
Quelle. In diesem Setup kann auch die Lichtstärke in Candela gemessen werden. Wenn für 
das Hardwaresetup „Source inside sphere” ausgewählt wurde, können nur die von der Quelle 
ausgestrahlten Lumen gemessen werden. 

 
In der Gruppe „Peak Parameters” kann man die folgenden Spitzeninformationen aktivieren 
bzw. deaktivieren: 
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Detaillierte Einstellungen wie Wellenlängenbereich und radiometrischer Outputparameter, für 
den die Spitze/n berechnet wird/werden, können im Fenster des Bestrahlungsstärke-
diagramms vorgenommen werden.  

Die Einstellungen der Grafik bestimmen, welcher Graph im Fenster des Bestrahlungsstärke-
diagramms angezeigt wird. 

Die Speichereinstellungen werden verwendet, um den Namen der Textdatei einzugeben, in 
welche die Ergebnisse der Bestrahlungsstärkediagramm-Messungen gespeichert werden. 
Vorgegeben ist hier der Name „irrchart.txt”. Durch Betätigen des Buttons „Change Output 
File” kann der Dateiname geändert werden.  

Durch die Aktivierung der Option „Save Irradiance Spectrum” 
wird ein vollständiges Bestrahlungsstärke-Spektrum 
zusammen mit Parameterergebnissen gespeichert. Der Name 
der Bestrahlungsstärke-Spektrumdatei beginnt mit dem 
Dateinamen, der eingegeben wurde („irrchart“ in der Abbildung 
rechts) gefolgt von einer Laufnummer und der Erweiterung 
*.irr. Die Bestrahlungsstärke-Spektrumdateien können vom 
Bestrahlungsstärkediagramm-Fenster aus gespeichert und 
geladen werden. 

Wenn alle Einstellungen eingegeben wurden, können die Messungen durch Klicken auf den 
„OK”-Button gestartet werden. Um die richtigen A/D-Einheiten messen zu können (für 
Dunkelspektrum korrigiert), wird eine Warnung angezeigt, wenn ein Dunkelspektrum nicht 
gespeichert wurde. 
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4.4.5.2 Irradiance Chart - Display  

Die Anzeige des Bestrahlungsstärkediagramms stellt die Grafiken und Outputparameter dar, 
die im Einstellungsfenster ausgewählt wurden. Des weiteren können bis zu zehn 
radiometrische Parameter ausgewählt werden, wobei jedem Parameter ein 
anwenderspezifischer Wellenlängenbereich zugewiesen werden kann. Die Messergebnisse 
können gespeichert 
werden und vorher 
gespeicherte Spektren 
können grafisch dargestellt 
und mit dem gemessenen 
Spektrum verglichen 
werden. Die 
Integrationszeit und die 
Anzahl der zu mittelnden 
Scans können geändert 
werden um die A/D-
Einheiten für jede Probe zu 
optimieren.  

Die Abbildung rechts zeigt 
das Ergebnis einer 
typischen LED-Messung 
innerhalb von getSphere.  

Wenn die Lichtquelle 
außerhalb der U-Kugel oder mit einem Kosinuskorrektor gemessen wird und Strahlungsfluss 
[µWatt], Strahlstärke [µWatt/sr], Lichtstrom [Lumen] oder Lichtstärke [Candela] berechnet 
werden müssen, kann die Entfernung [Meter] und die Geometrie der Lampe [Steradianten] 
auch im Bestrahlungsstärkediagramm-Fenster eingegeben werden. Die Geometrie der 
Punktquelle ist auf 4p Steradianten voreingestellt und wird lediglich für die Berechnungen des 
Lichtstroms und des Strahlungsflusses benötigt.  

 
In diesem Abschnitt werden die folgenden Elemente des Bestrahlungsstärkediagramm-
Fensters beschrieben:  

o Hinzufügen/Editieren von radiometrischen Parametern 
o Grafiken 
o Symbolleiste 

Die anderen Outputparameter werden gemäß den Einstellungen im 
Bestrahlungsstärkediagramm-Einstellungsfenster dargestellt. Hintergrundinformationen zu 
allen Outputparametern finden Sie unter Abschnitt „4.4.1 Hintergrund“. 

Hinzufügen/Editieren von radiometrischen Parametern 

Für die Überwachung der radiometrischen Parameter gibt es zwei Möglichkeiten. Erstere 
besteht darin, bis zu zehn verschiedene Parameter oder Wellenlängenbereiche in der 
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Radiometrie-Box rechts im Bestrahlungsstärkediagramm-Fenster zu definieren. Die zweite 
Möglichkeit ist, einen radiometrischen Parameter im Graph auszuwählen, wobei 
anschließend das Spektrum für den ausgewählten Parameter angezeigt wird (siehe 
„Grafiken” unten). 

Um einen Outputparameter in einer der zehn Zeilen der Radiometrie-Box zu definieren, 
doppelklicken Sie einfach auf die Zeile oder betätigen Sie den „Edit”-Button oben und geben 
Sie die Zeilennummer ein. Ein Fenster wird geöffnet, in dem der radiometrische Parameter 
und Wellenlängenbereich spezifiziert werden können.  

Der Wellenlängenbereich ist der Spektralbereich, über den der radiometrische Output 
integriert wird. Wenn man zum Beispiel die UV-C-, UV-B- und UV-A-Wellenlängenbereiche 
auf drei unterschiedlichen Zeilen spezifiziert, kann die Bestrahlungsstärke für diese 
Spektralbereiche gleichzeitig gemessen 
werden (vorausgesetzt, der Spektrometer-
wellenlängenbereich enthält die spezifizierten 
Bereiche und wurde für diese Bereiche auch 
kalibriert). 

Beachten Sie, dass die verfügbaren 
Parameter von den Einstellungen im 
Bestrahlungsstärkediagramm-
Einstellungsfenster abhängig sind. Um 
beispielsweise die Strahlstärke messen zu 
können, sollte die Option „Calculate Power 
and/or Energy emitted by a source” aktiviert 
sein.  

 

Grafiken 

 

  Chromatizitätsdiagramm Radiometrischer Graph   Scopedatengraph 

Das Chromatizitätsdiagramm wird für die Visualisierung der colorimetrischen Messungen 
verwendet. Abhängig davon, was im Bestrahlungsstärkediagramm-Einstellungsfenster 
ausgewählt wurde, stellt es die Ortslinie für die 2- oder 10-Grad-Standardbetrachtung dar. Die 
gemessenen x- und y-Koordinaten werden im Diagramm dargestellt. Eine Linie wird vom 
Mittelpunkt (x = y = 1/3) aus durch die gemessenen x- und y-Werte zur Flanke der Ortslinie, 
welche die dominante Wellenlänge repräsentiert, gezeichnet. 
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Der Scopedatengraph stellt die rohen A/D-Einheiten dar, die vom Spektrometer erhalten 
werden. Mit diesem Graph kann geprüft werden, ob eine gute Integrationszeit eingestellt 

wurde. Wenn die Integrationszeit zu niedrig ist, enthält das 
radiometrische Spektrum Rauschen, wenn die 
Integrationszeit zu hoch eingestellt ist, kann der Spektro-
meterdetektor „gesättigt“ werden. In diesem Fall erscheint 
eine „Saturated“-Kennzeichnung im Scopedatengraph. 

Der radiometrische Graph stellt das Spektrum für den 
ausgewählten radiometrischen Parameter dar. Ähnlich wie 
bei der Auswahl der radiometrischen Parameter in der 
Radiometrie-
Box, sind die 
verfügbaren 
Parameter von 

den Einstellungen im Bestrahlungsstärkediagramm-
Einstellungsfenster abhängig. In der Abbildung 
rechts wird eine LED innerhalb einer U-Kugel 
gemessen, wobei lediglich der Strahlungsfluss 
(ausgestrahlte Leistung in µWatt) und die 
ausgestrahlte Energie während eines 
Integrationszyklus ausgewählt werden können 
(siehe auch radiometrische Tabelle in 4.4.1.). Der ausgewählte Parameter  wird auch zur 
Bestimmung der Spitzen in der Spitzenmessungsbox verwendet.  

Die radiometrischen Spektren können durch Betätigen der Buttons „Save“ und „Open Saved 
Graph“ gespeichert und geladen werden (siehe unten „Symbolleiste“). 

Symbolleiste 

Der Button „Exit” schließt das Bestrahlungsstärkediagramm. Sie kehren nun ins getSoft-
Hauptfenster zurück. 

Der Button „Pause” stoppt die Datenverarbeitung, um einen Speicherauszug vom Spektrum 
und/oder Outputparametern zu ermöglichen. 

Der Button „Info” zeigt Informationen über die aktuellen Einstellungen an (siehe Abb. links). 
Die letzte Zeile in diesem Fenster „Save irradiance spectrum?: Yes” bezieht sich auf die 
Speichereinstellungen (Abschnitt „4.4.5.1 Irradiance Chart Settings“). Wenn diese Option 
aktiviert ist, werden alle (dargestellten) Parameter (hier in „irrchart2.txt“) und das Spektrum für 
den ausgewählten Parameter im radiometrischen Graph in „irrchart2xxxx.irr“ gespeichert, 
wobei xxxx die Laufnummer repräsentiert. 

Wenn die Option „Save irradiance spectrum” nicht aktiviert ist, werden lediglich die 
dargestellten 
Outputparameter 
gespeichert. 

Durch Betätigen des 
(schwarzen) Buttons 
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„Save Dark” wird ein neues Dunkelspektrum gespeichert. Es wird 
empfohlen, ein neues Dunkelspektrum nach jeder Änderung der 
Integrationszeit zu speichern. Durch Betätigen des Buttons „Save Data“ 
werden die gemessenen Daten der Textdatei hinzugefügt. Ein 
Kommentar des Nutzers kann den gespeicherten Daten beigefügt 
werden. Wenn ein radiometrisches Spektrum mit Outputparametern gespeichert wurde, wird 
der Name dieser Datei auch in der Textdatei gespeichert.  

Der Button „Display Saved Graph” kann betätigt werden, um ein gespeichertes 
radiometrisches Spektrum zu laden. Im offenen Dateifenster werden die gespeicherten 
radiometrischen Spektren aufgelistet. Durch einmaliges Klicken auf einen Dateinamen wird 
der Kommentar zu dieser Datei im Graph angezeigt. Durch einen Doppelklick auf den 
Dateinamen oder mittels dem „Open“-Button wird das radiometrische Spektrum angezeigt. 
Das kann für einen zweiten Dateinamen wiederholt werden, was einen grafischen Vergleich 
des Outputs beider Spektren ermöglicht. Das online gemessene Spektrum wird im gleichen 
Graph dargestellt und kann auch mit vorher gespeicherten Spektren verglichen werden.  

 
 

 

 

Der Dateiname und die Kommentare erscheinen oberhalb des Graphen. Die Textfarben 
entsprechen den Farben, mit denen die Spektren gezeichnet wurden. Durch Klicken auf den 
Dateinamen (blau oder grün) mit der rechten Maustaste wird ein Menü für dieses 
radiometrische Spektrum angezeigt, welches die Menüoptionen in der Abbildung rechts 
enthält.  

Die Menüoption „Show Info” zeigt die Hardwareeinstellungen, Messparameter und 
Speichereinstellungen für das Spektrum an. 

Die Messparameter zeigen die Einheit der Intensität 
des angezeigten gespeicherten Spektrums an. Dies 
kann eine andere Einheit als die für die online 
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gemessenen Spektren ausgewählte sein. Wenn zwei gespeicherte Spektren grafisch 
miteinander verglichen werden, beachten Sie bitte auch, dass beide in derselben 
radiometrischen Einheit abgespeichert wurden. 

Die anderen Menüoptionen „Convert to ASCII” und „Convert to Excel” im Popup-Fenster 
können benutzt werden, um die Daten von der (binären) Datei mit der Erweiterung *.IRR in 
eine Textdatei (*.txt) oder Excel-Datei  (*.xls) zu exportieren.  

Die Menüoption „Remove from Chart” entfernt das gespeicherte Spektrum. 

Auf der rechten Seite der Button-Leiste kann die Integrationszeit und die Anzahl der zu 
mittelnden Scans geändert werden. Der Button „Auto Configure Integration time” kann benutzt 
werden, um getSpec nach einer Integrationszeit suchen zu lassen, bei welcher die maximale 
Ausgabe im Scope-Modus (A/D-Einheiten) ungefähr 14500 Einheiten beträgt. Vergessen Sie 
nicht, ein neues Dunkelspektrum zu speichern (schwarzer Button), nachdem die 
Integrationszeit geändert wurde. 

4.4.6 Time Series Measurement 

Nachdem eine Kalibrierung der Intensität durchgeführt oder geladen wurde, wird das Register 
„Irradiance Time Series” im Fenster „Irradiance Settings“ verfügbar. Durch das Klicken auf 
das Register werden die Einstellungen für die Irradiance-Zeitreihe angezeigt.  

Mit Zeitreihenmessungen der Bestrahlung können bis zu 8 radiometrische Parameter 
gleichzeitig in einem Graphen in Abhängigkeit von der Zeit verfolgt werden. Die Funktionen 1 
bis 8 können durch Anklicken des entsprechenden Registers im Fenster Zeitreihen-
Einstellungen ausgewählt werden. Des Weiteren kann eine Anzahl grundlegender Parameter 
funktionsunabhängig eingegeben werden. Folgende Eigenschaften können separat für alle 
Funktionen 1 bis 8 eingestellt werden: 

 

  

 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 104 

 

 

…more than spectroscopy! 

 

o Funktion aktivieren/deaktivieren. Die radiometrischen Parameter können nach 
dem Betätigen des Buttons „Enable“ eingestellt werden. 

o Hardwaresetup. Die Hardwaresetup-Einstellung ist ein wichtiger Parameter, da er, 
wie im Abschnitt „4.4.1 Hintergrund“ beschrieben, die radiometrischen und 
photometrischen Kenngrößen, die gemessen werden, und die Art der Berechnung 
bestimmt. Wenn getSphere verwendet wird, ist es wichtig zu wissen, ob die 
Lichtquelle innerhalb (wie üblich bei LEDs) oder außerhalb der U-Kugel gemessen 
wird. Diese Einstellung kann nach Betätigen des Buttons „getSphere“ (Auswahl 
„Innerhalb“/„Außerhalb der Sphäre”) eingegeben werden. 

o Spektrometerkanal. Wenn das Spektrometersystem einen oder mehrere Slave-
Spektrometerkanäle enthält und auch eine Intensitätskalibrierung durchgeführt oder 
geladen wurde, kann der Spektrometerkanal, auf welchem der Outputparameter 
gemessen wird, im Auswahlfenster links oben ausgewählt werden (voreingestellt ist 
der Masterkanal). 

o Parameter. Die Anzahl der verfügbaren Parameter und der Weg, wie sie berechnet 
werden, sind vom Hardwaresetup abhängig. Die Abbildung oben zeigt die 
Einstellungen, die verfügbar sind, wenn mit einem Kosinuskorrektor oder einer U-
Kugel bei einer bestimmten Entfernung zur Lichtquelle gemessen wird. Für jede 
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Funktion F1...F8 kann einer der 35 verfügbaren Parameter ausgewählt werden. Im 
Abschnitt 4.4.1 werden die Hintergrundinformationen für die Parameter geliefert.  

Die colorimetrischen Parameter können mit Hilfe des 2-Grad-Standardbetrachtungs-
wertes oder mittels 10 Grad berechnet werden. Wenn einer der radiometrischen 
Parameter ausgewählt ist, muss der Wellenlängenbereich spezifiziert werden. Der 
Wellenlängenbereich ist der Spektralbereich, über den der radiometrische Output 
integriert wird. Wenn die Quelle nicht innerhalb einer U-Kugel liegt, können die 
Strahlungsintensität [µWatts/sr] und Strahlungsenergie [µJoule/sr] berechnet werden, 
wenn die Entfernung der Quelle zur Diffuseroberfläche definiert wurde. Strahlungs-
fluss (ausgestrahlte µWatt) und ausgestrahlte Energie [µJoule e.] können berechnet 
werden, wenn die Geometrie der Lampe [Steradianten] spezifiziert wurde. Entfernung 
und Geometrie können berechnet werden, wenn der Parameter ausgewählt wurde, für 
den diese Dateneingaben relevant sind. Wenn einer der Spitzenparameter ausgewählt 
wurde, muss der Wellenlängenbereich eingegeben werde, über den die (höchste) 
Spitze berechnet wird. Weiterhin sollte der radiometrische Parameter spezifiziert 
werden, um einen Spitzenparameter zu bestimmen. Photometrische Parameter 
benötigen keinen Wellenlängenbereich, da für diese Parameter immer der Bereich 
von 380 bis 780 nm gilt. Dennoch müssen die Geometrie (für die ausgestrahlten 
Lumen) und Entfernung (für die ausgestrahlten Lumen und Candela) spezifiziert 
werden, wenn die ausgestrahlten Lumen und Candela die photometrischen 
Äquivalente von Strahlungsfluss und Strahlstärke sind und es der Fall sein sollte, dass 
die Quelle nicht innerhalb einer U-Kugel gemessen wird. Wenn eine Quelle innerhalb 
einer U-Kugel gemessen wird, sind die radiometrischen Parameter, die gemessen 
werden können, auf den Strahlungsfluss (in ausgestrahlten µWatt) und die 
ausgestrahlte Energie (ausgestrahlte µJoule.) beschränkt und der photometrische 
Parameter, der in diesem Hardwaresetup gemessen werden kann, ist der 
ausgestrahlte Lumenbetrag. 

o Funktionsabbildungseinstellungen. Die Parameter, die in der Funktion eingestellt 
sind, können grafisch in Abhängigkeit von der Zeit dargestellt werden. Der Zeitbetrag, 
welcher auf der X-Achse dargestellt wird, kann manuell unter den X-
Achseneinstellungen bestimmt werden. Die Y-Achse kann für einen festgelegten 
Bereich oder auf Autoskalierung festgelegt werden. Die Option „Autoscale” setzt die Y-
Achse auf die minimalen und maximalen Funktionswerte, welche in der Liste der 
gemessenen Datenpunkte enthalten sind.   

Funktionsunabhängige Parameter 

 
 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 106 

 

 

…more than spectroscopy! 

Funktionsunabhängige Parameter – Display no graphics to speed up data processing 

Unterhalb der Register für die Funktionsdefinition kann eine Option aktiviert/deaktiviert werden, 
welche die Datenverarbeitung dadurch beschleunigt, dass sie die grafische Darstellung von 
Grafiken während den Messungen unterbindet. Wenn eine Applikation schnelle 
Datenverarbeitung erfordert (z.B. mehr als 10 Scans pro Sekunde), sollte diese Option 
aktiviert werden. Wenn sie in einer Outputdatei gespeichert wurden, können die Daten 
grafisch dargestellt werden, nachdem die Zeitreihenmessung abgeschlossen ist 
(beschrieben in Abschnitt „4.1.3 History Application - Display Saved History Graph“). 

Funktionsunabhängige Parameter - Save Function Output 

Die Ergebnisse einer Zeitreihenmessung werden in einer ASCII-Datei gespeichert, wenn der 
Radiobutton „Save Function Output” ausgewählt wurde. Eine Anzahl von Sekunden zwischen 
der Speicherung können für die Datenreduzierung eingegeben werden, sollten Messungen 
über lange Zeiträume erfolgen. Die Eingabe des Wertes „0“ veranlasst die Speicherung jedes 
Scans. Der Name der Datei, in welcher die Daten gespeichert werden, kann durch Betätigen 
des Buttons „Change Output File…” geändert werden.  

Die letzte Option in der „Save Function Output”-Box aktiviert/deaktiviert die Erstellung einer 
Backupdatei während der Messungen. Wenn diese Option aktiviert wurde, erstellt getSoft 
eine Backupdatei mit dem selben Namen bis auf die Erweiterung *.bak (auch in ASCII). Diese 
Backupdatei wird nach jedem Scan aktualisiert und kann im Falle einer fehlerhaften 
Speicherung (z.B. Stromversorgungsstörung während einer Messung) unter dem 
ausgewählten Dateinamen verwendet werden. 

Buttons „Save ICF…/Load ICF…” 

GetSoft speichert automatisch alle Parameter (Funktionsdefinition, Speicheroptionen) in der 
Datei „irrtime62.ini” und stellt diese Parameter beim nächsten Start von getSoft wieder her. 
Mit den Buttons „Save ICF…” und „Load ICF…” können auch Parameter in einer *.icf -Datei 
gespeichert und auch geladen werden. Mit dieser Option kann für jedes Experiment eine 
verschiedene *.icf -Datei gespeichert werden, so dass die Einstellung das nächste Mal bei 
Bedarf geladen werden kann.  

Nach der Definition von einer oder mehr Funktionen, kann der „OK”-Button zum Starten der 
Messung betätigt werden. Wird der „Cancel“-Button betätigt, verlassen Sie das Fenster und 
kehren Sie in das getSoft-Hauptfenster zurück.  

Nachdem die Farbmessungen durch Betätigen des „OK”-Buttons gestartet wurden, wird der 
Output der ausgewählten Farbparameter in Abhängigkeit von der Zeit dargestellt. Wenn die 
Option „Display No Graphics To Speed Up Data Processing” im Funktionseingabefenster 
markiert wurde, wird der Funktionsoutput lediglich durch Nummern angezeigt, welche 
aktualisiert werden, wenn ein neuer Scan in der Output-Datei gespeichert wird. 

Es befinden sich 6 Buttons am oberen Bildschirmrand (siehe Abb. unten): ein „Exit”-Button, 
ein „Pause/Start“-Button, ein „Save Reference“-Button, ein „Save Dark“-Button, ein „Info“-
Button und ein „Print“- Button.  

Wenn der rote „Exit“-Button betätigt wird, werden die Zeitmessungen beendet und 
Hauptfenster und Hauptmenü werden wieder aktiviert. Der gelbe „Pause“-Button kann zum 
temporären Anhalten der Messung verwendet werden. Nachdem der „Pause“-Button betätigt 
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wurde, stoppt die Datenerfassung und die Buttonbeschriftung ändert sich zu einem grünen 
„Start“. Wenn der „Start“-Button betätigt wird, wird die Datenerfassung fortgesetzt und die 
Beschriftung zeigt erneut „Pause“ (gelb). 

Die Buttons „Save 
Reference” und 
„Save Dark” besitzen 
die gleiche Funktion 
wie im Hauptfenster. 

Der „Info”-Button 
zeigt das Fenster 
„Function Entry”, in 
dem alle Parameter 
betrachtet (und nicht 
bearbeitet) werden 
können während die 
Messung läuft. 

Durch Betätigung 
des „Print”-Buttons 
können die 
dargestellten 
Grafiken während 
des Durchlaufs 
gedruckt werden. Ein 
Fenster wird geöffnet, in dem die Druckoptionen eingestellt werden können. Wenn 
beispielsweise nur einer der vier in der Abbildung rechts gedruckt werden soll, kann dieser 
Graph mit Hilfe des „Page(s)“-Radiobuttons ausgewählt werden. Alle Grafiken werden im 
Originalmaßstab auf eine separate Seite gedruckt. 

Wenn Zeitreihenmessdaten gespeichert wurden kann die resultierende ASCII-Datei durch die 
Auswahl im Fenster, welches nach Auswahl der Menüoption „Application -> History -> Display 
Saved History Graph“ geöffnet wird, grafisch dargestellt werden. 

Nachdem der „Open”-Button in diesem Fenster betätigt wurde, wird der Funktionsoutput in 
Abhängigkeit von der Zeit dargestellt. X- und Y-Achse werden auf ihre Vollskala 
zurückgesetzt, welche aus den Minimum- und Maximumwerten in der Liste bestimmt wird. 

Zoomfeatures 

In jedem Graphen können die gleichen Zoomfeatures wie im Hauptfenster angewendet 
werden (außer die Skalierung der Y-Achse mit dem Scrollrad der Maus). Dennoch sind 
Zoom-Ins über die X-Achse während einer Messung (mit einer bereits scrollenden X-Achse) 
nicht möglich, da in diesem Fall die X-Achse mit jedem neuen Scan aktualisiert wird. Der 
„Pause“-Button hält den Messvorgang an und kann somit zur Betrachtung eines Auszugs 
verwendet werden. 

Zoom out: Ziehen Sie mit der linken Maustaste innerhalb des weißen Rechtecks, aber anstatt 
die Maus nach unten zu ziehen, bewegen Sie sie in eine andere Richtung. Nachdem Sie die 



 

 
info@getSpec.com 

 
Tel. : +49 (0) 351 871 8423   Tél. : +33 (0) 4 72 80 82 02   Tel. : +49 (0) 231 974 2285   
Fax : +49 (0) 351 871 8465   Fax : +33 (0) 4 72 80 82 43   Fax : +49 (0) 231 974 2286 
             
    

• Dresden • Lyon • Dortmund • Sofia 
Seite 108 

 

 

…more than spectroscopy! 

Maustaste losgelassen haben, werden X- und Y-Achse auf ihre voreingestellten 
Ausgangswerte zurückgesetzt. 

X-Y-Bewegung: Mit der rechten Maustaste können Sie das gesamte Spektrum nach oben 
und unten sowie nach rechts und links verschieben. 

4.5 Application: Excel Output 

getSoft XLS ist eine Erweiterungsanwendung, welche getSoft Full die Ausgabe von History-
Channel-Daten und/oder kompletten Spektren zu Microsoft Excel ermöglicht. 

Die Erweiterungsanwendung verwendet die OLE-Automation, eine Technologie, die getSoft 
befähigt, Excel zu steuern, Tabellenblätter zu öffnen bzw. Daten in Zellen zu kopieren. Durch 
die moderne Hardware ist es möglich, die gesamten spektralen Daten von 2048 Pixeln in 
weniger als 50 msec zu Excel zu übertragen.  

4.5.1 Quelldaten auswählen 

Neben der Aktivierung des Excel-Output 
müssen Sie Ihre Quelldaten auswählen. 

Dies geschieht auf dem gleichen Wege 
wie ohne die Option Excel-Output – mit 
den Eingangs-Screens, die Sie benutzen, 
um die History-Channel-Einstellungen 
festzulegen und den Zeitreihen in der 
Farb- und Bestrahlungsapplikationen. 

Der einzige Unterschied ist, das Feld 
„Save Function Output“, welches von der 
Option Excel-Output genutzt wird. Dieser 
Bestandteil wurde durch ein separates 
Fenster ersetzt, welches näher unter 
„Einstellungen” beschrieben wird. 

4.5.2 Excel-Output aktivieren 

Aktivieren Sie die Option durch 
Auswahl von „Application -> Excel 
Output -> Enable“. 

Ein Häkchen erscheint vor dem 
Menüeintrag „Enable“ um den Status 
der Option anzuzeigen. 

4.5.3 Einstellungen 

getSoft wird die Daten auf drei 
unterschiedlich formatierte 
Arbeitsblätter schreiben. Dies hängt 
von den Vorgaben des Nutzers in der 
History-Channel-Funktionseingabe 
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und im Einstellungsfenster ab. 

Sie gelangen in das Einstellungsfenster durch die Auswahl von „Application -> Excel Output -
> Settings“. 

Wählen Sie zunächst den von Ihnen gewünschten Modus aus. 

Export-Modus 

Sie können den Export-Modus durch Betätigen des obersten Radiobuttons auswählen. In 
diesem Modus wird eine vordefinierte Anzahl von Scans den Arbeitsblättern zugewiesen, die 
Excel neu öffnet. Abhängig von ihrer Auswahl der History-Channels wird eine von zwei (oder 
auch beide) Formatformen der Arbeitsblätter von Excel geöffnet. 

Wenn Sie die üblichen History-Channels ohne „View Spectrum“ auswählen, wird das 
Arbeitsblatt horizontal formatiert, wobei das Programm je eine neue Zeile für jede 
dokumentierte Messung hinzufügt. 

 

 
 

 

Das Blatt erhält den Namen „getSoft Data“, die Spalten enthalten folgende Daten: 

Spalte A enthält einen Wert für Datum/Zeit, formatiert als „dd:mm:yyyy hh:mm:ss“. 
Dies ist ein Gleitkommawert, in welchem die Tagesnummerierung, welche beim 1. Januar 
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1990 mit Tag 1 beginnt, der ganzzahlige Bestandteil ist. Der gebrochene Teil repräsentiert 
einen dezimalen Zeitwert, wobei 0.5 12:00 Uhr mittags und 0.75 18:00 Uhr entspricht. Somit 
können Unterschiede in Datum/Zeit einfach durch Subtrahieren von Werten berechnet 
werden, was in der Textdarstellung nicht funktionieren würde. 

Spalte B enthält einen Zeitwert, welcher die verstrichenen Millisekunden seit 0:00 Uhr 
repräsentiert. Dieser Wert besitzt jedoch nicht die Auflösung von einer Millisekunde. Obwohl 
Windows kein Echtzeitbetriebssystem ist, kann der Zeitwert als relativ genauer Indikator für 
die zwischen zwei Scans verstrichene Zeit genutzt werden. 

Die Spalten C bis J enthalten 8 verschiedene History-Channel-Werte. Für nicht ausgewählte 
History-Channels wird eine „0“ im Blatt eingefügt. 

Wenn Sie „View Spectrum“ in ihrer Wahl der History-Channels ausgewählt haben, wird das 
Blatt vertikal formatiert. Da in Excel lediglich 256 Spalten pro Blatt möglich sind, ist es nötig, 
ein Spektrum (welches mehr als 200 Pixel aufnehmen kann) in eine Spalte anstelle in eine 
Zeile zu schreiben und Spalten hinzuzufügen, wenn die Zeit verstreicht. 

 

 
 
Da ein Maximum von 256 Spalten pro Blatt existiert, wird nach jeder 256. Spalte („IV“) ein 
neues Blatt hinzugefügt. 

Das erste Blatt erhält den Namen „F1“ für den History-Channel 1, das zweite „F2“ für History-
Channel 2 usw. Wenn außerdem noch zusätzliche Blätter hinzugefügt werden, wird der 
Name erweitert, wie beispielsweise F1_01, F1_02 usw.. 

Wenn der Funktionstyp „View Spectrum” für mehr als eine History-Channel-Funktion (z.B. 
Master-Kanal für F1, Slave1-Kanal für F2) ausgewählt wurde, dann sind die verschiedenen 
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History-Channel-Blätter (mit Namen F1 und F2) in verschiedenen Arbeitsmappen lokalisiert 
und müssen unter verschiedenen Dateinamen abgespeichert werden. Dies trifft auch auf das 
Blatt mit 8 History-Channel-Werten zu, was im vorangegangenen Abschnitt beschrieben 
wurde. 

Die Spalte A des ersten Blatts enthält die Wellenlängenskala. Der Wellenlängenbereich 
entspricht dem Bereich, der in den History-Channel-Funktionen festgelegt ist.  

In der unteren linken Hälfte des Einstellungsfensters kann die Anzahl der Scans, die nach 
Excel exportiert werden sollen und das Zeitintervall zwischen zwei Scans, das Sie festlegen 
möchten, eingegeben werden. 

Vorgegeben sind 1000 Scans und kein Intervall um schnellstmöglich zu exportieren. 

Stetiger Modus 

Sie können den stetigen Modus durch die Betätigung des unteren Radiobuttons einstellen. In 
diesem Modus werden die Daten auf ein einzelnes Blatt geschrieben, jeder Scan 
überschreibt den vorherigen. 

Im unteren rechten Teil des Einstellungsfensters können Sie die Arbeitsmappe auswählen, 
welcher das aktuelle Blatt angehören soll. Dabei wird Ihnen ermöglicht, Ihre eigenen 
Berechnungen und Graphen an aktuellen Daten von getSoft anzuwenden. 

Betätigen Sie den Button „Select File”, um die Arbeitsmappe auszuwählen. Bitte speichern 
Sie eine leere Arbeitsmappe, wenn Sie keine ältere zur Verfügung haben. 
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GetSoft wird überprüfen, ob ein Blatt namens „getSoft-Daten” vorhanden ist und fügt dieses 
Blatt hinzu, sollte es nicht vorhanden sein. Auf diesem Wege können Verbindungen zu 
diesem Blatt zwischen verschiedenen Mappen erhalten bleiben. 

Das Blatt enthält folgende Daten an festgelegten Positionen: 

A3  : Datums- / Zeit-Stempel 

Dies ist ein Gleitkommawert, in welchem die Tagesnummerierung, welche beim 1. Januar 
1990 mit Tag 1 beginnt, der ganzzahlige Bestandteil ist. Der gebrochene Teil repräsentiert 
einen dezimalen Zeitwert, wobei 0.5 12:00 Uhr mittags und 0.75 18:00 Uhr entspricht. Somit 
können Unterschiede in Datum/Zeit einfach durch Subtrahieren von Werten berechnet 
werden, was in der Textdarstellung nicht funktionieren würde. 

B3  : Zeit in Millisekunden nach 0:00 Uhr 

Dieser Wert besitzt jedoch nicht die Auflösung von einer Millisekunde. Obwohl Windows kein 
Echtzeitbetriebssystem ist, kann der Zeitwert als relativ genauer Indikator für die zwischen 
zwei Scans verstrichene Zeit genutzt werden. 

C5-C*** : Wellenlängenskala (in nm) für Spektrum des ersten History-Channel 

D3  : Wert für den ersten History-Channel (0 falls Spektrum ausgewählt) 

D5-D*** : Spektrum für den ersten History-Channel  

E5-E*** : Wellenlängenskala (in nm) für zweites History-Channel-Spektrum 

    (leer, falls kein Spektrum ausgewählt) 

F3  : Wert für den zweiten History-Channel  

F5-F*** : Spektrum für den zweiten History-Channel 

    (leer, falls kein Spektrum ausgewählt) 

etc.  

*** : hängt vom ausgewählten Wellenlängenbereich ab. 

4.5.4 Ausgabe Start 

Die Ausgabe wird auf dem gewohnten Weg gestartet mit 
“Application -> History -> Start Measuring”. 

Sie können alternativ die entsprechenden Buttons in der 
Symbolleiste benutzen. 

Bitte nehmen Sie keine großen Änderungen am Arbeitsblatt 
vor, während Daten übertragen werden. Sollte Excel zu 
beschäftigt sein, erscheint eine Fehlermeldung “Call was rejected by callee“. 

Die Bewegung des Arbeitsblatts allein sollte keine Probleme verursachen. 

Speichern Sie alle Änderungen an ihrem Arbeitsblatt vor dem Transfer zu Excel. Sie müssen 
weder Arbeitsblatt noch Excel schließen. 
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4.5.5 Ausgabe stoppen 

Wenn Sie den Transfer zu Excel stoppen möchten, wechseln Sie in das getSoft-Fenster und 
drücken Sie „Exit”. Es kann einige Sekunden dauern, bis die Buttons erscheinen. 

 

 
 
Excel wird nicht von getSoft geschlossen. Speichern Sie ihre Arbeiten und schließen Sie 
Excel genau so, wie Sie es im Normalfall nach der manuellen Arbeit mit Excel tun würden. 

Wir haben ein Beispielarbeitsblatt mit dem Namen „Continuous.xls” beigefügt, welches die 
Verbindung zum getSoft-Datenblatt demonstrieren soll. In diesem Fall wurden für die Spalten 
der Kanäle 1 und 2 zwei Graphen gezeichnet. Der Graph und die Daten werden während des 
Transfers zu Excel stetig aktualisiert. 
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4.5.6 Einschränkungen und Optimierung 

Da alle Scans im Speicher abgelegt werden, kann es schnell passieren, dass der interne 
Speicher im Export-Modus mit Scans überladen wird. Deswegen wurde ein Limit für die in 
Excel abgelegten Scans beigefügt. Bevor ein Blatt hinzugefügt wird, wird bestimmt, wie viel 
Speicher Excel gerade belegt. Wenn dieser Betrag größer als die Hälfte des Gerätespeichers 
ist, wird die Ausgabe zu Excel gestoppt. 

Bei einem 128 MB-Gerät entspricht dies 7 bis 8 vollständigen Arbeitsblättern mit 256 Spalten 
und 2000 Zeilen, ungefähr 2000 kompletten Scans. Wenn Sie der Wellenlänge ein Limit 
zuweisen, wird ihre Reihe von Scans entsprechend vergrößern. Natürlich hilft eine RAM-
Erweiterung Ihres Gerätes, das Limit zu erhöhen.  

Wir haben allerdings Grenzen des von Excel nutzbaren Speichers beobachtet. Es scheint  
ein internes Limit zu existieren, welches erreicht wird, bevor der Speicherplatz zu Ende geht. 

In einem Gerät mit 512 MB entspricht das Limit ungefähr 16 Arbeitsblättern mit 200 
vollständigen Pixel-Spektren. Danach zeigt Excel eine „Out of Memory“-Nachricht an und ist 
nicht mehr funktionsfähig. Zum Beispiel können Sie nun ihre Daten nicht mehr auf Diskette 
speichern. Dies ist nur bei Geräten mit großem Speicher (256 MB, 512 MB) unproblematisch. 

Für maximale Geschwindigkeit ist es wichtig, nach Excel zu wechseln. Wenn Sie in getSoft 
arbeiten, wird Windows die Priorität für Excel herabsetzen. Sie können dies anhand des 
Fortschrittbalkens in der linken unteren Ecke ihres Arbeitsblattes prüfen. 
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4.6 Chemometrie 

GetSoft-Chem wurde entwickelt, um Konzentrationsmessungen online mit einem 
Spektrometersystem zu ermöglichen. Nach dem Lambert-Beer-Gesetz existiert ein lineares 
Verhältnis zwischen Absorption und Konzentration. 

lcA ??? ?  

Hier entspricht A der Absorption (oder Extinktion), e dem Extinktionskoeffizienten des 
Präparats/Gemischs, welches gemessen werden soll, c der Konzentration und I dem 
Lichtweg. 

In der Praxis ist dieses Verhältnis nur für relativ geringe Absorptionslevels (angenommen 
kleiner 2) anwendbar. Die Wellenlänge, bei welcher die Absorption gemessen wird, muss 
natürlich konstant gehalten werden. 

Um Konzentrationsmessungen aufzunehmen, benötigen Sie ein Spektrometer entweder mit 
einem Küvettenhalter oder eine Tauchsonde und eine geeignete Lichtquelle. 

Wenn Sie Küvetten verwenden, bedenken Sie, dass Glasküvetten UV-Licht absorbieren. 
Wenn sich die von Ihnen verwendete Wellenlänge im UV-Bereich befindet, benutzen Sie 
stattdessen Küvetten aus Quarz oder Polystyrol. 

GetSoft-Chem kann die errechnete Konzentration auf zwei Wegen darstellen und speichern: 

o Die Konzentration kann für bis zu 8 Spektrometerkanäle in einem separaten Fenster 
online angezeigt werden. 

o Es ist möglich, bis zu 8 History-Channels auswählen, welche die Werte für die 
Konzentration in Abhängigkeit von der Zeit anzeigen und speichern können. Diese 
Applikation kann mit Excel und Prozesssteuerungsanwendungen kombiniert werden. 

4.6.1 Schnellstart: Wie man Konzentrationsmessungen mit getSoft-Chem durchführt 

1. Starten Sie die getSoft-Software und klicken Sie den Button „Start” im Hauptfenster. 

2. Bereiten Sie das Absorptionsexperiment mit einem Küvettenhalter oder einer Tauchsonde 
zur Messung der Probe mit der geringsten Konzentration vor. Diese ist normalerweise 
Ihre Referenz. Schalten Sie die Lichtquelle ein. 

3. Passen Sie die Integrationszeit an, so dass Sie ein gutes Referenzsignal mit einem 
Maximum bei etwa 14500 Einheiten erhalten. Der einfachste Weg, dieses zu 
bewerkstelligen, ist die Option „Auto Configure Integration time”. 

4. Stellen Sie die Anzahl der Mittelungen ein. Obwohl eine hohe Anzahl von Durchläufen ein 
genaueres Ergebnis liefert, muss doch die Zeit zur Aufnahme einer kompletten 
Absorptionskurve praktikabel bleiben. Zum Einstellen der Durchlaufzahl, betätigen Sie den 
„Stop”-Button. Nachdem Sie die Änderung der Durchlaufzahl in der Edit-Leiste 
vorgenommen haben, betätigen Sie den „Start”-Button ein weiteres Mal. 

5. Schalten Sie die Lichtquelle aus und speichern Sie ein Dunkelspektrum. Schalten Sie die 
Lichtquelle wieder an und speichern Sie eine Referenz.  

6. Wechseln Sie in den Absorptionsmodus, indem Sie den Button „A“ in der Symbolleiste 
betätigen. Messen Sie die Absorption einer Probe mit einer hohen Konzentration, um die 
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Wellenlänge und die Bandbreite einer verwertbaren Absorptionsspitze (in den meisten 
Fällen wird die Wellenlänge mit der höchsten Absorption benutzt) zu erhalten. 

7. Kalibrieren Sie ihre Absorptionsauslesung in Form der „Chemometry Settings“ (siehe 
Abschnitt „4.6.2 Kalibriereinstellungen“). Sie können auch eine vorherige Kalibrierlinie 
verwenden, da diese unter einem benutzerdefinierten Namen auf Diskette gespeichert und 
beim Start der Applikation neu geladen werden kann. 

8. Aktivieren Sie die Konzentrationsmessungen durch die Auswahl von „Application -> 
Chemometry -> Enable“ im Hauptmenü. Nachdem die Anwendung aktiviert wurde, kann 
„Chem” auch als eine History-Channel-Funktion ausgewählt werden. 

4.6.2 Kalibriereinstellungen 

Das Fenster (Abb. rechts) 
wird geöffnet, wenn 
erstmals „Application -> 
Chemometry -> Settings“ 
ausgewählt wurde. Eine 
Beispielkalibrierdatei, 
welche die im Fenster 
angezeigten Daten enthält, 
wurde im Ordner „Chem” 
erstellt. Beachten Sie, dass 
das Beispiel nur der 
Erläuterung dient. Sie 
müssen, wie in Abschnitt 
4.6.2.1. beschrieben, eine 
Anzahl von Proben mit 
bekannter Konzentration 
messen, um ihre eigenen Kalibrierdatei/en zu erstellen. Nachdem eine Kalibrierung 
gespeichert wurde, wird sie automatisch geladen, wenn die Applikation das nächste Mal 
gestartet wird. Wenn eine Kalibrierung einmal gespeichert ist, kann sie auch später, wenn 
benötigt, geladen oder modifiziert werden. In Abschnitt 4.6.2.2 wird beschrieben, wie man 
eine zuvor gespeicherte Kalibrierdatei modifiziert. 

4.6.2.1 Neue Kalibrierung starten 

Eine neue Kalibrierung wird durch Betätigen des Buttons „Start New Calibration (Clear Data)” 
begonnen. Alle Datenfelder für den ausgewählten Spektrometerkanal werden gelöscht. Geben 
Sie die Wellenlänge für die Messungen im Feld „Peak at“ und die Breite der verwendeten 
Spitze im Feld „Width“ ein. Das Programm wird die Absorptionswerte von „Peak minus 
Width” bis „Peak plus Width” integrieren und dieses Integral als Absorptionswert in den 
Konzentrationsberechnungen verwenden. 
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Die Einheit der Konzentration 
kann im Feld „Conc. Unit“ 
eingegeben werden. Dies ist 
lediglich ein Text, es werden 
keine Anpassungen 
durchgeführt, wenn Sie 
diesen Wert verändern. 
Geben Sie die bekannten 
Konzentrationswerte für die 
verfügbaren Standards in die 
mittlere Spalte der 
Kalibrierpunkttabelle ein. Sie 
können die Referenzprobe 
mit 0 Konzentration in diese 
Messungen einbeziehen. 
 

Danach enthält das Fenster 
zum Beispiel die Daten wie in 
der Abbildung rechts. 
Wenn die (Referenz-)Probe 
mit 0 Konzentration 
berücksichtigt wird, wie im 
Beispiel rechts, bereiten Sie 
das Experiment zur Messung 
dieser Referenz vor. Mit der 
Tastatur oder der Maus 
können Sie in der Tabelle die 
Zeile auswählen, um so die 
Probe festzulegen, für welche 
der Absorptionswert 
gemessen werden soll. 
Während Sie sich durch die 
Zeilen der Tabelle bewegen, wird der Text im Button „Read Absorbance for point x” für die 
Probe, die gemessen werden soll, aktualisiert. Im Beispiel beginnen wir mit der Messung von 
Punkt 1, der Referenzprobe. Betätigen Sie den Button „Read Absorbance for point 1” um die 
gemessene Absorption in die linke Spalte der Tabelle zu importieren. Wenn die Referenz 
gemessen ist, sollte der Wert sehr nahe 0,000 sein. Die gemessene Absorption und die 
entsprechende Konzentration werden als neuer Punkt im Graphen angezeigt. Bewegen Sie 
nun den Cursor in die zweite Zeile der Tabelle, bereiten Sie das Experiment für die Messung 
der Probe mit bekannter Konzentration für Punkt 2 (30 mmol/l im oberen Beispiel) vor und 
betätigen Sie den Button „Read Absorbance for point 1”, um die gemessene Absorption in die 
linke Spalte der Tabelle für Punkt 2 zu importieren. Wiederholen Sie diese Schritte für die 
anderen Proben mit bekannter Konzentration. Für eine lineare Kalibrierlinie werden 
mindestens zwei Proben benötigt, aber je mehr Punkte hinzugefügt werden, desto akkurater 
wird die Kalibrierlinie. 
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Nachdem die Proben 
gemessen wurden, klicken 
Sie den Button „Calculate 
New Calibration Line”. Nun 
wird eine rote Linie durch die 
gemessenen Daten gelegt. 
Sie werden gefragt, ob Sie 
die Kalibrierung speichern 
wollen oder nicht. 

In der Abbildung rechts kann 
man sehr gut erkennen, wie 
die Kalibrierlinie genau durch 
die gemessenen Punkte 
verläuft. Klicken Sie „Yes“, 
um zu bestätigen, dass Sie 
die Kalibrierung speichern 
wollen. 

Wenn während der Messung zum Beispiel durch Vermischung der Proben oder Messung der 
Konzentration in der falschen Zeile ein fehlerhafter Kalibrierpunkt gemessen wird, wird dies im 
Graphen deutlich. In diesem Fall können Sie direkt den Button „No“ betätigen oder die 
Kalibrierlinie später modifizieren. 

Nachdem Sie „Yes“ gedrückt haben, öffnet sich ein Fenster, in dem der Name für die 
Kalibrierdatei eingegeben werden kann. Geben sie den Namen, den Sie für diese Kalibrierlinie 
verwenden wollen, ein 
(„MyFirst“ im Beispiel rechts). 
Klicken Sie den Button 
„Save“. Im Folgenden wird 
die Datei „MyFirst.cal” erstellt 
und die Kalibrierlinie wird zur 
gegenwärtigen Kalibrierlinie, 
welche für die Berechnung 
des Konzentrationslevels des 
spezifischen Spektrometer-
Kanals (Master im Beispiel) 
verwendet wird.  
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Nachdem eine Kalibrierlinie 
gespeichert wurde, wird sie 
zur gegenwärtigen Kalibrier-
Linie , welche eine blaue 
Farbe hat. Diese Linie wird für 
die Konzentrations-
berechnung verwendet. 
Weiterhin sind die 
Kalibrierlinienkoeffizienten in 
der unteren rechten Ecke des 
Fensters angezeigt und die 
vorausberechneten 
Konzentrationswerte, die auf 
Grundlage der Kalibrierlinien-
koeffizienten berechnet 
wurden, sind in der rechten 
Spalte der Tabelle für die Standards eingefügt worden. 

Bei einem Vergleich der vorausberechneten Werte mit den tatsächlichen Konzentrations-
werten können Sie ein Urteil über die Qualität ihrer Kalibrierlinie erhalten. 

Die tatsächliche Kalibrierlinie wird automatisch geladen, wenn Sie getSpec das nächste Mal 
starten. Durch Betätigung des Buttons „Load“ können andere Kalibrierungen, die zuvor 
gespeichert wurden, geladen werden, wobei die geladene Kalibrierlinie zur gegenwärtigen 
Kalibrierlinie wird. 

4.6.2.2 Kalibrierung Modifizieren 

Die gegenwärtige Kalibrier-Linie kann durch die Auswahl der Fitordnung der Kalibrierlinie oder 
durch hinzufügen oder löschen von Kalibrierpunkten verändert werden.  

Fitordnung 

Die voreingestellte Fitordnung ist linear. Das Benutzen eines Fits 2. Ordnung macht es 
möglich, Nichtlinearitäten zu kompensieren. Um dies zu zeigen, wurde die Kalibrierung 
Myfirst.cal aus dem vorangehenden Kapitel geladen und die Fitordnung von linear auf 
2. Ordnung geändert. Nach dem Anklicken des „Calculate New Calibration Line” Button zeigte 
die neue Standardabweichung einen viel besseren Fit als der lineare. Nach der Speicherung 
dieser Kalibriergerade unter „MySecond.cal” zeigten die vorausbestimmten Konzentrationen 
einen besseren Fit für das quadratische Modell. Trotzdem sollte man den Fit höherer 
Ordnungen mit Vorsicht verwenden. Denn mit dieser Methode erhält man auch mit 
Ausreißern eine schöne Linie.  

Hinzufügen/Löschen von 
Kalibrierungspunkten 

Das Hinzufügen und Löschen von 
Kalibrierungspunkten zur/von der effektiven 
Kalibrierlinie ist sehr einfach und anschaulich 
in der grafischen Anzeige dargestellt. Um einer 
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Kalibrierung neue Kalibrierungspunkte hinzuzufügen, laden Sie einfach die Kalibrierungsdatei, 
bewegen Sie den Cursor in die nächste Zeile der Tabelle (Zeile 5 in unserem Beispiel), geben 
Sie die Probenkonzentration in die zentrale Spalte ein und lassen Sie in die erste Zeile durch 
Betätigen des Buttons „Read Absorbance for point 5”. Ein neuer roter Punkt wird den 
Kalibrierpunkt im Graphen markieren. Neue Punkte können bis zu 30 Standardproben 
hinzugefügt werden. Der Button „Calculate New Calibration Line“ wird eine neue rote Linie 
neben der tatsächlichen blauen Kalibrierlinie anzeigen. Danach öffnet sich ein Fenster, 
welches fragt, ob die neuen Kalibrierdaten gespeichert werden sollen. Dies kann bei der 
Überprüfung der korrekten Messung der neuen Punkte hilfreich sein. Man kann auch 
erkennen, wenn einer oder mehrere neue Punkte einen starken Anstieg der 
Standardabweichung hervorrufen. Im Beispiel (Abb. oben) wurde der Fehler durch die 
Eingabe von 60 in der zentralen Spalte anstelle des korrekten Wertes von 40 verursacht. Um 
einen oder mehrere Kalibrierpunkte von der gegenwärtigen Kalibrierlinie zu löschen, löschen 
Sie einfach den Wert für diesen Punkt in der linken oder zweiten Spalte. 

4.6.3 Die Anwendung aktivieren 

Die Anwendung wird durch die Auswahl der Option „Application -> Chemometry -> Enable” 
im Hauptmenü aktiviert. Ein Häkchen erscheint vor dem Menüeintrag 
um anzuzeigen, dass die Option aktiviert ist. 

Ein separates Fenster öffnet sich, welches für jeden aktivierten 
Spektrometerkanal die Konzentration anzeigt.  

Nachdem die Chemometrieanwendung aktiviert wurde, können Sie „Chem” als Funktionstyp 
im Funktionseingabefenster der History-Applikation auswählen. 
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5. Hilfe 

Nachdem die Option „Help -> Contents” ausgewählt wurde, wird das vollständige getSoft-
Handbuch im HTML-Format angezeigt. Das Inhaltsverzeichnis links zeigt alle Sektionen, die 
der Nutzer für spezifische Fragen durchsuchen kann.  
 

 
Alternativ zum Durchsuchen der einzelnen Sektionen kann ein Suchfenster geöffnet werden 
(Abb. unten). Nachdem ein Stichwort eingegeben wurde (z.B. Konzentration) und der Button 
„List Topics ” betätigt wurde, wird eine Liste mit allen Themen angezeigt, welche dieses 
Stichwort enthalten. Durch das Anwählen eines Themas links (Doppelklick) wird die 
Information rechts angezeigt, wobei das Stichwort im Text markiert ist. 
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Wie in Abschnitt 4.1.1 beschrieben, wurden die Funktionen des „History Channels” durch die 
Möglichkeit erweitert, eine von VB-Script unterstützte Funktion zu definieren. Für ihre 
Referenz haben wir eine Hilfedatei zu VB-Script beigefügt. Diese erreichen Sie, indem Sie im 
Hauptmenü die Option „Help -> VB Script“ auswählen. Sie listet neben anderen Dingen alle 
verfügbaren Operatoren und Funktionen auf: 
 

 
 
Das dritte Hilfe-Untermenü ist das Info-Fenster, welches Informationen über die Version von 
getSoft, die Seriennummer des angeschlossenen Spektrometers, die Windows-Version und 
den freien Speicherplatz enthält. 
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Anlage A Fehlersuche 

Wie man eine fehlerhafte USB-Installation korrigiert 

Jede USB-Einheit benötigt entsprechende Treiber, die auf dem Computer installiert sein 
müssen. Wenn sie das getSpec-2048 versehentlich an ihren Computer angeschlossen 
haben, bevor Sie getSoft installiert haben, können die USB-Treiber nicht gefunden werden. 
Auch das Spektrometer wird (vom später installierten getSoft) nicht erkannt. Um eine 
fehlerhafte Installation zu korrigieren, folgen Sie 
diesen Schritten:  

1. Gehen Sie zum Geräte-Manager. Sollten Sie 
Windows 98 verwenden, dann wählen Sie Start | 
Einstellungen | Systemsteuerung. 
Doppelklicken Sie auf das Icon System. Wählen 
Sie das Feld Geräte-Manager aus. In Windows 
2000-Systemen klicken Sie mit der rechten 
Maustaste auf Mein Computer und wählen Sie 
Eigenschaften, dann Hardware und klicken Sie 
auf den Button Geräte-Manager. 

1. Scrollen Sie nach unten, bis Sie Andere Geräte 
sehen. 

2. Unter Andere Geräte werden Sie ein USB-Gerät 
mit einem großen Fragezeichen sehen. Klicken 
Sie auf den Button Auswerfen oder klicken Sie 
mit der rechten Maustaste auf das Gerät und 
wählen Sie die Uninstall-Option. 

3. Ein Warnfenster wird sich öffnen, welches eine 
Bestätigung für das Auswerfen des Gerätes 
erfragt. Klicken Sie OK. 

4. Trennen Sie das getSpec-2048-Spektrometer von ihrem Computer und reinstallieren Sie 
getSoft. 

5. Nun können Sie das getSpec-2048-Spektrometer wieder an den USB-Anschluss Ihres 
Computers anschließen. Vergessen Sie auch nicht, das getSpec-2048 an das 12-V-
Netzteil anzuschließen. Windows 
wird ein Fenster öffnen, welches die 
„Neu Gefundene Hardware” anzeigt 
(USB-Gerät) und beginnen, nach dem 
Treiber zu suchen (dies kann einige 
Minuten dauern). Abhängig von ihrer 
Windows-Version kann sich das 
„Dateien Benötigt”-Fenster (Abb. 
rechts) öffnen, welches Ihnen erlaubt, 
das Verzeichnis auszuwählen, auf 
dem sich der USB-Treiber befindet. 

The file „getUSB.sys“ on getUSB 
Installation Disk is needed.  
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Klicken Sie auf den Button Durchsuchen und gehen Sie zum Verzeichnis 
C:\WINNT\SYSTEM32\DRIVERS und doppelklicken Sie auf den AvsUsb.sys-Treiber. 
Betätigen Sie dann den Button OK im Fenster „Dateien Benötigt“ um die Installation 
abzuschließen. 

6. Die getSoft-Software kann nun gestartet werden und wird das Spektrometer am USB-
Anschluss erkennen. Sollte dies nicht der Fall sein, sehen Sie bitte im Geräte-Manager 
nach, der das getSpec.com-Spektrometer-Board unter „Universelle Serielle Bus-
Controller” (Abb. oben) beinhalten sollte. 

 
Zögern Sie nicht, uns zu kontaktieren, wenn die Probleme nicht zu lösen sind.  


